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Technical Support

Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

m A range of support options that give you the flexibility to select the right
amount of service for any size organization

m Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

m Upgrade assurance that delivers software upgrades

m Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

m Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/
All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

m Product release level
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Hardware information

Available memory, disk space, and NIC information

Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description:

m Error messages and log files

m Troubleshooting that was performed before contacting Symantec

m Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

Questions regarding product licensing or serialization

Product registration updates, such as address or name changes

General product information (features, language availability, local dealers)
Latest information about product updates and upgrades

Information about upgrade assurance and support contracts

Information about the Symantec Buying Programs

Advice about Symantec's technical support options

Nontechnical presales questions

Issues that are related to CD-ROMs or manuals
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Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan customercare_apac@symantec.com
Europe, Middle-East, and Africa semea@symantec.com

North America and Latin America supportsolutions@symantec.com
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Introducing NetBackup for
Exchange

This chapter includes the following topics:

About NetBackup for Exchange

Features of NetBackup for Exchange

NetBackup for Exchange terminology

About Exchange backup operations

About Exchange restore operations

About Exchange backups and Granular Recovery Technology (GRT)
About snapshot backups with Exchange Server

About Exchange Instant Recovery methods

Online documents

About NetBackup for Exchange

NetBackup for Microsoft Exchange Server extends the capabilities of NetBackup
to include online backups and restores of Exchange databases when Exchange
Server is installed. This capability is provided as an add-on or extension to the
NetBackup for Windows client software. Because this product is tightly integrated
with the Backup, Archive, and Restore interface, this topic only gives an overview
of NetBackup functionality. In general, backup and restore operations for Exchange

files are identical to other NetBackup file operations.
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Introducing NetBackup for Exchange
Features of NetBackup for Exchange

Features of NetBackup for Exchange

Table 1-1 describes the features of the NetBackup for Exchange Server agent.

Table 1-1 NetBackup for Exchange Server features
Feature Description
Online backups Exchange Server data and transaction logs can be backed up without taking the Exchange

Server offline. Exchange services and data remain available during the Exchange Server
backup.

Minimal backup time

An administrator has the choice of to perform full or incremental backups. A full backup
may take considerable time, so it may be performed infrequently. In the interim, any updates
that occurred since the full backup can be quickly and incrementally backed up through a
transaction log backup. In the event of a failure, the full backups and incremental backups
would be restored.

During recovery, the Exchange Server updates the databases and applies each of the logged
transactions to the database. After the Exchange Server recovery completes, the system is
brought back to the state as it existed when the last incremental backup was performed.

Exchange Server

NetBackup supports all Exchange Server backup methods: full backups, cumulative

Backup methods incremental backups, and differential incremental backups. User backups function as copy
backups.

Tight NetBackup Tight integration with NetBackup allows for the following:

integration

B An administrator already familiar with NetBackup procedures and software can easily
configure and use NetBackup to perform Exchange Server backup and restore operations.

m Features and strengths of the NetBackup product suite are available to the Exchange
Server backup user. These features include software data compression and encryption,
scheduled and user-directed operations, backups of multiple data streams, and in-line
tape copy.

See the NetBackup Administrator’s Guide, Volume I.

Central administration

Administrators can define, back up, and restore Exchange Servers and other NetBackup
client computers from a central location.

Media management

Exchange Server backups can be saved directly to a wide variety of storage devices that the
NetBackup master server supports.

Automated backups

Administrators can set up schedules for automatic, unattended backups for local or remote
clients across the network. These backups can be full or incremental and are managed
entirely by the NetBackup server from a central location. The administrator can also
manually back up the clients.

Restore operations

An administrator using the Backup, Archive, and Restore interface can browse backups
and select the ones to be restored.
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Features of NetBackup for Exchange

Table 1-1 NetBackup for Exchange Server features (continued)
Feature Description
Exchange backup and | NetBackup can back up and restore storage groups and databases within the storage group.

restore features

The capabilities of this feature are as follows:

m Scheduled backups of individual storage groups and databases
m User-directed backups of individual storage groups and databases

m Restores of individual storage groups and databases. These restores can be performed
with the Backup, Archive, and Restore interface (on the server or on the client). Or you
can use the Remote Administration Console for Windows or UNIX.

MAPI mailbox backup
and restore

With Exchange 2007 or earlier, users can perform MAPI backups and restores of individual
mailboxes and folders, as follows:

m Scheduled backups of individual mailboxes and folders
m User-directed backups of individual mailboxes and folders

B Restores of individual mailboxes, folders, or messages. You can perform this type of
restore with the Backup, Archive, and Restore interface (on the server or on the client).
Or you can use the Remote Administration Console.

MAPI public folder
backup and restore

With Exchange 2007 or earlier, users can perform MAPI backups and restores of individual
public folder items, as follows:

m Scheduled backups of individual folders

m User-directed backups of individual folders

B Restores of individual folders or documents. You can perform this type of restore can
with the Backup, Archive, and Restore interface (on the server or on the client). Or you
can use the Remote Administration Console.

Restores of individual
items using Granular

Recovery Technology
(GRT)

When a backup uses GRT, users can restore individual mailbox and public folder items
directly from any full database backup.

See “About Exchange backups and Granular Recovery Technology (GRT)” on page 19.

Redirected restores of
mailbox objects

You can restore mailboxes, mailbox folders, mailbox messages, public folders, and public
folder items to a new location.

Redirected restores of
databases or storage
groups

Exchange 2007 and later backups can be restored to another database or another storage
group on the local server or on a different server. Exchange 2003 snapshot backups can be
restored to an identical storage group on a different server.

Redirection to the
recovery database
(RDB) or recovery
storage group (RSG)

Exchange 2007 and later backups can be redirected to the recovery database or RSG.
Streaming backups of Exchange 2003 can be redirected to the RSG.
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Features of NetBackup for Exchange

Table 1-1 NetBackup for Exchange Server features (continued)

Feature

Description

Single Instance
Storage (SIS) of
mailbox message
attachments

This feature applies only to Exchange 2007 or 2003 MAPI mailbox backups. Users can
enable Single Instance Storage for message attachments so that NetBackup writes only one
copy of an attachment to the backup.

Compression of

Compression increases backup performance over the network and reduces the size of the

backups backup image that is stored on the disk or tape. NetBackup does not support GRT for any
backups that use compression.

Encryption When the Encryption attribute is enabled, the server encrypts the backup for the clients
that are listed in the policy. NetBackup does not support GRT for any backups that use
encryption.

Snapshot backups and | NetBackup for Exchange can perform backups and restores of Exchange objects with

restores snapshot methodology. With a separate Snapshot Client license, you can perform off-host

backups, Instant Recovery backups, and backups with a hardware provider.

See “About snapshot backups with Exchange Server” on page 20.

Exchange 2007 and
later enhancements to
consistency checks of
snapshot backups

For snapshot backups, NetBackup uses the Microsoft consistency check API to check the
consistency of databases and transaction logs and to provide additional details. This speeds
up a snapshot backup, because it allows the backup to proceed in parallel with the
consistency check. For an Exchange 2010 DAG, you can disable the consistency check or
ignore the check and continue with the backup.

Cluster support

The NetBackup for Exchange Server agent supports Microsoft Cluster Server (MSCS)
environment and Veritas Cluster Server (VCS). See the NetBackup Enterprise Server 7.1
Cluster Compatibility list. This list contains information on the versions of Exchange Server
that are supported with the cluster environments.

LCR/CCR support

NetBackup for Exchange with Snapshot Client supports backups of the passive VSS writer
of an Exchange 2007 LCR and CCR configuration. NetBackup can back up the data that is
replicated by interfacing with the replica (or passive) Exchange server. The benefit of such
a backup is to reduce I/0 impact on the active Exchange server. NetBackup accesses the
replicated data and leaves the active (or live) Exchange server alone. This type of backup
is especially beneficial for a backup of a CCR node because the active node is completely
left out of the backup. VSS is the only backup Microsoft supports of this replicated data.
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NetBackup for Exchange terminology

Table 1-1 NetBackup for Exchange Server features (continued)
Feature Description
Exchange 2010 NetBackup for Exchange supports backups of Exchange 2010 standalone servers and
standalone server and | Exchange 2010 Database Availability Groups (DAGs). VSS is the only backup Microsoft
DAG support supports of Exchange 2010 backups.

For a DAG, NetBackup supports backups of the active and the passive VSS writer of a
Database Availability Group (DAG). When NetBackup backs up the data that is replicated
the benefit is that I/O impact is reduced on the active Exchange server. NetBackup accesses
the replicated data and leaves the active (or live) Exchange server alone. You can also
configure a list of preferred servers you want to use to perform backups.

NetBackup for Exchange terminology

Table 1-2 NetBackup for Exchange terminology
Term Definition or description
Exchange Server, Exchange In the NetBackup for Microsoft Exchange Server documentation, “Microsoft

Exchange Server” is referred to as “Exchange Server” or “Exchange”.

Granular Recovery Technology (GRT) | Allows a user to restore individual mailbox and public folder items from

full database backups.

MAPI mailbox or MAPI public folder | Refers to any mailbox and public folder operations that are performed with

backups and restores

MAPI. This type of backup and restore is only available with Exchange 2007
and earlier.

Microsoft consistency check API Refers to the Microsoft CHKSGFILS API or interface.
NetBackup File System daemon The NetBackup File System daemon on the NetBackup media server is a
(NBFSD) process that allows NetBackup clients to mount, browse, and read tar

images. This process is used with a client for Granular Recovery Technology
(GRT) operations. These operations include backups, browsing for backup
images, restores, and duplication.

NetBackup for Microsoft Exchange In the NetBackup for Microsoft Exchange Server documentation, “NetBackup

Server for Microsoft Exchange Server ” is referred to as “NetBackup for Exchange
Server” or “NetBackup for Exchange”.
Snapshot Refers to backups and restores performed with snapshot technology. In

the NetBackup for Exchange Server documentation, “VSS” is synonymous
with “snapshot”.
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Table 1-2 NetBackup for Exchange terminology (continued)

Definition or description

Streaming backups and restores Refers to Exchange database backups and restores that use the Microsoft

Exchange Backup and Restore API and not snapshot technology or the VSS
provider.

Refers to the software provider used to perform snapshot backups and
restores. In the NetBackup for Exchange Server documentation, “snapshot”
is synonymous with “VSS”.

About Exchange backup operations

NetBackup provides the following methods to perform backups:
m Automatic

m Manual

m User-directed

For more information on these backup methods and other administrator-directed
activities, see the NetBackup Administrator’s Guide, Volume I.

With automatic backups, the NetBackup administrator can schedule the full
backups and the incremental backups that occur automatically and unattended.
(Incremental backups can be differential incremental backups or cumulative
incremental backups.) Automatic backups meet most backup requirements.

You cannot perform an automatic copy backup. To perform a copy backup, run a
user-directed backup.

With manual backups, the administrator can perform immediate backups of the
files that are associated with any policy, client, or schedule.

The manual backup option can be useful for the following situations:
m Testing a configuration

m When workstations miss their regular backups

m Before installing new software (to preserve the old configuration)

m Preserving records before a special event such as when companies split or
merge

With the Backup, Archive, and Restore interface, the user can perform backups
of Exchange Server, mailboxes, and public folders. A user-directed backup produces
a copy backup for Exchange, which is a full backup that does not truncate the
transaction logs.
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About Exchange restore operations

With the Backup, Archive, and Restore interface, the administrator can browse
for Exchange Server backups and select the ones to restore. The following types
restores are available:

m Server-directed
m Redirected restores to a different client
m Redirected restores to a different target or database location

With a server-directed restore, an administrator can browse Exchange Server
databases and select the ones you want to restore. NetBackup lets you select the
NetBackup server from which files are restored, view the backup history, and
select items to restore. You can select a specific client or other clients that were
backed up by the selected NetBackup server.

When you redirect to a different client, you can restore to an Exchange client
other than the one that was originally backed up. You can redirect the Exchange
databases, directories, or mailbox objects. The administrator can direct restores
to any NetBackup for Exchange client (regardless of which client performed the
backup). To redirect a restore, the administrator can use the NetBackup
Administration Console on the master server or the Remote Administration
Console.

See the NetBackup Administrator’s Guide for the configuration that is needed for
this type of redirected restore.

A redirected restore to a different target or database location allows a user to
restore mailbox or public folder objects to a target or a database location different
from the location from which the objects were backed up. Depending on the
Exchange version and type of backup, database objects can be redirected to the
following:

m The Exchange recovery database (RDB)
m The Exchange recovery storage group (RSG)
m Another database

m Another storage group

About Exchange backups and Granular Recovery
Technology (GRT)

When a backup uses Granular Recovery Technology (GRT), users can restore
individual items directly from any full database backup. This type of backup can
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serve both kinds of recovery situations. From the same backup image you can
restore entire storage groups or databases. Or you can select individual folders
or messages within a mailbox or public folder. This backup can replace the existing
MAPI mailbox backup.

You can restore individual items using GRT from the following types of backups:

m Full or user-directed backups
Incremental backups are not yet supported.

m Local snapshot backups
m Off-host snapshot backups

m Instant recovery backups, when the schedule copies the snapshot to a storage
unit

m Replica snapshot backups
This type of backup applies to LCR or to CCR environments with Exchange
2007 or a Database Availability Group (DAG) with Exchange 2010.

m Streaming backups (Exchange 2007 and earlier)

About snapshot backups with Exchange Server

NetBackup for Exchange Server includes support for snapshot backups. NetBackup
for Exchange Server can back up and restore Exchange objects by taking snapshots
of the component files. Data is captured at a particular instant. The resulting
snapshot can be backed up without affecting the availability of the database. These
snapshots are backed up to tape or to the storage unit.

A separate Snapshot Client license provides additional features for snapshot
backups. You can configure the snapshot image for Instant Recovery and you can
configure an alternate client to perform the snapshot backup.

NetBackup for Exchange supports the Microsoft Volume Shadow Copy Service
(VSS) for creating a snapshot image. The actual VSS provider that is used is
dependent on your hardware environment and software environment. A list of
the VSS providers available for use with NetBackup for Exchange Server is
available.

See the NetBackup Snapshot Client (Advanced Client) OS, Arrays, and Database
Agent Compatibility list.

The following Snapshot Client features are available for use with NetBackup for
Exchange Server:
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Snapshot backup A snapshot is a disk image of the client's data. NetBackup backs
up the data from the snapshot volume, not directly from the
client’s original volume. Client operations and user access are
allowed to continue without interruption during the backup.

Instant Recovery NetBackup supports Instant Recovery backups with Exchange
2007 or later for non-clustered and non-replicated environments.
Instant Recovery requires a separate Snapshot Client license key.

This feature makes backups available for “instant recovery” from
disk. Instant Recovery combines snapshot technology with the
ability to do rapid disk-based restores. Optionally, the image is
retained on disk as well as backed up to storage.

To perform an Instant Recovery, one of the following methods is
used:

m Files are copied back from the snapped volume to the original
volume
m The volume is rolled back

Off-host backup NetBackup supports off-host backups of Exchange using an
alternate client. Off-host backups require a separate Snapshot
Client license key.

Off-host backups use a second, or alternate, client to perform the
backup on behalf of the primary client. Compared to local Snapshot
Client backups, this approach reduces the backup I/O burden on
the primary client.

NetBackup also supports off-host Instant Recovery backups for
Exchange 2007 and later.

See “Configuration and licensing requirements for Exchange snapshot backups
and restores” on page 29.

See “Limitations of Exchange snapshot operations” on page 89.

About Exchange Instant Recovery methods

If the snapshot is preserved with the Instant Recovery option, NetBackup restores
the database using rollback of the snapshot volume(s) when appropriate. Usually,
arollback of the snapshot volume(s) that contain the Exchange files is the fastest
way. However, the whether or not a rollback is appropriate depends on several
things: the configuration of the Exchange database files, the contents of the
volumes, and configuration of the disk array. If a volume rollback cannot be
performed, the files that are required for restoration are copied from the snapshot
volume to the destination volume. Instant recovery of Exchange differs from
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Instant Recovery of a file system. For Exchange, NetBackup decides which recovery
method to use. For file system restores, the user chooses the Instant Recovery
method.

NetBackup uses the following methods during an Exchange database restore to
restore the physical files:

Volume rollback The entire volume is rolled back, or resynchronized, by using the
snapshot. This method overwrites the entire volume with the
snapped volume.

File copy back Individual files are copied back from the snapped volume to the

current volume.

To determine if a volume can be rolled back, checks are made to insure that the
same list of files exists in the following places:

m The snapshot volume is compared with the cataloged list of files to restore.
These lists must match exactly. An example of a difference is a file that was
included in the snapshot, but was not cataloged because it is not an Exchange
file. The snapshot is not rolled back because that action overwrites the
non-Exchange file. Exchange files also may exist on the snapshot but not in
the catalog if the backup did not include all the databases on the volume.

m The snapshot volume is compared with the current volume. All files on the
current volume must also exist in the snapshot. If there is a file that is not on
the snapshot, a rollback is not performed because that action does not restore
that file.

In both comparisons, NetBackup excludes certain files from consideration. For
example, unneeded Exchange transaction logs, files Exchange re-generates, or
any files that are artifacts of the NetBackup process. The bppfi log shows when
such a file difference is found and excluded from consideration.

The copy-back restore method is used in the following situations:

m If the system provider is used and the snapshot selected for restore is not the
most recent snapshot

m If there are other files on the volume that could be lost
m If all the files on the snapshot are not selected for restore

m If youselect Roll-Forward Recovery. The copy-back method must be used for
the volume that contains the log files. A roll-forward recovery needs the log
files that were created since the backup. A rollback cannot be performed since
it removes those log files. If the database file (.edb) is on a different volume,
that volume is still evaluated with the other criteria to determine if it is eligible
for rollback.
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If multiple volumes are included in the restore set, each volume is evaluated
separately to determine if it is eligible for rollback. (The restore set is based on
the location of the Exchange database, transaction logs, and system files that are
part of the restore.) For example, perhaps the volume that contains the database
files is eligible for rollback, but the volume that contains log files has extra,
non-Exchange files. At the time of the restore, only the volume that contains the
database files is rolled back. All the log files are copied back from the snapshot
to the current volume.

See “Configuring a snapshot policy with Instant Recovery for Exchange Server”
on page 92.

See “About configuration requirements for the Exchange Server when you use
Instant Recovery” on page 102.

Online documents

NetBackup documents are delivered on a documentation CD that is included with
the NetBackup media kit. Contact your NetBackup administrator to obtain the
location of this CD or to have the files installed on your computer.

These online documents are in Adobe® Portable Document Format (PDF). To view
PDF documents, you must use the Adobe Acrobat Reader. You can download the
reader from:

http://www.adobe.com
Symantec assumes no responsibility for the installation and use of the reader.

For a complete list of NetBackup technical documents, see the Related Documents
appendix in the NetBackup Release Notes.


http://www.adobe.com
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Installing NetBackup for
Exchange

This chapter includes the following topics:

Planning the installation of NetBackup for Exchange

Verifying the operating system and platform compatibility for NetBackup for
Exchange

NetBackup server and client software requirements for NetBackup for Exchange
Exchange server software requirements for NetBackup for Exchange
Requirements for Exchange mailbox backup and restore operations
Requirements for Exchange in a cluster environment

Configuration and licensing requirements for Exchange snapshot backups and
restores

Adding the NetBackup for Exchange license key

Planning the installation of NetBackup for Exchange

Every NetBackup server includes the NetBackup client software by default.
Therefore you can use NetBackup for Exchange on a NetBackup server or client
(if NetBackup for Exchange is supported on that platform). Perform the following
tasks before you use NetBackup for Exchange.
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Table 2-1 Installation steps for NetBackup for Exchange
Step Action Description
Step 1 Verify the operating system and platform See “Verifying the operating system and platform
compatibility. compatibility for NetBackup for Exchange”
on page 26.
Step 2 Verify the NetBackup server and client See “NetBackup server and client software
requirements for NetBackup for Exchange. requirements for NetBackup for Exchange”
on page 27.
Step 3 Verify the Exchange software requirements for | See “Exchange server software requirements for
NetBackup for Exchange. NetBackup for Exchange” on page 28.
Step 4 Verify the requirements for mailbox backup and | See “Requirements for Exchange mailbox backup
restore operations. and restore operations” on page 28.
Step 5 If you plan to use Granular Recovery Technology | See “About installing and configuring Network
(GRT) to restore individual Exchange items, File System (NFS) for Exchange Server Granular
review the information about Network File System | Recovery” on page 33.
(NFS).
Step 6 If you installed Exchange Server in a cluster, See “Requirements for Exchange in a cluster
review the requirements for that environment. |environment” on page 29.
Step 7 If you plan to use snapshot backups, review the | See “Configuration and licensing requirements
requirements for that type of backup. for Exchange snapshot backups and restores”
on page 29.
Step 8 Add the license key for NetBackup for Exchange. | See “Adding the NetBackup for Exchange license

key” on page 31.

Verifying the operating system and platform
compatibility for NetBackup for Exchange

Verify that the NetBackup for Exchange agent is supported on your operating

system or platform.

To verify operating system and compatibility

1 Go to the Symantec Support Web page:

http://www.symantec.com/business/support/index.jsp

2 Inthe Product Finder box, type NetBackup Enterprise Server and click

the > icon.

3 From the list on the right, click on Compatibility List.


http://www.symantec.com/business/support/index.jsp
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4 In the list of documents, click on the following document:

NetBackup (tm) x.x Database Agent Software Compatibility List (Updated
date_updated)

For x.x, look for the current release. For date_updated, look for the most
recent date.

5 For information on supported cluster environments for NetBackup for
Exchange, see the following document:

NetBackup (tm) Enterprise Server x.x / Enterprise Server x.x Cluster
Compatibility List (Updated date_updated)

6 Forinformation on support for Snapshot Client, see the following document:

NetBackup (tm) x.x Snapshot Client (Advanced Client) OS, Arrays, and
Database Agent Compatibility (Updated date_updated)

NetBackup server and client software requirements
for NetBackup for Exchange

Verify that the following requirements are met for the NetBackup server and
client software:

m The NetBackup server software is installed and operational on the NetBackup
server. The NetBackup server platform can be any that NetBackup supports.
See the NetBackup Installation Guide.

m The NetBackup client software is installed on the computer that has the
databases you want to back up.
Install the NetBackup client software on the computer that has the Exchange
Server, any off-host clients, and all CAS servers that are used for mailbox
databases. In an Exchange Server cluster, install the NetBackup client on each
node in the cluster.
The following PowerShell command can be used to change which CAS server
is assigned to a database. Refer to Microsoft documentation for more
information.
Set-MailboxDatabase <Mailbox Database Name> -RpcClientAccessServer

<ClientAccessServer or ClientAccessServerArrayID>

m To use the new features that are included in NetBackup for Exchange in
NetBackup 7.1 or later releases, you must upgrade your NetBackup for
Exchange clients. The media server and NetBackup for Exchange clients must
be at the same NetBackup version.

m  Make sure that you configure any backup media that the storage unit uses.
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The number of media volumes that are required depends on several things:
m The devices used

m The sizes of the databases that you want to back up

m The amount of data that you want to archive

m The size of your backups

m The frequency of backups or archives
See the NetBackup Administrator’s Guide, Volume I.

Exchange server software requirements for
NetBackup for Exchange

Verify the following regarding the Exchange server software on the NetBackup
server or client:

m Exchange server software must be installed and operational.

m For Exchange 2007, Symantec recommends that you do not install Microsoft
Outlook on the same server on which Exchange is installed. This
recommendation does not apply if you do not perform MAPI backups or perform
restores with Granular Recovery Technology (GRT).

m Install the NetBackup client on the Exchange server, if the Exchange server
is not locally installed on a NetBackup server.

Requirements for Exchange mailbox backup and
restore operations

To perform backups and restores of mailboxes, whether with MAPI or with
Granular Recovery Technology (GRT), you must meet the following requirements:

m (Exchange 2007) On the Exchange Server install the Microsoft Exchange Server
MAPI Client and Collaboration Data Objects (CDO) package. On Windows 2008
and later, install version 6.05.8022.0 or higher. On Windows 2003 and later,
install version 6.05.7888 or higher.

These packages are available on the following Microsoft Web site:
http://www.microsoft.com/downloads/

m Create a user account for the NetBackup Client Service and configure the log
on account for this service.
See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.


http://www.microsoft.com/downloads/
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Requirements for Exchange in a cluster environment

If you plan to use NetBackup for Exchange to back up an Exchange 2007 server
in a VCS 5.0 environment, verify the following:

m A patch is required to cluster Exchange 2007 in a VCS 5.0 environment. See
the following TechNote for more information.
http://www.symantec.com/docs/TECH51616

Configuration and licensing requirements for
Exchange snapshot backups and restores

To perform snapshot backups of restores of Exchange Server, you must meet the
following requirements:

m Confirm that the type of snapshot you want to configure is supported for your
Exchange environment. See the following compatibility list:
NetBackup Snapshot Client (Advanced Client) OS, Arrays, and Database Agent
Compatibility

m Configure the NetBackup Snapshot Client and verify that you meet the
configuration requirements for the snapshot method you want to use.
See the NetBackup Snapshot Client Administrator’s Guide.

m Ifyouuse Veritas Storage Foundation for Windows (SFW), verify that you have
the minimum software level.

Windows 2008 and later, SFW 5.1 SP1
Windows 2008 R2 and later

Windows 2003 x64 SFW 5.0

Windows 2003 x86 SFW 4.3

m The following snapshot options or Exchange configurations require a separate
Snapshot Client license:

m Instant recovery
m Off-host backups
m Backups using a hardware provider

m A CCR environment
Additional installation requirements apply for Instant Recovery and off-host
backups.

29
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See “Requirements for Exchange off-host backups” on page 30.
See “Requirements for Exchange Instant Recovery backups” on page 31.

m If you want to restore individual items from database backups (granular
recovery), additional installation requirements apply and other configuration
is necessary.

See “About installing and configuring Network File System (NFS) for Exchange
Server Granular Recovery” on page 33.

See “Limitations of Exchange snapshot operations” on page 89.

Requirements for Exchange off-host backups
Note the following requirements and operational notes for off-host backups:

m (Exchange 2007) Storage Foundation for Windows (SFW) 5.0 or later is required
for off-host backups that use the SFW VSS provider. For Windows 2008 and
later and Windows 2008 R2 and later, SFW 5.1 SP1 is required for local and
off-host snapshot backups.

m (Exchange 2007) To successfully perform backups with the SFW VSS provider
for SFW 5.0, apply the following hotfixes on the hosts where a snapshot backup
occurs:

m http://entsupport.symantec.com/docs/295112
This hotfix is also included in the SFW/SFW-HA 5.0 MP1 release.

m http://entsupport.symantec.com/docs/292544

Note: These hotfixes are included in SFW/SFW-HA 5.1 and are not required
if you have that version.

m The Exchange Server does not need to be installed on the off-host client.

m (Exchange 2007 and later) For consistency checks of Exchange with the
Microsoft consistency check API, Symantec Corporation recommends that
you install the Exchange System Management Tools on the alternate client.
Then restart the Exchange Server. If you choose not to install the Exchange
System Management Tools on an Exchange 2010 alternate client, you must
install the VC9 runtime DLLs. These DLLs can be downloaded from Microsoft
x64 VC9 download page:
http;//www.microsoft.com/downloads/details.aspx?familyid=BD2A6171-E2D6-4230-B809-
9A8D7548C1B6&displaylang=en
More information is available about consistency checks in general and options
for Exchange 2010 consistency checks:

See “Consistency checks on Exchange snapshot backups” on page 91.


http://entsupport.symantec.com/docs/295112
http://entsupport.symantec.com/docs/292544
http://www.microsoft.com/downloads/details.aspx?familyid=BD2A6171-E2D6-4230-B809-9A8D7548C1B6&displaylang=en
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See “About consistency checks options for an Exchange 2010 backup”
on page 126.

m For Instant Recovery off-host backups, see the following requirements:
See “Requirements for Exchange Instant Recovery backups” on page 31.

See “Requirements for Exchange mailbox backup and restore operations”
on page 28.

Requirements for Exchange Instant Recovery backups

With Windows 2008 and later and Windows 2008 R2 and later, Instant Recovery
backups require Storage Foundations for Windows (SFW) 5.1 SP1 if you use the
SFW VSS provider.

See “Requirements for Exchange mailbox backup and restore operations”
on page 28.

Adding the NetBackup for Exchange license key

To use NetBackup for Exchange, add a valid license key for it on the master server.
More information is available on how to add license keys.

See the NetBackup Administrator’s Guide, Volume I.

In a NetBackup cluster, add the key on each node where the NetBackup server is
installed.

To add a NetBackup for Exchange license key in the NetBackup Administration
Console

1 On the master server, open the NetBackup Administration Console.
2 Choose Help > License Keys.

3 Click the New icon.

4  Type the license key and click Add.
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Installing and configuring
NFS for Exchange Granular
Recovery

This chapter includes the following topics:

m About installing and configuring Network File System (NFS) for Exchange
Server Granular Recovery

m Requirements to perform backups and restores with Granular Recovery
Technology (GRT)

m Configurations that are supported for Exchange Granular Recovery

m About configuring Services for Network File System (NFS) on the Windows
2008 and Windows 2008 R2 NetBackup media server and NetBackup clients

m About configuring Services for Network File System (NFS) on the Windows
2003 R2 SP2 NetBackup media server and NetBackup clients

m Configuring a UNIX or Linux media server and Windows clients for backups
and restores that use Granular Recovery Technology

m Configuring a different network port for NBFSD

About installing and configuring Network File System
(NFS) for Exchange Server Granular Recovery

NetBackup Granular Recovery leverages Network File System, or NFS, to read
individual objects from a database backup image. Specifically, the NetBackup
client uses NFS to extract data from the backup image on the NetBackup media
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server. The NetBackup client uses “Client for NFS” to mount and access a mapped
drive that is connected to the NetBackup media server. The NetBackup media
server handles the I/O requests from the client through NBFSD.

NBFSD is the NetBackup File System (NBFS) service that runs on the media server.
NBFSD makes a NetBackup backup image appear as a file system folder to the
NetBackup client over a secure connection.

Network File System, or NFS, is a widely recognized, open standard for client and
server file access over a network. It allows clients to access files on dissimilar
servers through a shared TCP/IP network. NFS is typically bundled with the host
operating system. NetBackup uses Granular Recovery Technology (GRT) and NFS
torecover the individual objects that reside within a database backup image, such
as:

m A user account from an Active Directory database backup
m Email messages or folders from an Exchange database backup
m A document from a SharePoint database backup

Multiple NetBackup agents that support GRT (for example, Exchange, SharePoint,
and Active Directory) can use the same media server.

Requirements to perform backups and restores with
Granular Recovery Technology (GRT)

Table 3-1 Requirements for Exchange Granular Recovery
Step Action Description
Step 1 You have a supported Exchange Server
configuration.
Step 2 You have a media server platform that supports | See the NetBackup Enterprise Server and Server

GRT.

x.x OS Software Compatibility List.
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Table 3-1 Requirements for Exchange Granular Recovery (continued)
Step Action Description
Step 3 On all Exchange granular clients, do the following: | See “Requirements for Exchange mailbox backup
m Ensure that the computer has an available and restore operations” on page 28.
drive letter on which to mount the backup See “About Exchange client and server privileges
image. for granular operations, virtual environments, or
m Configure NetBackup and Exchange Server | off-host backups” on page 114.
for mailbox backups and restores.
m For Windows 2003 R2 SP2, install the hotfix
for Client for NFS. The hotfix is available at
the following location:
http://support.microsoft.com/kb/947186
Step 4 Enable or configure NFS for your environment. | See “About configuring Services for Network File

m Windows 2008 and Windows 2008 R2 media
server and clients

m Windows 2003 R2 SP2 media server and
clients

m UNIX/Linux media server and Windows clients

System (NFS) on the Windows 2008 and Windows
2008 R2 NetBackup media server and NetBackup
clients” on page 36.

See “About configuring Services for Network File
System (NFS) on the Windows 2003 R2 SP2
NetBackup media server and NetBackup clients”
on page 43.

See “Configuring a UNIX or Linux media server
and Windows clients for backups and restores
that use Granular Recovery Technology”

on page 50.

Configurations that are supported for Exchange
Granular Recovery

For information on the Exchange versions and Windows Server releases that are
supported for Granular Recovery Technology (GRT) see the following:

NetBackup 7.x Database Agent Software Compatibility List

For information on the media server platforms that are supported for Granular
Recovery Technology (GRT) see the following:

NetBackup Enterprise Server and Server 7.x OS Software Compatibility List


http://support.microsoft.com/kb/947186

36 | Installing and configuring NFS for Exchange Granular Recovery
About configuring Services for Network File System (NFS) on the Windows 2008 and Windows 2008 R2 NetBackup

media server and NetBackup clients

About configuring Services for Network File System
(NFS) on the Windows 2008 and Windows 2008 R2
NetBackup media server and NetBackup clients

Table 3-2 Configuring NFS in a Windows 2008 or Windows 2008 R2
environment,

Step Action Description
Step 1 Stop and disable the Before you install NFS on the media server or client(s), look for the
Portmapper service. ONC Portmapper service. If it exists, stop it and disable it. Otherwise,

the installation of NFS Services for Windows fails.

Step 2 Enable NFS. Enable NFS on the following:

m The NetBackup media server
m The Exchange granular clients
See “About Exchange client and server privileges for granular
operations, virtual environments, or off-host backups” on page 114.
m The CAS Server

See “Enabling Services for Network File System (NFS) on Windows
2008 or Windows 2008 R2” on page 36.

Step 3 Disable Server for NFS. You can disable the Server for NFS on the following:

m The NetBackup media server
m The Exchange granular clients
See “About Exchange client and server privileges for granular
operations, virtual environments, or off-host backups” on page 114.
m The CAS Server

See “Disabling the Server for NFS” on page 40.

Step 4 Disable Client for NFS. You can disable the Client for NFS on the NetBackup media server.
See “Disabling the Client for NFS on the media server” on page 41.

If an Exchange granular client resides on the media server, do not
disable the Client for NFS.

Enabling Services for Network File System (NFS) on Windows 2008 or
Windows 2008 R2

Torestore individual items from a backup that uses Granular Recovery Technology
(GRT), you must enable Services for Network File System. When this configuration
is completed on the media server and the Exchange granular clients, you can
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disable any unnecessary NFS services. More information is available on which
clients require this configuration.

See “About Exchange client and server privileges for granular operations, virtual
environments, or off-host backups” on page 114.

To enable Services for Network File System (NFS) on Windows 2008 or Windows
2008 R2

1 Open the Server Manager.

2 Inthe left pane, click Roles and, in the right pane, click Add Roles.

= 5erver Manager !E B
File Action ‘iew Help
€9 =]
5 Roles
ﬁ_j Features
i Diagnostics . View the health of the roles installed on vour server and add or remove rales and Features,
if& Configuration

=5 Storage

+! Roles Summary ﬂ Raoles Summary Help

~) Roles: 1 of 13 installed

Lﬂm %u

. Remove Roles
B3 Hyper-y

~! Hyper-¥ Hyper-¥ Help

Provides the services that you can use to create and manage virtual machines and their resources.

+| Role Status E Go ko Hyper-Y

@ Messages: 1
System Services: All Running

& Everts: 613 errars, 2 warnings, 10 informational in the last 24 hours

%:; Last Refresh: 11§19/2008 9:00:51 AM  Configure refresh

3 Inthe Add Roles Wizard, on the Before You Begin page, click Next.
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4  Onthe Select Server Roles page, under Roles, check the File Services check
box.

Add Roles Wizard

Select one or mare rales to install on this server,

Roles: Descripkion;
File: Services [] Active Direckary Certificate Services File Services provides technologies
. ) ) ) that help you manage storage, enable
Rale Services L] Active Directory Domain Services file replication, manage shared
Confirmation [[] Active Directory Federation Services folders, ensure Fast file searching, and
[ Active Directory Lightweight Direckory Services enable access For UNIX clisnt
Frogress [] active Directary Rights Management Services computers.
Results [] application Server

|: DHCP Server
|: DNS Server
’: Fax Server
[] File Services
Hyper-¥ (Installed)
[ Metwork Policy and Access Services
|: Prink Services
[ Terminal Services
|: UDDI Services
[ web Server (115)
[ windows Deployment Services
[] windows Server Update Services

IMore sbout server roles

< Previous | Mext = I Inistall Cancel

Click Next.
On the Files Services page, click Next.

On the Select Role Services page, uncheck File Server.



Installing and configuring NFS for Exchange Granular Recovery | 39
About configuring Services for Network File System (NFS) on the Windows 2008 and Windows 2008 R2 NetBackup
media server and NetBackup clients

8 Check Services for Network File System.

Add Roles Wizard
= .
!! E Select Role Services
Biefore You Begin Select the rale services tainstall for File Services:
Server Roles Raole services: Description:
File Services - Services for Network File Syskem
U Fllle El;er\-'er . {MES) enables you to give UMK client
=l [ Distributed File System computers access ta files on this
confitmati [] DFs Mamespaces server.
sniirmation [] DFS Replication
Progress |: File Server Resource Manager

[¥] Services For Metwark File System
[ windows Search Service
B[] windows Server 2003 File Services
[ File Replication Service
[ 1ndexing Service

Results

IMore sbout role services

< Previous | Mewxk = I Imstall Cancel

9 Click Next and complete the wizard.

10 On the media server, configure the portmap service to start automatically at
server restart.

Issue the following from the command prompt:

sc config portmap start= auto

This command should return the status [SC] ChangeServiceConfig SUCCESS.
11 For each host in your configuration, choose from one of the following:

m If you have a single host that functions as both the media server and the
Exchange granular client, you can disable the Server for NFS.

m For a host that is only the NetBackup media server, you can disable the
Server for NFS and the Client for NFS.
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m For a host that is only an Exchange granular client, you can disable the
Server for NFS.

Disabling the Server for NFS

After you enable Services for Network File System (NFS) on the media server and
on the Exchange granular clients, you can disable Server for NFS.

To disable the Server for NFS

1 Open the Server Manager.

2 Inthe left pane, expand Configuration.
3 Click Services.

F,: Server Manager !E[ E

File  Action  Wiew Help
€9 2plE o= HE>» = 0 ®»

5 Roles —
ﬁa Features Mame * Drescription Skatus SFartup Type Log On &s =
_i Diagnostics CLSANJLAN Transfer .., Enablesre... Disabled Local System
= jil’._!: Configuration & Secondary Logon Enables st...  Started Automatic Local System
() Task scheduler Eh5ecure Socket Tun...  Provides s... Manual Local Service
ﬁ windows Firewall with Adve | S Security Accounts ... The startu...  Started Automatic Local System
.5"({ Services Lk Server Supports fil,.,  Starked Aukomatic Local System
5 WM Contral r For MFS Enables a...  Started Aukomatic Metwark 5.,
P Local Users and Groups Eh5hel Hardware Det... Providesn...  Started Aukomatic Local System
=5 Storage 5151 UI Matification 5. Provides 5. Marual Local Service
Sk Smart Card Manages a... Manual Local Service
ChSmart Card Remav,.,  Allows the ... Manual Local System
CLSNMP Trap Receives tr.., Manual Local Service J
1 Software Licensing Enables th...  Starked Automatic Metwark 5.,
EhSpecial Administrati...  Allaws adm... Manual Local System
“£1.55DP Discovery Discovers ... Disabled Local Service
“EhSuperfetch Maintains a... Disabled Local System
Lk Symartec Private B... Symantec... Started Automatic Local System LI
LI—I _’I Extended A Standard

4 Inthe right pane, right-click on Server for NFS and click Stop.
5 Inthe right pane, right-click on Server for NFS and click Properties.
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6 Inthe Server for NFS Properties dialog box, from the Startup type list, click
Disabled.

Server for NFS Properties (DCDELL224)

General | Log Dnl Hecoveryl Dependenciesl

Service name: MfzService

Dizplay name: Server for MFS

Description: Enablez a‘windows bazed computer to act az an ;I
- MNFS Server

L

Path to executable:
C\Windowsheystem32infseve. exe

Startup type: Automatic ﬂ
Autornatic [Delayed Start)
Automatic

atual

Help me configure

Service status:

Start | Stop | Fauge Eesume

‘f'ou can specify the start parameters that apply when you start the service
from here.

Start parammeters: I

ok I Cancel Lpoply

7 Click OK.

8 Repeat this procedure for the media server and for each Exchange granular
client.

Disabling the Client for NFS on the media server

After you enable Services for Network File System (NFS) on a host that is only a
NetBackup media server, you can disable the Client for NFS.

To disable the Client for NFS on the NetBackup media server
1 Open the Server Manager.

2 Inthe left pane, expand Configuration.
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3 Click Services.

Server Manager

File Action Wiew Help

I[=] B3

L A ENEIEY

_Eéa Server Manager (DCDELLZZ4)
5 Roles
ﬁ:j Features
_i Diagnostics
= jﬁ’j Canfiguration
() Task Scheduler

.{,‘(E Services
= WMI Control
Q_, Local Users and Groups
=5 Storage

3|

c

@ windows Firewall with Advz | “5Application Layer G...

&

&

&

&

2nk For NFS
“GhCNG Key Isolation

{CLCOM+ Event System
{CLCOM+ System Appl...

\‘:(:_’;Cnmputer Browser
\‘:(I_’;Cryptographic Serv...
{5RDCOM Server Proc,.,
».‘:(:_’;Dasktop wWindow M.,
“CLDHCP Client
\‘:(:’;D\agnostic Policy Se...

SOk Niannnckic Sarvice

Extended >\ Standard

The Diannn

Enables thi...
The CHG k...
Suppotts S...
Manages t...
Maintains a...
Provides fo...
Provides la...
Provides D
Reqisters a...
The Diagno...

Started

Started

Starked
Started
Starked
Started
Starked

Aukomatic
Manual
Aukarnatic
Marual
Disabled
Autornatic
Aukomatic
Autornatic
Aukarnatic
Autornatic

fanal

Description Skakus Startup Type Log On As =
5 Adaptive Server An... Managest... Disabled Local System
\‘:(: pplication Experie... Processes .., Started Automatic Local System
“ShApplication Informa,.. Faclitates .. Manual Local Syskemn oo
Provides s... Manual Local Service
‘Chapplication Manage... Processesi... Manual Lacal Systemn
‘ChBackground Intellig... Tramsfersf... Started Automatic {D...  Local System
C)Base Fiteting Engine ~ The Base F...  Started Automnatic Local Service
‘ChCertificate Propaga... Propagate...  Started Manual Local System

=
Local System
Local Service
Local System
Local System
Metwork 5.
Local Syskemn
Local System
Local Service
Local Service

| nral Servire

In the right pane, right-click on Client for NFS and click Stop.

In the right pane, right-click on Client for NFS and click Properties.
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6 In the Client for NFS Properties dialog box, from the Startup type list, click
Disabled.

Client for NFS Propetties (DCDELLZ24)

General | Log Dnl Hecoveryl Dependenciesl

Service name: MfzClnt

Dizplay name: Client for MFS

Description: Enables this computer to access files on NFS shares;l
I
Path to executable:
C:\Windowsheystem3Zhnfsclnt. exe

Startup type: Automatic ﬂ

Autornatic [Delayed Start)
Help me configure | Automatic
— [Manual

Service status:

Start | Stop | Fauge | Eesume |

‘f'ou can specify the start parameters that apply when you start the service
from here.

Start parammeters: I

ok I Cancel Lpoply

7 Click OK.

About configuring Services for Network File System
(NFS) on the Windows 2003 R2 SP2 NetBackup media
server and NetBackup clients

Note: NetBackup does not support Granular Recovery Technology (GRT) with
Windows Server 2003 R1 or earlier versions.
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Table 3-3

Step Action Description

Step 1 Install the necessary NFS See Table 3-4 on page 44.
components on the NetBackup media See “Installing Services for NFS on
Server. the Windows 2003 R2 SP2 media

server” on page 44.

Step 2 Install the necessary NFS See Table 3-4 on page 44.
component.s on the Exchange See “About Exchange client and
granular clients. ..

server privileges for granular
operations, virtual environments, or
off-host backups” on page 114.
See “Installing Services for NFS on
Exchange granular clients with
Windows 2003 R2 SP2” on page 47.
Note: If an Exchange granular client
resides on the media server, install
all the components on the media
server.

Table 3-4 NFS components required for Windows 2003 R2 SP2

NFS component NetBackup client NetBackup

media server

Client for NFS X

Microsoft Services for NFS Administration X

RPC External Data Representation X X

RPC Port Mapper X

Installing Services for NFS on the Windows 2003 R2 SP2 media server

This topic describes how to install Services for NFS on a Windows 2003 R2 SP2
media server.

To install Services for NFS on the Windows 2003 R2 SP2 media server
1 Click Start > Control Panel > Add or Remove Programs.

2 Click Add/Remove Windows Components.
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3 Check Other Network File and Print Services and click Details.

Windows Components Wizard B

Windows Components
Yau can add ar remove camponents of Windows,

To add or remove a component, click the checkbox, A& shaded box means that only
part of the component will be installed. To see what's included in & component, click
Details.

[ & Remote Storage EAME

O @ Security Configuration “#fizard 0.6 MB i
O Subzystem for UME-based Applications 1.9MB

[ Teminal Server nnme =

Description:  Shares files and printers on this computer with otherz on the netwaork.

Total disk space required: 439 MB Details |
Space available on disk: 2508, MB —

< Back I Mest > I Cancel | Help |

4  Check Microsoft Service for NFS and click Details.

Other Network File and Print Services E3

To add or remove a component, click the check box. A shaded box means that only part
of the companent will be installed. To see what's included in & component, click Details.

Subcomponents of Other Metwork. File and Print Services:

[] ™ Camman Lag File System 0.0ME ;I
O File Services for Macintosh 0.0mB

for MES 0.0ME

O Print Services for Lnix 03mMB

[~

Descrption:  Enables UMIX users to both store and gain access to files on a server
unhing Microzaft Windows.

Taotal disk space required: 439 1B Details... |
Space available on disk: 8h08.4 MB
Q. I Cancel |
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5 Install the components that apply to your configuration.

m If the host is only a NetBackup media server, check the following
components:

m RPC External Data Representation

m RPC Port Mapper

m If you have a single host that functions as both the media server and the
Exchange granular client, check the following components:

m Client for NFS
m Microsoft Services for NFS Administration
m RPC External Data Representation

m RPC Port Mapper

Microsoft Services for NFS

To add or remove a component, chck the check box, & shaded box means that only part
of the compaonent will be installed. To see what's included in a component, click Details.

Subcomponents of Microsoft Services for HFS:

Media server O ;ﬁjl:l?ent for NF5 . o 00ME =
and client O Microsoft Services for MFS Administration 0.0me
Media RPC Esternal Data Representation 0.0mMBe
server only L1 RPC Part Mapper 0.0MB
1 B Server for NFS 0.0 ME
O Server For MFS Authentication 0.0mMe
O Q& Uzer Mame Mapping 0.0mMEe ;l
Dezcription:  Provides RPC port mapping zervices for Server for NFS and Uzer Mame
M apping.
Total disk space required: 43.9ME Detals |
Space avalable on disk: 85084 MB
0K I Cancel |
Click OK.
Click OK.

Click Next and complete the Windows Components Wizard.

O 00 N O

After the installation is complete, open Services in the Control Panel.

10 Depending on configuration of the host, verify that Client for NFS is running
or is stopped and disabled:
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m Forasingle host that has both the media server and the Exchange granular
client, ensure Client for NFS is running.

m For a host that is only a NetBackup media server, Client for NFS can be
stopped and disabled.

11 Configure the portmap service to start automatically at server restart.
Issue the following from the command prompt:
sc config portmap start= auto

This command should return the status [SC] ChangeServiceConfig SUCCESS.

Installing Services for NFS on Exchange granular clients with Windows
2003 R2 SP2

This topic describes how to install NFS on the NetBackup clients with Windows
2003 R2 SP2. Only the clients that perform granular operations require NFS. If
an Exchange granular client is also a media server, you must follow a different
procedure.

See “Installing Services for NFS on the Windows 2003 R2 SP2 media server”
on page 44.

More information is available on which clients require NFS.

See “About Exchange client and server privileges for granular operations, virtual
environments, or off-host backups” on page 114.

To install Services for NFS on the NetBackup clients with Windows 2003 R2 SP2
1 Click Start > Control Panel > Add or Remove Programs.

2 Click Add/Remove Windows Components.
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3 Check Other Network File and Print Services and click Details.

Windows Components Wizard B

Windows Components
Yau can add ar remove camponents of Windows,

To add or remove a component, click the checkbox, A& shaded box means that only
part of the component will be installed. To see what's included in & component, click

Details.

Components:

R :
[ & Remote Storage EAME

O @ Security Configuration “#fizard 0.6 MB i
O Subzystem for UME-based Applications 1.9MB

[ Teminal Server nnme =

Description:  Shares files and printers on this computer with otherz on the netwaork.

Total disk space required: 439 MB Details |
Space available on disk: 2508, MB —

< Back I Mest > I Cancel | Help |

4  Check Microsoft Service for NFS and click Details.

Other Network File and Print Services E3

To add or remove a component, click the check box. A shaded box means that only part
of the companent will be installed. To see what's included in & component, click Details.

Subcomponents of Other Metwork. File and Print Services:

[] ™ Camman Lag File System 0.0ME ;I
O File Services for Macintosh 0.0mB

r MFS 0.0 B
O Print Services for Lnix 03mMB

[~

Descrption:  Enables UMIX users to both store and gain access to files on a server
unhing Microzaft Windows.

Taotal disk space required: 439 1B Details... |
Space available on disk: 8h08.4 MB
Q. I Cancel |
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5

NetBackup clients

Check the following components:
m Client for NFS
m Microsoft Services for NFS Administration

m RPC External Data Representation

Microsoft Services for NFS E3

To add or remove a component, click the check box. A shaded box means that anly part
of the component will be installed. To zee what's included in a component, click Details.

Subcomponents of Microsoft Services for NFS:

Microzoft Services for MFS Administration
RPC External Data Reprezentation

[] = RPC Part Mapper

O @ Server for MFS

[] = Server For NFS Authentication 0.0ME

| Sié} Idger Mamme Mapping Qome x

Description:  Allows this computer to store ahd gain access to files on UM NFS
FEMVETS.

Tatal dizk zpace required: 43,9 MEB Details... |

Space available on dizk: 508 4 MB

ak I Cancel |

Click OK.

Click OK.

Click Next and complete the Windows Components Wizard.

After the installation is complete, open Services in the Control Panel.
Ensure the following that the Client for NFS service is running.

Repeat this procedure for each Exchange client that performs granular
operations.

49
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Configuring a UNIX or Linux media server and
Windows clients for backups and restores that use
Granular Recovery Technology

To perform backups and restores that use Granular Recovery Technology, perform
the following configuration if you use a UNIX or Linux media server and Windows
clients:

m Confirm that your media server is installed on a platform that supports
granular recovery.
See the NetBackup Enterprise Server and Server 7.x OS Software Compatibility
List.

m No other configuration is required for the UNIX or Linux media server.

m Enable or install NFS on the Exchange granular clients.
See “Enabling Services for Network File System (NFS) on Windows 2008 or
Windows 2008 R2” on page 36.
See “Installing Services for NFS on Exchange granular clients with Windows
2003 R2 SP2” on page 47.

® You can configure a different network port for NBFSD.
See “Configuring a different network port for NBFSD” on page 50.

Configuring a different network port for NBFSD

NBFSD runs on port 7394. If another service uses the standard NBrsD port in your
organization, you can configure the service on another port. The following
procedures describe how to configure a NetBackup server to use a network port
other than the default.

To configure a different network port for NBFSD (Windows server)

1 Logonasadministrator on the computer where NetBackup server is installed.
2 Open Regedit.

3 Open the following key.:

HKEY LOCAL MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

Create a new DWORD value named FSE_PORT.
Right-click on the new value and click Modify.
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6 Inthe Value data box, provide a port number between 1 and 65535.
7 Click OK.

To configure a different network port for NBFSD (UNIX or Linux server)

1 Logon asroot on the computer where NetBackup server is installed.
2 Open the bp.conf file.

3 Add the following entry, where XXXX is an integer and is a port number
between 1 and 65535.

FSE_PORT = XXXX
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Configuring NetBackup for
Exchange

This chapter includes the following topics:

About user interface terminology
About configuring NetBackup for Exchange

About configuring the NetBackup Client Service for backups and restores that
use Granular Restore Technology (GRT) or MAPI

About configuring a backup policy for Exchange Server
Configuring Exchange backups that use Granular Recovery Technology (GRT)
About configuring snapshot backups of Exchange Server

About configuring Instant Recovery backups of Exchange Server (Exchange
2007 and later)

Configuring a streaming NetBackup for Exchange policy (Exchange 2007 and
earlier)

Configuring a policy for backups of individual Exchange mailboxes or public
folders (Exchange 2007 and earlier)

About Exchange client and server privileges for granular operations, virtual
environments, or off-host backups

Configuring exclude lists for Exchange clients
Configuring host properties for Exchange clients

Testing configuration settings for NetBackup for Exchange
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About user interface terminology

You can perform many of the configuration steps in this topic from the NetBackup
Administration Console on the master server. The type of console available depends
on your master server’s platform. NetBackup supports a Java interface for both
Windows and UNIX master servers. In addition, NetBackup supports a Windows
interface for Windows master servers.

The Java and Windows interfaces are nearly identical. If interface differences
exist in the configuration procedures, the term “Windows” or “Java” appears in
the procedure to differentiate between the two interfaces.

About configuring NetBackup for Exchange

To successfully perform backups and restores of Exchange Server and Exchange
mailboxes, complete the following steps.

Table 4-1 Configuring NetBackup for Exchange
Step Action Description
Step 1 Configure the NetBackup Client | Required if you want to do the
Service. following
B Restore individual mailboxes
and public folder items with
granular recovery technology
(GRT).
m Perform MAPI backups of
individual mailbox and public
folder objects (Exchange 2007
and earlier).
Step 2 Review the steps and See “About configuring a backup
recommendations for creating a | policy for Exchange Server”
backup policy. on page 62.
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Configuring NetBackup for Exchange (continued)

Step

Action

Description

Step 3

Review the information and
configuration for the type of
backups you want to perform.

See “Configuring Exchange
backups that use Granular
Recovery Technology (GRT)”
on page 84.

See “About configuring snapshot
backups of Exchange Server”
on page 87.

See “About configuring Instant
Recovery backups of Exchange
Server (Exchange 2007 and later)”
on page 99.

See “Configuring a policy for
backups of individual Exchange
mailboxes or public folders
(Exchange 2007 and earlier)”
on page 111.

See “Configuring a streaming
NetBackup for Exchange policy
(Exchange 2007 and earlier)”
on page 108.

Step 4

Configure the host properties for
Exchange clients.

See “Configuring host properties
for Exchange clients” on page 120.

Step 5

Configure the client and server
privileges.

Required for granular operations,
virtual environments, and off-host
backups.

See “Configuring Exchange client
and server privileges for granular
operations, virtual environments,
or off-host backups” on page 115.

Step 6

Test your configuration settings.

See “Testing configuration
settings for NetBackup for
Exchange” on page 126.
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About configuring the NetBackup Client Service for
backups and restores that use Granular Restore
Technology (GRT) or MAPI

To restore individual mailbox and public folder items, you must configure an
account and mailbox for NetBackup to use. This configuration is also required for
Exchange 2007 and earlier if you perform MAPI backups of individual mailbox
and public folder objects.

NetBackup must also have administrator access to Exchange mailboxes and public
folders so it can do the following:

m Enumerate mailboxes when defining a policy.
m Perform MAPI mailbox and public folder backups (Exchange 2007 and earlier)

m Restore mailbox and public folder objects from MAPI backups or backups that
use Granular Recovery Technology (GRT).

Table 4-2 Steps to configure the NetBackup Client Service for backups and
restores that use Granular Restore Technology (GRT) or MAPI
Step Action Description
Step 1 Associate the NetBackup Client | Symantec recommends that you
Service with a valid Exchange create a uniquely named mailbox
mailbox. and that the NetBackup Client

Service uses the same account that
runs Exchange Services.

Step 2 Ensure that the NetBackup service
account has domain privileged
rights.

Step 3 Verify that the NetBackup service

account mailbox is not hidden.
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Table 4-2

or MAPI

Steps to configure the NetBackup Client Service for backups and
restores that use Granular Restore Technology (GRT) or MAPI

(continued)

Step

Action

Description

Step 4

Configure the NetBackup service
account.

See “Configuring the NetBackup
service account (Exchange 2010)”
on page 57.

See “About NetBackup and
Microsoft Exchange Web Services
(Exchange 2010)” on page 58.

See “Configuring the NetBackup
service account (Exchange 2007)”
on page 59.

See “Configuring the NetBackup
service account (Exchange 2003)”
on page 60.

Step 5

Configure the log on account for
the NetBackup Client Service.

See “Configuring the log on
account for the NetBackup Client
Service for Windows” on page 61.

See “About configuring NetBackup for Exchange” on page 54.

Configuring the NetBackup service account (Exchange 2010)

If in a cluster or replicated environment, perform the steps in the following
procedures on each Exchange node. Also perform these steps on the Exchange
Client Access Server (CAS).

To configure the NetBackup service account (Exchange 2010)

1 In Active Directory Users and Computers, select the Users directory.

2 Right-click on the Administrator account, click Copy, and create an account

for NetBackup.

Create a user account that has a mailbox with a unique name. A unique name

is one that does not already exist within the Exchange Organization. This
name cannot be contained as a set of characters in an existing name.

For example: EXCH1 is entered as the unique mailbox name, and other mailbox
names such as EXCH1BACKUP or BACKUPEXCH1 exist. The backup or restore

of individual mailboxes or both fail.

3 Double-click on the account you created.
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4 In the Properties dialog box, click the Members Of tab.
Click Add and add this account to the following groups Domain Admins group:
m Administrators
m Domain Users
m Organization Management
6 Configure the NetBackup Client Service log on account.

See “Configuring the log on account for the NetBackup Client Service for
Windows” on page 61.

7 If youreceive an “Access is denied” error when you perform a restore, you
may need to run the following commands:

New-ManagementRole -Name EWSImpersonationRole -Parent ApplicationImpersonation

New-ManagementRoleAssignment -Role EWSImpersonationRole -User Administrator

EWSImpersonationRoleAssignment

where Administrator is the alias of the Active Directory account you want to
use.

See “About configuring NetBackup for Exchange” on page 54.

About NetBackup and Microsoft Exchange Web Services (Exchange

2010)

For Exchange 2010, NetBackup uses Microsoft Exchange Web Services (EWS) to
support a backup that uses the Granular Recovery Technology (GRT). EWS provides
support for the restore of individual mailboxes, mail messages, and public folders
from an Exchange 2010 database backup.

To use EWS to restore individual items, the client throttling policy is disabled for
the resource credentials you specify for the restore job. The client throttling policy
is located on the Client Access Server and enforces connection bandwidth limits
on the Exchange server.

NetBackup also creates an impersonation role and a role assignment for Exchange
Impersonation. Exchange Impersonation role assignment associates the
impersonation role with the NetBackup resource credentials you specify for the
restore job.

NetBackup creates and assigns the following roles:
m SymantecEWSImpersonationRole

m SymantecEWSImpersonationRoleAssignment
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See “About configuring NetBackup for Exchange” on page 54.

See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.

See “About Exchange backups and transaction logs” on page 82.

Configuring the NetBackup service account (Exchange 2007)

If in a cluster or replicated environment, perform the steps in the following
procedures on each Exchange node.

To configure the NetBackup service account (Exchange 2007)
1 In Active Directory Users and Computers, select the Users directory.

2 Right-click on the Administrator account, click Copy, and create an account
for NetBackup.

Create a user account that has a mailbox with a unique name. A unique name
is one that does not already exist within the Exchange Organization. This
name cannot be contained as a set of characters in an existing name.

For example: EXCH1 is entered as the unique mailbox name, and other mailbox
names such as EXCH1BACKUP or BACKUPEXCH1 exist. The backup or restore
of individual mailboxes or both fail.

3 After youcreate the account, double-click the account, click the Members Of
tab, and add this account to the Domain Admins group.

Open the Exchange Management Console.

In the Exchange Management Console, right-click on Organization
Configuration and click Add Exchange Administrator.

6 Onthe Add Exchange Administrator page, click Browse and select the user
to which you want to delegate control.

Click the Exchange Server Administrator role.

Under Select the server(s) to which this role has access, click Add.
9 Select the servers to which you want to delegate control and click OK.
10 Click Add.

11 On the Completion page, verify that the delegation was successful and click
Finish.

12 Configure the NetBackup Client Service log on account.

See “Configuring the log on account for the NetBackup Client Service for
Windows” on page 61.
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See “About configuring NetBackup for Exchange” on page 54.

Configuring the NetBackup service account (Exchange 2003)

If in a cluster environment, perform the steps in the following procedures on each

Exchange node.

To configure the NetBackup service account (Exchange 2003)

1

N O o ~W

Use Active Directory Users and Computers to create a user account that has

a mailbox with a unique name.

A unique name is one that does not already exist within the Exchange
Organization. This name cannot be contained as a set of characters in an
existing name.

For example: EXCH1 is entered as the unique mailbox name, and other mailbox
names such as EXCH1BACKUP or BACKUPEXCH1 exist. The backup or restore

of individual mailboxes or both fail.

After you create the account, double-click the account, click the Members Of

tab, and add this account to the Domain Admins group.

Open Exchange System Manager.

Right-click the Exchange Organization and click Delegate Control.
Click Next.

On the Users or the Groups screen, click Add.

In the Delegate Control dialog box, provide the following information.

Group or User Specify the name of the account that was created in step 1.

Role Select Exchange Full Administrator.

Complete the Delegation wizard.
Configure the NetBackup Client Service log on account.

See “Configuring the log on account for the NetBackup Client Service for
Windows” on page 61.

See “About configuring NetBackup for Exchange” on page 54.
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Configuring the log on account for the NetBackup Client Service for

Windows

By default, the NetBackup Client Service uses “Local System” account to log on
as. A different account is required for the following operations: MAPI mailbox
and public folder items backups (Exchange 2007 and earlier) and any operations
that use Granular Recovery Technology (GRT).

Change the service account to the Windows domain account that you previously
created. To change this account, you must have administrator group privileges.

See “Configuring the NetBackup service account (Exchange 2010)” on page 57.
See “Configuring the NetBackup service account (Exchange 2007)” on page 59.
See “Configuring the NetBackup service account (Exchange 2003)” on page 60.

Note: In a cluster environment, perform the steps on each database node in the
cluster. For Exchange 2010, perform the steps on each database node in the DAG
and the CAS server. For an off-host backup, perform the steps on the alternate
client.

To configure the log on account for the NetBackup Client Service
1 Open the Windows Services application.

2 Double-click on the NetBackup Client Service entry.

3 Click on the Log On tab.
4

If Local System account is not selected as the Log on as account, proceed
with step 9.

5 Provide the name of the user account that you created for the NetBackup
Client Service.

See “Configuring the NetBackup service account (Exchange 2010)” on page 57.
See “Configuring the NetBackup service account (Exchange 2007)” on page 59.
See “Configuring the NetBackup service account (Exchange 2003)” on page 60.

The account must include the domain name, followed by the user account,
domain_name\account. For example, recovery\netbackup.

Type the password.
Click OK.

Stop and start the NetBackup Client Service.

O 00 N O

Close the Services control panel application.
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About configuring a backup policy for Exchange

Server

A backup policy for a database defines the backup criteria for a specific group of
one or more clients.

These criteria include the following:
m Storage unit and media to use

m Policy attributes
You can configure snapshot backups and backups that uses Granular Recovery
Technology (GRT). For Exchange 2007 and earlier, you can also configure
streaming database backups, MAPI mailbox backups, and public folder backups.

m Backup schedules
m Clients to be backed up
m Items (database objects) to be backed up

To back up a database environment, define at least one MS-Exchange-Server
policy with the appropriate schedules. A configuration can have a single policy
that includes all clients, or there can be many policies, some of which include only
one client.

Most requirements for database policies are the same as for file system backups.
In addition to the policy attributes for this database agent, other attributes are
available that you should consider.

See the NetBackup Administrator’s Guide, Volume I.

Table 4-3 Configuring a backup policy for Exchange Server

Step

Action Description

Step 1

Refer to the policy recommendations for your See “Policy recommendations for Exchange Server
Exchange version. 2010” on page 63.

See “Policy recommendations for Exchange Server
2007 and earlier database backups” on page 66.

See “Policy recommendations for Exchange Server
2007 and earlier MAPI backups” on page 67.
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Table 4-3

Configuring a backup policy for Exchange Server (continued)

Step

Action

Description

Step 2

Refer to the instructions for the type of backup
you want to perform.

See “Configuring Exchange backups that use
Granular Recovery Technology (GRT)” on page 84.

See “About configuring snapshot backups of
Exchange Server” on page 87.

See “About configuring Instant Recovery backups
of Exchange Server (Exchange 2007 and later)”
on page 99.

See “Configuring a streaming NetBackup for
Exchange policy (Exchange 2007 and earlier)”
on page 108.

See “Configuring a policy for backups of
individual Exchange mailboxes or public folders
(Exchange 2007 and earlier)” on page 111.

Step 3

Configure the policy attributes.

See “About policy attributes for NetBackup for
Exchange” on page 69.

Step 4

Configure the schedules for your policy.

See “Adding schedules to a NetBackup for
Exchange policy” on page 70.

Step 4

Add clients to your policy.

See “Adding clients to a NetBackup for Exchange
policy” on page 73.

Step 5

Add backup selections to your policy.

See “Adding backup selections to an Exchange
policy” on page 74.

See “About configuring NetBackup for Exchange” on page 54.

Policy recommendations for Exchange Server 2010

Refer to the following recommendations when you create policies for an Exchange

Server 2010 Database Availability Group (DAG):

m Create a policy that backs up an entire DAG or one or more databasesin a DAG.

This policy supports full, incremental, and user-directed backups.

To perform a backup with Granular Recovery Technology (GRT) select the
Enable granular recovery option. Then you can restore databases and
individual mailbox and public folder items. You cannot restore individual
mailbox and public folder items from any incremental backups.

m MAPI mailbox and public folder backups are not supported with Exchange

2010.
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m The example policies include the basic policy settings for an Exchange backup.
For more information on how to create policies, see the following:
See “About configuring snapshot backups of Exchange Server” on page 87.

Table 4-4 Example policy that backs up all databases in an Exchange DAG
Policy item Configuration
Policy type MS-Exchange-Server
Backup selections Microsoft Exchange Database Availability Groups:\
Auto backup frequency Weekly Full

Daily Incremental

Enable granular recovery Optional. Enable this option if you want to restore individual
mailbox and public folder objects from the database backup.

Other configuration Perform snapshot backups must be enabled.

You can include multiple clients on the Clients tab. The
client names are the DAG names.

Table 4-5 Example policy that backs up a database for an Exchange DAG
Policy item Configuration
Policy type MS-Exchange-Server
Backup selections Microsoft Exchange Database Availability Groups:\Mailbox
Database

Microsoft Exchange Database Availability Groups:\forest or
domain name\Microsoft Information Store\Mailbox
Database

Auto backup frequency Weekly Full

Daily Incremental

Enable granular recovery Optional. Enable this option if you want to restore individual
mailbox and public folder objects from the database backup.

Other configuration Perform snapshot backups must be enabled.

You can only include one client on the Clients tab. A DAG
is the client for the policy.

Refer to the following recommendations when you create policies for an Exchange
2010 standalone server:
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m Create a policy that backs up the Information Store or individual databases.
To perform a backup with Granular Recovery Technology (GRT), select the

Enable granular recovery option. This policy supports full, incremental, and

user-directed backups.

From either policy you can restore databases and individual mailbox and public
folder items. You cannot restore individual mailbox or public folder items from

any incremental backups that use GRT.

m MAPI mailbox and public folder backups are not supported with Exchange

2010.

m For information on how to create snapshot backup policies, see the following:

See “About configuring snapshot backups of Exchange Server” on page 87.

Table 4-6 Example policy that backs up all database in an Exchange 2010
standalone server
Policy item Configuration
Policy type MS-Exchange-Server

Backup selections

Microsoft Information Store:\

Auto backup frequency

Weekly Full

Daily Incremental

Enable granular recovery

Optional. Enable this option if you want to restore individual
mailbox and public folder objects from the database backup.

Other configuration

Perform snapshot backups must be enabled.

Table 4-7 Example policy that backs up a database in an Exchange 2010
standalone server
Policy item Configuration
Policy type MS-Exchange-Server

Backup selections

Microsoft Information Store:\Mailbox Database

Auto backup frequency

Weekly Full

Daily Incremental

Enable granular recovery

Yes

Other configuration

Perform snapshot backups must be enabled.

See “About configuring NetBackup for Exchange” on page 54.
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Policy recommendations for Exchange Server 2007 and earlier database

backups

Refer to the following recommendations when you create database backup policies
for Exchange Server 2007 and earlier:

Create a policy that backs up the Information Store, a storage group, or an
individual database. This policy supports full, incremental, and user-directed
backups.

To perform the backup with Granular Recovery Technology (GRT) select the
Enable granular recovery option. Then you can restore databases and
individual mailbox and public folder items. You cannot restore these individual
items from any incremental backups that use GRT.

The example policies include the basic policy settings for an Exchange backup.
For more information on how to create policies, see the following:

See “About configuring snapshot backups of Exchange Server” on page 87.
See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007
and earlier)” on page 108.

Table 4-8 Example Exchange 2007 and earlier streaming backup or snapshot

policy that backs up all the databases

Policy item Configuration

Policy type MS-Exchange-Server

Backup selections Microsoft Information Store:\

Auto backup frequency Weekly Full

Daily Incremental

Enable granular recovery Optional. Enable this option if you want to restore individual

mailbox and public folder objects from the database backup.

Other configuration For snapshot backups, select Perform snapshot backups.

Table 4-9 Example snapshot policy that backs up a storage group for an

Exchange 2007 or earlier database

Policy item Configuration

Policy type MS-Exchange-Server

Backup selections Microsoft Information Store:\Storage Group
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Table 4-9 Example snapshot policy that backs up a storage group for an
Exchange 2007 or earlier database (continued)

Policy item Configuration
Auto backup frequency Weekly Full
Daily Incremental

Enable granular recovery Optional. Enable this option if you want to restore individual
mailbox and public folder objects from the database backup.

Other configuration Select Perform snapshot backups.
Table 4-10 Example Exchange 2007 or earlier streaming backup policy that
backs up a storage group or a storage group database
Policy item Configuration
Policy type MS-Exchange-Server
Backup selections Microsoft Information Store:\Storage Group

Microsoft Information Store:\Storage Group\Database

Auto backup frequency Weekly Full

Daily Incremental

Enable granular recovery Optional. Enable this option if you want to restore individual
mailbox and public folder objects from the database backup.

Other configuration Do not select Perform snapshot backups.

To ensure that transaction logs are deleted regularly include
all databases for a storage group in a full backup policy. Or
specify the storage group (not individual databases) in the
backup policy.

See “About Exchange backups and transaction logs”
on page 82.

See “About configuring NetBackup for Exchange” on page 54.

Policy recommendations for Exchange Server 2007 and earlier MAPI
backups

Refer to the following recommendations when you create MAPI backup policies
for Exchange Server 2007 and earlier:
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m Create a policy that backs up mailbox objects. This policy supports full,
incremental, and user-directed backups. (In Table 4-11.)

m Create a policy that backs up public folder objects. This policy supports full,
incremental, and user-directed backups. (In Table 4-12.)

m The Enable granular recovery and Perform snapshot backups options are
not applicable for MAPI backups.

m The example policies include the basic policy settings for an Exchange backup.

For more information o

n how to create policies, see the following:

See “Configuring a policy for backups of individual Exchange mailboxes or

public folders (Exchang

Table 4-11 NetBacku

e 2007 and earlier)” on page 111.

p policy example for Exchange Server 2007 or earlier MAPI

mailbox backup

Policy item

Configuration

Policy type

MS-Exchange-Server

Backup selections

Microsoft Exchange Mailboxes:\

Auto backup frequency

Weekly Full

Daily Incremental

Enable granular recovery

Not applicable for MAPI backups.

Other configuration

A backup of all mailboxes may not complete within the
backup windows. Consider adding smaller groups of
mailboxes to multiple policies.

Perform snapshot backups is not applicable for MAPI
backups.

Table 4-12 NetBackup policy example for Exchange Server 2007 or earlier MAPI
public folder backup
Policy item Configuration
Policy type MS-Exchange-Server

Backup selections

Microsoft Exchange Public Folders:\

Auto backup frequency

Weekly Full

Daily Incremental

Enable granular recovery

Not applicable for MAPI backups.
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Table 4-12 NetBackup policy example for Exchange Server 2007 or earlier MAPI
public folder backup (continued)
Policy item Configuration
Other configuration Perform snapshot backups is not applicable for MAPI
backups.

See “About configuring NetBackup for Exchange” on page 54.

About policy attributes for NetBackup for Exchange

With a few exceptions, NetBackup manages a database backup like a file system
backup. Other policy attributes vary according to your specific backup strategy
and system configuration.

For more information on policy attributes, see the NetBackup Administrator’s
Guide, Volume I.

Table 4-13 Policy attribute descriptions for NetBackup for Exchange policies

Attribute

Description

Policy type

Determines the types of clients that can be in the policy. In some cases the policy type
determines the types of backups that NetBackup can perform on those clients. To use the
Exchange database agent, you must define at least one policy of type that is
MS-Exchange-Server.

Policy storage

In an Exchange 2010 DAG environment where the Exchange server is a both a client and
a media server, policy storage is treated differently. If you want to back up to the local
Exchange client that is also a media server, specify a storage unit group. NetBackup
automatically selects the local storage unit from the storage unit group during the backup
processing. If you specify a single storage unit, all backups use this storage unit.

Allow multiple data
streams

Specifies that NetBackup can divide automatic backups for each client into multiple jobs.
Each job backs up only a part of the list of backup selections.The jobs are in separate data
streams and can occur concurrently. The number of available storage units, multiplex
settings, and the maximum jobs parameters determine the total number of streams and
how many can run concurrently. Not all directives in the backup selections list allow for
multiple database streams.

For Exchange 2010, you can create multiple data streams at the database level. For Exchange
2007 and earlier, you can create multiple data streams at the storage group level. For MAPI
mailbox and public folder backups, you can create multiple data streams at the mailbox or
public folder level.
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Table 4-13 Policy attribute descriptions for NetBackup for Exchange policies
(continued)

Attribute

Description

Enable granular
recovery

Allows restores of individual items using Granular Recovery Technology (GRT). Users can
only restore individual items from a full backup. (You can perform incremental backups
using GRT, but the backup does not save granular information and you cannot restore
individual items from an incremental backup.)

You can restore individual items only if the backup image resides on a disk storage unit. If
you want to retain a granular backup on tape, you must duplicate the image. If you want
to restore from a granular backup that was duplicated to tape, you must import the image
to a disk storage unit.

See “About disk storage units and restores using Granular Recovery Technology (GRT)”
on page 85.

Exchange Server GRT-enabled backups do not support encryption or compression.

Keyword phrase

A textual description of a backup. Useful for browsing backups and restores.

Perform snapshot
backups

This option enables snapshot backups. For Exchange 2010 you must enable this option for
all backup policies.

See “About snapshot backups with Exchange Server” on page 20.

Microsoft Exchange
Attributes

Indicates what database backup source you want to use for an Exchange 2010 Database
Availability Group (DAG) or for an Exchange 2007 replication backup (LCR or CCR). For
Exchange 2010, you can also indicate a preferred server list.

See “Backup source for an Exchange 2010 DAG backup or an Exchange 2007 replication
backup ” on page 96.

See “Configuring a preferred server list for an Exchange 2010 Database Availability Group
(DAG)” on page 97.

Adding schedules to a NetBackup for Exchange policy

Each policy has its own set of schedules. These schedules control the initiation
of automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for Exchange policy
1 Inthe Policy dialog box, click the Schedules tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.

Specify a unique name for the schedule.



Configuring NetBackup for Exchange
About configuring a backup policy for Exchange Server

4  Select the Type of backup.

See “NetBackup for Exchange backup types” on page 71.
5 Specify the other properties for the schedule.

See “About NetBackup for Exchange schedule properties” on page 73.
6 Click OK.

NetBackup for Exchange backup types

This topic describes the types of backups you can schedule for backups of Exchange
Server.

Note: Incremental backups fail if database circular logging is configured for the
Exchange Server. See Microsoft’s Exchange Server Administration Guide for more
information on how to configure circular logging.

Note: Incremental backups back up the Exchange transaction logs. Therefore,
since Exchange 2007 and earlier maintains transaction logs at the storage group
level, NetBackup performs incremental backups of storage groups, not individual
databases within storage groups. NetBackup lets you configure incremental
schedules for individual databases. The backup job still runs according to the
configured incremental schedules, but the job logs warnings for attempted
incremental backups of these objects.

Table 4-14 NetBackup for Exchange backup types
Type of backup Description
Full backup This schedule type backs up the Exchange Server database and associated transaction

logs. Exchange truncates all committed transaction logs after NetBackup notifies it that
the backup succeeded. In replicated environments, the truncation is scheduled and does
not occur immediately.

By default, transaction logs are not truncated for Instant Recovery backups. You can enable
the truncation of logs for this type of backup or you can perform a backup to a storage
unit.

See “About truncating Exchange transaction logs with Instant Recovery backups”
on page 124.

See “Truncating Exchange transaction logs by performing a backup to a storage unit”
on page 124.
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Table 4-14 NetBackup for Exchange backup types (continued)

Type of backup

Description

Differential incremental
backup

Includes the changes since the last full or differential incremental backup. After NetBackup
notifies it that the backup succeeded, Exchange truncates all committed transaction logs.
The truncation of the transaction logs sets the context for the next backup.

For backups of databases, storage groups, or the entire Information Store, the backup only
includes the transaction logs. This type of schedule is not supported for Exchange 2003
pre-SP1 snapshot backups. Individual items cannot be restored for this type of backup if
Enable granular recovery is enabled.

To perform a full restore the data that is needed is contained in multiple NetBackup images.
One image for the full backup and another image for each differential incremental that
was performed.

Cumulative incremental
backup

Includes the changes since the last full backup or differential incremental backup. (However,
most configurations do not mix cumulative and differential incremental backups between
full backups.) Exchange does not truncate the logs when the backup is completes. When
a series of cumulative incremental backups follows a full backup, transaction logs remain
intact since the last full backup.

For backups of databases, storage groups, or the entire Information Store, the backup only
includes the transaction logs. For Exchange 2007 and earlier, you also can use this schedule
type to back up changes to the mailboxes or the Public Folders. This type of schedule is
not supported for Exchange 2003 pre-SP1 snapshot backups. Individual items cannot be
restored for this type of backup if Enable granular recovery is enabled.

Consider an Exchange Server data recovery scenario where the transaction logs are all
intact. You only need to restore the database from the last full backup and the last
cumulative incremental backup. During recovery, Exchange Server replays all the logs
that are in the log folder.

User backup

A user backup is not automatically scheduled and is initiated on the target client computer.
It is like a snapshot (or a copy backup) of the databases at a given point in time. This backup
does not affect the content of ongoing full and incremental backups. Transaction logs are
not truncated for Exchange 2003 SP1 and later snapshot backups, but are truncated for
Exchange 2003 pre-SP1 snapshot backups .

For streaming backups, you can configure user backups to truncate the logs.

See “Performing user-directed full streaming backups (Exchange 2007 and earlier)”
on page 134.

You may want to consider creating a separate policy for user backup schedule types. Then
you can easily separate user-directed and scheduled backups when you restore files. If
you decide to create separate policies for user backup schedule types, the considerations
are similar to those for automatic backups. A backup selections list is not needed because
users select the files to restore.
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About NetBackup for Exchange schedule properties

This topic describes the schedule properties that have a different meaning for
database backups than for file system backups. Other schedule properties vary
according to your specific backup strategy and system configuration. Additional
information about other schedule properties is available.

See the NetBackup Administrator’s Guide, Volume I.

Table 4-15 Description of schedule properties
Property Description
Type of backup Specifies the type of backup that this schedule controls. The selection list shows only the

backup types that apply to the policy you want to configure.
See “NetBackup for Exchange backup types” on page 71.

Schedule type You can schedule a backup in one of the following ways:

m Frequency
This setting is used only for scheduled backups. It is not used for user-directed backups.
Frequency specifies the period of time that can elapse until the next backup or archive
operation begins on this schedule. For example, assume that the frequency is seven
days and a successful backup occurs on Wednesday. The next full backup does not
occur until the following Wednesday. Typically, incremental backups have a shorter
frequency than full backups.

m Calendar
This setting is used only for scheduled backups. It is not used for user-directed backups.
The Calendar option allows you to schedule backup operations that are based on specific
dates, recurring week days, or recurring days of the month.

More information is available on schedule types and instant recovery backups.
See “Adding schedules for Exchange Instant Recovery” on page 105.

See “Schedules settings in Exchange Instant Recovery policies” on page 106.

Retention Specifies a retention period to keep backup copies of files before they are deleted. The
retention level also denotes a schedules priority within the policy. A higher level has a
higher priority. Set the time period to retain at least two full backups of your database. In
this way, if one full backup is lost, you have another full backup to restore. For example,
if your database is backed up once every Sunday morning, you should select a retention
period of at least 2 weeks.

Adding clients to a NetBackup for Exchange policy

The clients list contains a list of the clients that are backed up during an automatic
backup. A NetBackup client must be in at least one policy but can be in more than
one.
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For a NetBackup for Exchange policy, clients you want to add must have the
following software installed:

m Exchange Server

m NetBackup client or server

To add clients to a NetBackup for Exchange policy

1

N o0 0o b

In the Policy dialog box, click the Clients tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

Click New.
Type the name of the client and press Enter (Windows) or click Add (Java).
Note the following:

m IfExchangeis clustered or in a Database Availability Group (DAG), specify
the virtual Exchange name that represents that cluster or DAG.

m If you want to perform a restore from a backup using Granular Recovery
Technology (GRT), ensure that the clients meet the requirements for
granular restore.

See “Configuring Exchange client and server privileges for granular
operations, virtual environments, or off-host backups” on page 115.

m For off-host backups, the client name should be the name of the primary
client.

(Windows) To add another client, repeat step 2 and step 3.
(Java) To add another client, repeat step 3.
If this client is the last client you want to add, click OK.

(Java) In the Policy dialog box, click Close.

Adding backup selections to an Exchange policy

The backup selections list defines the Exchange objects to back up and the grouping
of Exchange objects for multiple data streams. Exchange objects are defined
through directives. You can append an individual object name to a directive to
specify a storage group, database, mailbox, or public folder. You can use wildcards
to specify a group of such objects.
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Note: In a backup policy, include directives from only one directive set. For
example, do not add Microsoft Exchange Database Availability Groups:\
(a DAG directive) and Microsoft Information Store:\ (a standalone database
directive) to the same policy. Also do not add Microsoft Information Store:\
and Microsoft Exchange Mailboxes:\ OF Microsoft Exchange Public
Folders:\ to the same policy.

The following directives exist:

Table 4-16 NetBackup for Exchange Server directive sets and directives
Directive set Directive(s) Notes
MS_Exchange Database | NEW_STREAM This directive set applies to Exchange 2010
standalone servers and to Exchange 2007 and

Microsoft Information Store:\ .
earlier.

See “Notes and limitations for creating a backup
selections list for Exchange 2007 and earlier
streaming database backups” on page 111.

See “About excluding Exchange items from
backups” on page 80.

MS_Exchange Database
Availability_Groups

NEW_STREAM

Microsoft Exchange Database

Availability Groups:\
MS_Exchange_Mailbox | NEW_STREAM Only supported for Exchange 2007 and earlier.
Microsoft Exchange Mailboxes:\ See “Notes and limitations when you create a
backup selections list for MAPI mailbox and public
folder backups” on page 114.
See “About excluding Exchange items from
backups” on page 80.
MS_Exchange Public_ | NEW_STREAM Only supported for Exchange 2007 and earlier.

Folders

Microsoft Exchange Public Folders:\ | See “Notes and limitations when you create a
backup selections list for MAPI mailbox and public
folder backups” on page 114.

See “About excluding Exchange items from
backups” on page 80.

Refer to the following topics when you add backup selections:

m See “Adding Exchange entries to a backup selections list by browsing (Windows
only)” on page 76.
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m See “Adding Exchange entries to the backup selections list manually”
on page 76.

m See “Performing Exchange backups with multiple data streams” on page 77.

m See “About excluding Exchange items from backups” on page 80.

Adding Exchange entries to a backup selections list by browsing
(Windows only)

On Windows systems, you can browse for Exchange objects and add them to the
backup selections list. Alternatively, you can specify the objects manually..

To add Exchange entries to the backup selections list by browsing (Windows only)
1 Inthe Policy dialog box, click the Backup Selections tab.

Click New.

Click the Remote Folder icon.

Navigate to and click the Exchange object to back up and click OK.

g b~ W N

If necessary, edit the entry.
m Append the object name to the new entry.

m If amailbox specification without wildcards does not end with a backslash,
add it.

m Add wildcard characters if you want to define groups of objects or use
multiple data streams.

See “Performing Exchange backups with multiple data streams”
on page 77.
See “Using wildcards in an Exchange backup selections list” on page 78.

6 Click OK.

Adding Exchange entries to the backup selections list manually

You can add database objects manually to the backup selections list, if you do not
want to use the browse feature.

To manually add entries to the backup selections list

1 Inthe Policy dialog box, click the Backup Selections tab.
Click New.

(Windows) Click the Directives button.

Select the directive set.

o A W N

Select the directive.
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6 Click OK.
Edit the new entry if you want to define groups of objects or use multiple data
streams.

8 Click OK.

Performing Exchange backups with multiple data streams

When you enable multiple data streams, backups are divided into multiple jobs.
Each job backs up only a part of the backup selections list. To use multiple data
streams, enable Allow multiple datastreams on the Attributes tab for the policy.

You can choose to have NetBackup automatically determine where to begin new
streams by adding an asterisk (*) after the directive. Or you can control where
each stream begins by inserting the NEW_STREAM directive at a certain point
or points in the backup selections list. If you use wildcard characters to define
Exchange objects in the backup selections list, those objects are backed up in
multiple streams.

When you back up multiple Exchange 2010 databases, NetBackup groups the
backup jobs by the selected server. One snapshot is performed for all of the
replicated databases on a given server. Another snapshot is performed for all the
active databases on the server. Multistreaming then applies to the database
backups that are performed on each snapshot.

For more information on the multiple data streams feature, see the following:

NetBackup Administrator’s Guide, Volume I

Using multiple datastreams with Exchange Database
Availability Groups (DAG)s

When you back up databases in a Database Availability Group (DAG), NetBackup
selects the server to back up each database according to your data source and
preferred server list settings. The backup jobs are grouped by server. From your
backup selections list, all of the databases that have passive copies on a given
server are grouped under one snapshot job. They are then backed up by one or
more child backup jobs. All of the databases that have active copies on the server
are grouped under another snapshot job, followed by one or more backup jobs.

Note: Use explicit NEw_sTREAM directives in a DAG only when you are confident
which servers will back up which databases.

The nEw_sTrEAM directive works as follows:
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m When you do not enable multiple backup streams, all of the databases for a
snapshot job are backed up in a single backup job.

m When you enable multiple backup streams and do not specify any NEw_STREAM
directives, each database is backed up in its own backup job.

m When you enable multiple backup streams and do specify NEw_sTreamdirectives
in your policy, then NetBackup tries to group the database backups into jobs
according to the placement of the NEw_sTREaMdirectives in the backup selection
list. The result is affected by the grouping of database backups into snapshot
jobs. NetBackup separates backup jobs after any database that is followed by
aNEW_sTREAM directive in the policy.

See “About excluding Exchange items from backups” on page 80.

See “About configuring NetBackup for Exchange” on page 54.

Using wildcards in an Exchange backup selections list

Wildcard characters can be used to define groups of databases, storage groups,
mailboxes or public folders. This way multiple objects can be backed up without
having to specify the objects individually in the backup selections list. Multiple
data streams must also be enabled. If this feature is not enabled, the backup fails.

See “Performing Exchange backups with multiple data streams” on page 77.

Table 4-17

Supported wildcard characters

Wildcard character

Action

Asterisk (*)

Use as a substitute for zero or more characters. Specify
the asterisk as the last character in the string.

Example: To specify all objects that start with an a use

ax.

Question mark (?)

Use as a substitute for one or more characters in a name.

Example 1: The string s ?z processes all objects that
have s for a first character, any character for a second
character, and z for a third character.

Example 2: The string Data??se processes all objects
that have Data as the first four characters, any
characters for the fifth and sixth characters, and se as
the seventh and either characters.
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Supported wildcard characters (continued)

Wildcard character

Action

Left & right brackets ([ ... ])

Use to match any one character that is enclosed in
square brackets. A minus (-) can be used to indicate a
range of consecutive characters; for example, [0-9] is
equivalent to [0123456789].

These wildcard characters are not supported for the
Microsoft Information Store:\ directive or for
the Microsoft Exchange Database
Availability Groups:\ directive.

Note: The minus (-) loses this special meaning if it
occurs last in the string.

Note: The right square bracket (]) does not terminate
such a string when it is the first character within it. For
example, [] a-f] matches either aright square bracket
(]) or one of the ASCII letters a through f inclusive.
Asterisk (*) and Question Mark (?) stand for themselves
within such a string of characters.

The following rules apply when wildcard characters are used in the backup

selections list:

m Only one wildcard pattern per backup selections list entry is allowed.

m If a wildcard pattern is not honored it is treated literally.

m Wildcard patterns are honored only in the final segment of the path name.

Correct

Microsoft
Microsoft
Microsoft
Microsoft
Microsoft
Microsoft

Microsoft

Information
Information
Information
Information
Information

Information

Store:\*
Store:\StorageGroup?
Store:\Database*
Store:\Data??se
Store:\Storage Group*

Store:\Storage?G?oup

Exchange Mailboxes:\John Anderson [janderson]\Top of

Information Store\*

Microsoft
Microsoft
Microsoft
Incorrect

Microsoft

Exchange Database Availability Groups:\*

Exchange Database Availability Groups:\Database*

Exchange Database Availability Groups:\Data??se

Information

Store:\StorageGroup?\Mailbox Database
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Microsoft Exchange Mailboxes:\John Anderson [janderson]\*\Inbox

m For an Exchange Mailboxes path: Any segment of the path can contain wildcard
characters as long as the wildcard characters are the last characters in the
segment. These segments include mailbox names, folders, or messages within
the mailbox hierarchy.

Correct

Microsoft Exchange Mailboxes:\John Anderson [janderson]\Top of
Information Store\*

Microsoft Exchange Mailboxes:\John Anderson [janderson]\Top of
Information Store\[a-h]

Incorrect

Microsoft Exchange Mailboxes:\[a-h]\Top of Information Store

Microsoft Exchange Mailboxes:\John Anderson [janderson]\Top*\

m For Exchange public folders: Any segment of the path can contain wildcard
characters as long as the wildcard characters are the last characters in the
segment. These segments include workspace names or workspace folders.
Correct
Microsoft Exchange Public Folders:\Folderl\Subfolder?

Incorrect
Microsoft Exchange Public Folders:\Folder?\Subfolderl

Microsoft Exchange Public Folders:\*\Subfolderl

See “About configuring NetBackup for Exchange” on page 54.

About excluding Exchange items from backups

This topic describes how to exclude storage group or database items from an
Exchange VSS backup or mailbox or public folder entries from a streaming backup.
An exclude list can be added from the server or from the client.

For more information on how to create an exclude list by using the NetBackup
Administration Console, see one of the following:

m See “Configuring exclude lists for Exchange clients” on page 117.
m The NetBackup Administrator’s Guide, Volume I.

For Exchange 2010, you can exclude specific databases from a backup, both for
databases that exist in a DAG and for databases that exist in a standalone Exchange
server. You can specify the exclude list entry under All Policies or under a specific
policy or schedule. However, if you enter a database in a DAG under All Policies,
the discovery phase of the backup detects the exclude entry and excludes it at
that point. If you enter a database in a DAG for a specific policy, the discovery
phase does not detect it, but the snapshot phase of the backup detects it and
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excludes it. In this case, if this is the only database in the bpfis job, this causes
the snapshot phase to fail with a status 69. The entire backup finishes with an
error, but NetBackup retains the images from all of the other Exchange servers.

For Exchange 2007 and earlier you must specify the storage group name in the
exclude list. Entering a database is not valid because Exchange requires that VSS
backups must contain the entire storage group (for log truncation purposes). The
exclude list entry can be specified under All Policies or under a specific policy or
schedule.

Table 4-18 provides examples of Exchange 2010 entries you can add to an exclude
list.

Table 4-18 Example Exchange 2010 entries in an exclude list
This entry ... excludes ...
Microsoft Information Store:\Database2 The database named Database?2.
YoucanusethesameMicrosoft information
Store: \ directive for both DAG and standalone
databases.
Note that Microsoft Exchange Database
Availability Groups:\Database 2isan
invalid exclude entry.
Table 4-19 provides examples of Exchange 2007 or earlier entries you can add to
an exclude list.
Table 4-19 Example Exchange 2007 or earlier entries in an exclude list

This entry ... excludes ...

Microsoft Information Store:\Storage Groupl The storage group named Storage Groupl.
Table 4-20 provides examples of Exchange mailbox entries you can add to an
exclude list.

Table 4-20 Example Exchange mailbox entries in an exclude list

This entry ... excludes ...

Microsoft Exchange Mailboxes:\J*

All mailboxes with a name that starts with “J”.

Microsoft Exchange Mailboxes:\Joe Smith\ The mailbox “Joe Smith” or “Joe Smith [JoeS]”

Microsoft Exchange Mailboxes:\Joe Smith [JoeS]\

with a name that starts with “Joe Smith”.
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Table 4-20 Example Exchange mailbox entries in an exclude list (continued)

This entry ...

excludes ...

Microsoft Exchange

Mailboxes:\Joe Smith*\Top of |The Deleted Items folder for the mailbox “Joe

Information Store\Deleted Items Smith”.
Microsoft Exchange Mailboxes:\*\Top of Any messages that begin with “SPAM” in the
Information Store\Inbox\SPAM* user’s “Inbox”.

Table 4-21 provides examples of public folder entries you can add to an exclude
list.

Table 4-21 Example public folder entries in an exclude list
This entry ... excludes ...
Microsoft Exchange Public The root public folder called “Marketing”.
Folders:\Marketing
Microsoft Exchange Public All . x1s documents under the Public Folder called “Marketing”.
Folders:\Marketing\*.x1ls

See “About configuring NetBackup for Exchange” on page 54.

See “Using multiple datastreams with Exchange Database Availability Groups
(DAG)s” on page 77.

See “Using wildcards in an Exchange backup selections list” on page 78.

About Exchange backups and transaction logs

For performance and recoverability, the Exchange database uses transaction logs
to accept, track, and maintain data. All transactions are first written to transaction
logs and memory, and then committed to their respective databases. Transaction
logs can be used to recover Information Store databases in the event that a failure
corrupted the database. The Exchange 2010 Information Store can have multiple
separate databases, each of which has its own set of transaction logs. For Exchange
2007 and earlier, the databases in each storage group share a common set of
transaction logs.

Transactions are first written to the log file and then later written to the database.
The effective database is a combination of the uncommitted transactions in the
transaction log file and the actual database file. When the log file is filled with
transaction data, it is renamed and a new log file is created. When the log file is
renamed, the other renamed log files are stored in the same subdirectory. The
renamed log files are named in a sequential numbering order, in hexadecimal.
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For Exchange 2007 and later the database transaction log for the Information
Store is named Exxyyyyyyyy.log. XX is the database number or storage group
number (in hex). YYYYYYYY is the log file number (in hex). The size of the
transaction logs is 1 MB.

For Exchange 2003, the database transaction log for the Information Store is
named E0yXxxxX.1log. Yis a number from O to 3 representing the storage group.
XXXXX is a five-digit hexadecimal number that is incremented each time an
EOy.1log file is renamed. For example, E010029E. log, E010029F. log,
E010029A.10g.The size of the transaction logs is 5 MB.

After every 1 MB or 5 MB of transaction log data is written, a new log is created.
The log is created even though the transaction data may not be committed to the
database. There may be several transaction logs that contain uncommitted data,
therefore they cannot be purged.

Exchange 2010 transaction logs get committed to their database over time or
when the services are brought down. Any transactions that existed in log files
and not in the database file are committed to the database.

Exchange 2007 and earlier transactions in log files are committed to the respective
database over time, or when the service shuts down normally. For example,
consider when the Information Store service experiences a normal shutdown
(service shuts down with no errors). Any transactions that existed in log files and
not in the database file are committed to the database.

Do not manually purge log files. Instead, purge logs through the backup process.
For backups of a replicated copy (LCR, CCR or DAG), the log truncation is scheduled.
It starts with the active copy when Exchange has the resources to start truncation.
It does not happen instantly after a backup as with non-replicated copies.

For information on how transaction logs are truncated, see the following topics:
See “NetBackup for Exchange backup types” on page 71.

See “Adding schedules for Exchange Instant Recovery” on page 105.

See “About configuring NetBackup for Exchange” on page 54.
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Configuring Exchange backups that use Granular
Recovery Technology (GRT)

Table 4-22
Technology (GRT)

Configuring Exchange backups that use Granular Recovery

Step

Action

Description

Step 1

Review the limitations and conditions.

See “About disk storage units and restores
using Granular Recovery Technology (GRT)”
on page 85.

See “Limitations and conditions for restores
using Granular Recovery Technology (GRT)”
on page 85.

Step 2

Configure a backup policy and select Enable
granular recovery on the Attributes tab.

See “About configuring snapshot backups of
Exchange Server” on page 87.

See “Configuring a streaming NetBackup for
Exchange policy (Exchange 2007 and earlier)”
on page 108.

See “About policy attributes for NetBackup for
Exchange” on page 69.

See “NetBackup for Exchange backup types”
on page 71.

Step 3

(Optional) Disable the cataloging when you
duplicate any Exchange backups that use GRT.

See “Disabling the cataloging for duplications
of Exchange backups using Granular Recovery
Technology (GRT)” on page 86.

Step 4

(Optional) Configure a granular proxy server.

See “Configuring the granular restore proxy
host” on page 124.

Step 5

Configure the privileges for granular
operations.

See “Configuring Exchange client and server
privileges for granular operations, virtual
environments, or off-host backups” on page 115.

Step 6

For cluster or virtual environments (including
private networks, Database Availability Groups
(DAGs), and CCR) or for off-host backups,
configure the list of Exchange hosts.

See “Configuring the hosts for backups that
use Granular Recovery Technology (GRT) in
virtual environments ” on page 86.
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About disk storage units and restores using Granular Recovery
Technology (GRT)

Granular information is only cataloged for a backup image that is made to a disk
storage unit. A backup that is made directly to tape does not contain granular
information. You can duplicate the image to tape, but you cannot directly back
up to tape. If you configure backups to a disk storage unit, no further configuration
is required. You can only perform restores of individual items using Granular
Recovery Technology (GRT) if the backup resides on a disk storage unit.

Limitations and conditions for restores using Granular Recovery
Technology (GRT)

The following limitations and conditions exist for jobs using Granular Recovery
Technology (GRT):

The feature is limited to certain versions of Exchange Server and Windows
Server.

See “Configurations that are supported for Exchange Granular Recovery”
on page 35.

The NetBackup media and server client must have NetBackup 6.5.3 or later.

You must configure NetBackup for browsing and restores of individual
mailboxes and public folders.

See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.

This feature only supports full and user-directed backups. NetBackup lets you
create a complete policy for disaster recovery, with all the various types of
schedules. However, you cannot restore individual items from an incremental
backup.

Backups must be made to a disk storage unit, not to tape, and restores that use
GRT must be made from a disk storage unit. You can manually duplicate the
backup image to disk, but you cannot restore from the tape copy.

See “About disk storage units and restores using Granular Recovery Technology
(GRT)” on page 85.

Exchange Server provides a feature to retain deleted items for a period of time
after you “permanently” delete them. Because the deleted items still exist,

NetBackup includes them in the backup image. NetBackup displays these items
when you browse the granular backup image and you can restore these items.

In IPV6-enabled NetBackup 7.1 environments, granular recovery is not
supported for Exchange Server.
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Disabling the cataloging for duplications of Exchange backups using
Granular Recovery Technology (GRT)

Unlike a duplication of a backup that uses Granular Recovery Technology (GRT)
from tape to disk, duplication of the same backup from disk to tape takes extra
time. NetBackup requires this extra time to catalog the granular Exchange
information. You can choose not to catalog the granular information so that the
duplication is performed more quickly. However, then users are not able to browse
for individual items on the image that was duplicated to tape if the disk copy
expires.

During the duplication process, NetBackup writes log entries periodically to show
the progress of the job.

To disable the cataloging of Exchange backups using Granular Recovery Technology
On the master server, open the NetBackup Administration Console.

In the left pane, expand Host Properties.

Click Master Servers.

In the right pane, right-click the master server click Properties.

Click General Server.

O U W N =

Uncheck Enable message-level cataloging when duplicating Exchange
images that use Granular Recovery Technology.

7 Click OK.

Configuring the hosts for backups that use Granular Recovery
Technology (GRT) in virtual environments

When you perform a backup with Granular Recovery Technology (GRT) in a virtual
environment, NetBackup catalogs backup images under the client name in the
policy. This name is the virtual name (DAG, cluster, or private network name).
For an off-host backup with GRT, it is the primary client name. In NetBackup you
can provide a list of the Exchange hosts so that a virtual client name can be used
for the backup. Set the following configuration parameters in the host properties
for the master server.

Note: If you use a proxy server for backups using Granular Recovery Technology
(GRT), also add the proxy server to the list. For restores to be successful in an
Exchange 2010 DAG environment, you must add the CAS server to the list.
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To configure restores for multiple Exchange Server hosts

Click Add.

A U1~ W N =

host, as follows:

Environment Application host

DAG Virtual name of DAG
Virtual name of DAG
Virtual name of DAG
Virtual name of DAG

Exchange host name

Cluster Virtual cluster name
Virtual cluster name
Virtual cluster name

Exchange host name

CCR Virtual name of cluster
Virtual name of cluster
Off-host Exchange host name

On the master server, open the NetBackup Administration Console.
Select NetBackup Management > Host Properties > Master Servers.
In the right pane, double-click on the master server.

Select Distributed Application Restore Mapping.

Provide the name of the application host and the name of the component

Component host

Physical name of Node 1
Physical name of Node 2
Physical name of Node 3
Physical name of CAS server

Off-host machine name

Physical name of Node 1
Physical name of Node 2
Physical name of Node 3

Off-host machine name

Physical name of Node 1

Physical name of Node 2

Off-host machine name

About configuring snapshot backups of Exchange

Server

You use the following steps to configure snapshot backups of Exchange Server.
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Table 4-23

Configuring a snapshot backup of Exchange Server

Step

Action

Description

Step 1

Review the configuration and the
licensing requirements for
snapshot backups.

See “Configuration and licensing
requirements for Exchange
snapshot backups and restores”
on page 29.

Step 2

Additional configuration is
required if you want to restore
mailbox items from a database
backup (using Granular Recovery
Technology or GRT). Create a user
account for the NetBackup Client
Service and configure the log on
account for this service.

See “About configuring the
NetBackup Client Service for
backups and restores that use
Granular Restore Technology
(GRT) or MAPI” on page 56.

Step 3

If you want to perform off-host
backups, review the installation
requirements for that type of
backup.

See “Requirements for Exchange
off-host backups” on page 30.

Step 4

Review the general configuration
requirements for snapshot
operations.

See “Configuration requirements
for snapshot backups of Exchange
Server” on page 90.

See “Limitations of Exchange
snapshot operations” on page 89.

Step 5

Review the configuration
requirements for Exchange
Server.

See “Configuration
recommendations for the
Exchange Server” on page 90.

Step 6

Choose which transaction logs to
back up.

See “About backing up all or only
uncommitted Exchange
transaction log files with snapshot
backups” on page 123.

Step 7

Configure consistency checks.

See “Consistency checks on
Exchange snapshot backups”
on page 91.

See “About consistency checks
options for an Exchange 2010
backup” on page 126.

See “About configuring a pause in
consistency checks for Exchange
2007 and earlier” on page 122.
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Table 4-23 Configuring a snapshot backup of Exchange Server (continued)
Step Action Description
Step 8 Configure an MS-Exchange-Server | See “Configuring a snapshot
policy that has the applicable policy with Instant Recovery for
snapshot attributes selected. Exchange Server” on page 92.
Step 9 Choose whether to back up the See “Backup source for an
passive or the active copy. This | Exchange 2010 DAG backup or an
applies to Exchange 2007 Exchange 2007 replication backup
replication backups or Exchange | ” on page 96.
201(_) ba.cl.<ups of a Database See “Configuring a preferred
Availability Group (DAG). For an .
server list for an Exchange 2010
Exchange 2010 DAG, you can also s
defi ferred list Database Availability Group
efine a preferred server list. (DAG)” on page 97.
Step 10 Configure the snapshot volume
that you want to use during the
backup process.
Step 11 Disable circular logging for all
Exchange storage groups.

Limitations of Exchange snapshot operations

The following limitations exist when you perform snapshot operations with
NetBackup for Exchange:

m Data movers are not supported with off-host backups. Only alternate clients
are supported for off-host backups.

The following additional limitations exist for snapshot operations performed with

Exchange 2007 and earlier:

m Snapshot backups are supported only for the full Information Store, or storage

groups. The entire Information Store or storage group must be selected for
backup. (However, you can select individual databases for restore.)

m Snapshot backups are not supported for individual Exchange mailboxes or

public folders.

m (Exchange 2003, pre-Service Pack 1) Differential and cumulative backups are
not supported.

m You cannot restore snapshot backups and streaming or MAPI backups in the
same restore job.
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An incremental backup must be of the same type (streaming or snapshot) as
the last full backup.

See “About snapshot backups with Exchange Server” on page 20.

Configuration requirements for snapshot backups of Exchange Server

Observe the following configuration requirements before you perform snapshot
backups:

The hardware and software for the appropriate snapshot method is installed
and configured correctly.

See the NetBackup Snapshot Client Administrator’s Guide.

See the Symantec Support Web site for details on the snapshot methods and
platforms that are supported for your agent.

NetBackup Snapshot Client is configured correctly.

See the NetBackup Snapshot Client Administrator’s Guide for details.

A Snapshot Client license key is not required for any Exchange snapshot
backups that use the Microsoft default provider or SFW.

To perform off-host backups, perform any special configuration that is
required.
See the NetBackup Snapshot Client Administrator’s Guide for information.

Mount databases before you perform a backup.

If you want to create a virtual storage unit for an Exchange 2007 CCR
environment when the Exchange cluster is also configured as a SAN Media
server, see the following:

http://entsupport.symantec.com/docs/322986

Configuration recommendations for the Exchange Server

Symantec Corporation recommends the following configuration when you perform
snapshot backups:

The volume(s) that contains the Exchange databases should be dedicated to
Exchange only. Other types of databases (for example, SQL Server) should not
reside on the volume(s). Only Exchange objects are included in a snapshot
backup.

Transaction logs or Exchange system files should not reside on the same
volume as the Exchange database files (edo and stm).

(Exchange 2003, pre-Service Pack 1) The Information Store must be configured
with only one database per storage group.


http://entsupport.symantec.com/docs/322986
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m (Exchange 2003 SP1 or later, Exchange 2007) Restore all databases in a storage
group at the same time. Also restore all the databases before the transaction
logs are committed and the databases are mounted. Transaction logs are
committed at a storage group level, rather than at a database level.

m For off-host backups using Storage Foundations for Windows (SFW), SFW
deports and imports at the disk level. The volumes that you back up must
constitute whole disks.

For Exchange 2003, the database files are the .edb and . stm files. For Exchange
2007 and later, the database file is the .edb file.

See “About Exchange Instant Recovery methods” on page 21.

Consistency checks on Exchange snapshot backups

NetBackup is configured to run consistency checks for Exchange snapshot backups.
Consistency checks are required for Exchange 2007 and earlier or for a standalone
Exchange 2010 server. Consistency checks are not required for an Exchange 2010
Database Availability Group (DAG) because of the checks that are performed
during replication.

The consistency check runs with the proper options against the files that exist
on the snapshot. If any of the files fail the consistency check, the backup fails and
the backup image is discarded. The Exchange VSS Writer is notified of the failure.
When this kind of backup failure occurs, Exchange does not truncate log files.
Failure of the consistency check may be an indication of either database corruption
or a problem with the snapshot.

For Exchange 2003 NetBackup uses EsEuTIL.EXE. For Exchange 2007 and later
local snapshot backups, NetBackup uses the Microsoft consistency check API.
This API allows the user to view problems or information in the application event
logs.

For off-host backups, the consistency checks are run on the off-host client rather
than on the primary client. For Exchange 2007 and later, Symantec Corporation
recommends that you install the Exchange System Management Tools on the
alternate client. NetBackup performs the backup faster with this configuration.
If the Exchange System Management Tools are not installed on the alternate
client, the following occurs:

m (Exchange 2010) If you choose not to install the Exchange System Management
Tools, , the backup may fail. You must install the VC9 runtime DLLs on the
alternate client. These DLLs can be downloaded from Microsoft x64 VC9
download page:
http;//www.microsoft.com/downloads/details.aspx?familyid=BD2A6171-E2D6-4230-B809-
9A8D7548C1B6&displaylang=en


http://www.microsoft.com/downloads/details.aspx?familyid=BD2A6171-E2D6-4230-B809-9A8D7548C1B6&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=BD2A6171-E2D6-4230-B809-9A8D7548C1B6&displaylang=en
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B Dbpfislogs a message. The message indicates that the DLL cannot be loaded
and that eseutil is used for the consistency check.

m NetBackup performs the consistency check during the snapshot import step.

More information is available about configuring consistency checks for Exchange
2010 and the pause option for Exchange 2003 SP2.

See “About consistency checks options for an Exchange 2010 backup” on page 126.

See “About configuring a pause in consistency checks for Exchange 2007 and
earlier” on page 122.

See “Configuration requirements for snapshot backups of Exchange Server”
on page 90.

Configuring a snapshot policy with Instant Recovery for Exchange

Server

To configure a snapshot policy with Instant Recovery, you follow a different
procedure.

See “About configuring Instant Recovery backups of Exchange Server (Exchange
2007 and later)” on page 99.

If you have existing streaming backup policies and you upgraded to Exchange
2010, you must update your backup policies. Exchange 2010 backup policies
require that Perform snapshot backups is enabled. You may have to update the
backup selections list with the correct directives.

With a snapshot policy you can optionally perform an off-host backup. Also refer
to the following topics for policy recommendations:

See “Policy recommendations for Exchange Server 2010” on page 63.

See “Policy recommendations for Exchange Server 2007 and earlier database
backups” on page 66.

To configure a snapshot policy for Exchange Server

1 Create a new policy or open the policy you want to configure.
2 Inthe Policy dialog box, click the Attributes tab.

3 Inthe Policy type list, click MS-Exchange-Server.

4  Select the Policy storage.
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5 Click Perform snapshot backups.

[2] Attributes |@ Schedulesl S Ellentsl () Backup Selechnnsl

Palicy type: |MS-Excharge-Server =l W Gointo effect at |11n2s2008 = 90937 aM =
Destination I™| Fallav RS
Diata classification: |<ND data classification: j I=! Gross mourt points
[~ Compression
Palicy storage: I Any Available j I Enciyption
el il INetBackup j Callect disas.ter reco.ver_l,l infarmatiar far,
I Inteligent Disaster Recoverny
I~ | Bare Metal Hestare
I Tiake checkpaints every: 0 3: mintes ™| Collect e image restare information
[ Limt jobs per policy: lﬁ I | with move detestion
[ Allow muliiple data streams
Job priority: 0 3: =
[~ Disahle client-side: deduplication
Media Owner: Ay hd [~ Enable granular recovery

Keywoard phrasze: I

r~ Snapshot Clignt
I | Ferform black level insremental backups
¥ Perform snapshot backups Options... |
™ Retain snapshats for Instant Recovery

™| Hppery server: I

¥ Perform off-host backup

Use: IAllemale Client j

achine: Iclienld

r Microsoft Exchange Attribute:
Exchange 2010 DAG or Exchange 2007 replication [LCR or CCR)

Database backup zource: I

Prefered server list... | [Exchange 2010 DAG only]

=

oK I Cancel Help

In the Snapshot Client group, click Options.

In the Snapshot Client Options dialog box, from the Snapshot method list,
click VSS.

Adjust the configuration parameters.
See “Snapshot options for Exchange Server” on page 95.

(Optional) To perform off-host backups with Exchange 2007 or earlier or with
an Exchange 2010 standalone server, do the following:

m Click Perform off-host backup.
m In the Machine box, type the name of the alternate client.

If you use the SFW VSS provider, review the additional installation
requirements and configuration that exist.

See “Requirements for Exchange off-host backups” on page 30.
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10

11

12

13

14

Optional: To divide backups into multiple jobs, click Allow multiple data
streams.

To enable restores of individual items from database backups, click Enable
granular recovery.

See “Configuring Exchange backups that use Granular Recovery Technology
(GRT)” on page 84.

For an Exchange 2010 DAG or Exchange 2007 replication backup, in the
Microsoft Exchange Attributes group choose the Database backup source.

r— Microzoft Exchange Attribute:

Exchange 2010 DAG or Exchange 2007 replication [LCF or CCR)

Database backup source:

Preferred semver list... | [Exchange 2010 DAG anly)

See “Backup source for an Exchange 2010 DAG backup or an Exchange 2007
replication backup ” on page 96.

See “Configuring a preferred server list for an Exchange 2010 Database
Availability Group (DAG)” on page 97.

Note that the settings you choose for Microsoft Exchange Attributes only
apply for NetBackup 7.0 clients.

To configure schedules, click the Schedules tab.

See “Adding schedules to a NetBackup for Exchange policy” on page 70.
Use the Clients tab to specify clients to be backed up by this policy.

See “Adding clients to a NetBackup for Exchange policy” on page 73.

For a DAG policy, the client name is the name of the DAG and not the client
on which the backup is run. If you want to use a particular Exchange server,
add it to the preferred server list.

See “Configuring a preferred server list for an Exchange 2010 Database
Availability Group (DAG)” on page 97.

For off-host backups, the client name should be the name of the primary
client. The alternate client must be the client that shares the disk array. This
option may require additional configuration.

See to the NetBackup Snapshot Client Administrator’s Guide.
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15 Usethe Backup Selections tab to enter the directives or browse for Exchange
objects.

See “Notes and limitations for creating a backup selections list for Exchange
2007 and earlier streaming database backups” on page 111.

Off-host backups with the SFW VSS provider have a requirement. You must
back up storage groups only on the same SFW disk group.

16 Click OK to close the dialog box.

17 For any backups that use Granular Recovery Technology (GRT), configure
the list of Exchange hosts.

See “Configuring the hosts for backups that use Granular Recovery
Technology (GRT) in virtual environments ” on page 86.

See “About Exchange Instant Recovery methods” on page 21.

See “About configuration requirements for the Exchange Server when you use
Instant Recovery” on page 102.

Snapshot options for Exchange Server
Table 4-24 lists the options that are available for snapshot backups.

Table 4-24 Snapshot options
Parameter Value Description
Provider Type 0-auto The VSS Provider is automatically selected based on the providers

available for the snapshot volumes.

1-system Only the default Microsoft VSS Provider is used.

2-software Currently, the only software VSS Provider that is supported is SFW. If
this provider is not in control of one of the volumes that is required
for the backup, the backup fails.

3-hardware The applicable hardware VSS Provider is used for the volumes. If a
hardware provider is not available for one of the volumes that is
required for the backup, the backup fails.

Snapshot Attribute | 0-unspecified The setting for this option depends on the configuration of the snapshot

1-differential volume.

2-plex
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Table 4-24 Snapshot options (continued)
Parameter Value Description
Maximum Snapshots This option defines the number of snapshots that is retained for Instant
(Instant Recovery Recovery. When this threshold is reached, a snapshot is automatically
only) snapped back or deleted, depending on the VSS provider and its

configuration before another snapshot backup is performed.

Select a number that is appropriate for the number of volumes that
you have available to become snapshot volumes for your backup. If you
use the Microsoft VSS Provider, consider the amount of disk space
available for the virtual snapshots that it creates.

See “About snapshot backups with Exchange Server” on page 20.
See “Limitations of Exchange snapshot operations” on page 89.

See “Configuration recommendations for the Exchange Server” on page 90.

Backup source for an Exchange 2010 DAG backup or an
Exchange 2007 replication backup

An Exchange 2010 DAG is an environment where each database is active on one
server and has zero or more replicated passive copies on other Exchange servers.
Exchange 2007 includes the mirroring (replicating) of Exchange databases and

logs to alocal server with replication enabled (LCR). Or databases and logs can be
replicated to a passive node of a Microsoft Cluster with replication enabled (CCR).

The supported backup interface to the DAG or the replicated data is the VSS
passive writer. NetBackup allows the user to select which VSS writer is backed up
from the Attributes tab in the policy. The client backs up and catalogs as if it
were a local snapshot backup. For Exchange 2010, you can also configure a list of
preferred servers.

See “Configuring a preferred server list for an Exchange 2010 Database Availability
Group (DAG)” on page 97.

Note: The Instant Recovery and off-host options cannot be used with a replication
or DAG backup.

The backup source for the DAG or replication backup can be defined as one of the
following:
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Passive copy only (or  This option backs up the passive copy of a database if the

passive copy from database is all of the following: mounted, included in the backup

preferred serverlist  selectionslist, and healthy. For an Exchange 2010 DAG, you must
also configure a preferred server list. In that case, NetBackup
backs up the passive copy on a server in the preferred server list,
provided that the database meets the other criteria.

If a database does not have any passive copies, then it is backed
up on its active (and only) server. For example, the Public Folder
database only has an active copy.

Active copy only This option backs up the active copy of a database. For Exchange
2010, the preferred server list is ignored.

Passive copy and if not This option backs up the passive copy of a database that is all of

available the active the following: mounted, included in the backup selections list,

copy and healthy. For an Exchange 2010 DAG, you can also configure
a preferred server list. In that case, NetBackup backs up the
passive copy on a server in the preferred server list, provided
that the database meets the other criteria. If the passive copy is
not available and healthy, NetBackup backs up the active copy.

This option is the default.

See “About configuring NetBackup for Exchange” on page 54.

Configuring a preferred server list for an Exchange 2010
Database Availability Group (DAG)

You can create preferred server configurations for an Exchange 2010 Database
Availability Groups (DAG). The preferred server list is a collection of one or more
servers in the DAG that you select as preferred backup sources. Preferred server
configurations take priority as backup sources in instances where database copies
are replicated between multiple servers. The preferred server list is ignored for
Active copy only and is optional for Passive copy and if not available the active

copy.

You can let NetBackup choose the best server from which to back up the replicated
database copies or you can designate a preferred server list. Designating a
preferred server list gives you more control over your backup jobs. For example,
you can configure a list of preferred servers that are local to avoid having to back
up replicated data over your WAN. Or you may have one node of a DAG that
contains passive copies for all or most of your databases and that is also a fast
media server. Add only this server to your preferred list to make the backup more
efficient.
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For each replicated database you select for backup, NetBackup picks a server as
follows:

The server is the one from which NetBackup most recently attempted to back
up the database.

The backup attempt on the server was successful.

NetBackup tracks the success or failure of backup attempts to determine which
Exchange node to perform a passive copy database backup from.

See “Backup status for Exchange Database Availability Groups (DAGs) and the
preferred server list” on page 99.

The server is included in the preferred server list.

If this algorithm does not choose a server, the database is not backed up. A message
appears in the progress log identifying each database that is skipped for this
reason.

To configure a preferred server list

1
2

5
6
7

In the Policy dialog box, click the Attributes tab.

In the Microsoft Exchange Attributes group, from the Database backup
source list, select Passive copy only.

See “Backup source for an Exchange 2010 DAG backup or an Exchange 2007
replication backup ” on page 96.

Click Preferred server list.
In the Name box, type the name of the DAG node you want to add to the list.

Symantec recommends that you type the fully qualified domain name (FQDN)
of the node.

If you installed NetBackup 7.1 as a new installation, you must type this name
as an FQDN.

If you upgraded to NetBackup 7.1 from a NetBackup 7.x release, you can type
the shorter host name of the node, but Symantec recommends that you type
the node's FQDN.

Click Add.
Add any other DAG nodes.
Click OK.

See “Backup status for Exchange Database Availability Groups (DAGs) and the
preferred server list” on page 99.

See “About configuring NetBackup for Exchange” on page 54.
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Backup status for Exchange Database Availability Groups
(DAGSs) and the preferred server list

In an Exchange 2010 Database Availability Groups (DAG) environment, NetBackup
tracks the success or failure of a backup attempt for each passive copy database
backup. This information is stored in the Backup Status database on the NetBackup
master server. This status is used in subsequent backup attempts for each database
in a DAG to help determine which Exchange node to perform a passive copy
database backup from.

If the last backup was successful, NetBackup performs the subsequent passive
copy database backup attempt on the same Exchange server, if possible. If the
last backup attempt failed, NetBackup attempts to find a different Exchange server
to perform the subsequent passive copy database backup attempt on.

See “Displaying and resetting the Backup Status for a Database Availability Group
(DAG)” on page 204.

See “Configuring a preferred server list for an Exchange 2010 Database Availability
Group (DAG)” on page 97.

See “About configuring NetBackup for Exchange” on page 54.

About configuring Instant Recovery backups of
Exchange Server (Exchange 2007 and later)

Table 4-25 Configuring Instant Recovery backups of Exchange Server (Exchange
2007 and later)
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Step Action Description
Step 1 Disable circular logging for all Exchange
storage groups.
Step 2 Review the configuration and the licensing See “Configuration and licensing requirements
requirements for snapshot backups. for Exchange snapshot backups and restores”
on page 29.
Step 3 Review the installation requirements for See “Requirements for Exchange Instant

Instant Recovery backups.

Recovery backups” on page 31.
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Table 4-25 Configuring Instant Recovery backups of Exchange Server (Exchange
2007 and later) (continued)
Step Action Description
Step 4 Review the general configuration requirements | See “Configuration requirements for snapshot
for snapshot operations. backups of Exchange Server” on page 90.
See “Limitations for Exchange Instant Recovery
operations” on page 101.
See “About Software Foundations for Windows
(SFW) and Exchange Instant Recovery”
on page 102.
See “About Exchange Instant Recovery with
the Microsoft VSS Provider” on page 103.
Step 5 Review the configuration requirements for See “About configuration requirements for the
Exchange Server for Instant Recovery Exchange Server when you use Instant
operations. Recovery” on page 102.
Step 6 Choose which transaction logs to back up. See “About backing up all or only uncommitted
Exchange transaction log files with snapshot
backups” on page 123.
Step 7 Configure a pause in consistency checks. See “About configuring a pause in consistency
checks for Exchange 2007 and earlier”
on page 122.
Step 8 Review the backup policy recommendations | See “Policy recommendations for Exchange
for Instant Recovery backups. Instant Recovery” on page 100.
Step 9 Configure an MS-Exchange-Server policy that | See “Configuring an Exchange snapshot policy
has the Instant Recovery attribute selected and | with Instant Recovery” on page 103.
the Snapshot Client options that you want.
Step 10 Configure one snapshot volume for each

backup image that you need to retain on disk.

Policy recommendations for Exchange Instant Recovery

Create a policy with the following schedules when you use Instant Recovery:

m Create a snapshot policy with Instant Recovery enabled and with the option
Snapshots and copy snapshots to a storage unit selected. (In Table 4-26, see

Schedules 1 and 2.)
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m (Optional) For fast, temporary backups, create a separate policy with a Full

Backup schedule. Enable Retain snapshots for Instant Recovery and the
Instant Recovery option Snapshots only. (In Table 4-26, see Schedule 3.)

Information is available on how transaction logs are truncated according to the
backup type you select.

See “NetBackup for Exchange backup types” on page 71.

Table 4-26 Instant recovery policy examples for Exchange Server
Policy type Auto backup Copy to | Description and other configuration
frequency storage
unit
MS-Exchange- Schedule 1:Weekly | Yes This schedule provides for disaster recovery .

Server Full

Schedule 2: Daily | Yes
Incremental or
Differential

This schedule provides for disaster recovery .
Note: Do not include cumulative and differential schedules in

the same policy.

Note: If you choose differential backups, you must choose
Snapshots and copy snapshots to a storage unit.

Schedule 3: Every | No
4 hours

This schedule provides fast, temporary backups because the
snapshot is not copied to the storage unit. In the Snapshot Client
group, click Options and set Maximum Snapshots to a small
number.

See “About Exchange Instant Recovery methods” on page 21.

See “Limitations for Exchange Instant Recovery operations” on page 101.

See “About configuring Instant Recovery backups of Exchange Server (Exchange

2007 and later)” on page 99.

Limitations for Exchange Instant Recovery operations

The following limitations exist for Instant Recovery operations:

m Instant recovery is only supported for Exchange 2007 and later.

m NetBackup can only restore an Instant Recovery backup that was performed

with NetBackup 6.5.2 or later.

m Granular Recovery Technology (GRT) is only supported with Instant Recovery

if you also configure a backup to a storage unit.

See “About Exchange Instant Recovery methods” on page 21.
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See “Configuring a snapshot policy with Instant Recovery for Exchange Server”
on page 92.

See “About configuration requirements for the Exchange Server when you use
Instant Recovery” on page 102.

About Software Foundations for Windows (SFW) and Exchange Instant

Recovery

When you use the SFW VSS provider to create your Exchange IR snapshots, use
Veritas Enterprise Administrator (VEA) rather than VShadow or Vssadmin to
view and manage your snapshots. SFW resnaps a volume after a rollback restore,
but the Microsoft utilities are not aware of the new snapshot. They falsely report
that the snapshot does not exist.

See “Limitations for Exchange Instant Recovery operations” on page 101.
See “About snapshot backups with Exchange Server” on page 20.

See “About configuration requirements for the Exchange Server when you use
Instant Recovery” on page 102.

About configuration requirements for the Exchange Server when you
use Instant Recovery

The following configuration is required for the Exchange Server when you use
Instant Recovery:

m The volume(s) that contains the Exchange databases should be dedicated to
Exchange only. Other types of databases (for example, SQL Server) should not
reside on the volume(s). Only Exchange objects are included in a snapshot
backup.

m To allow volume rollback to occur during a restore, a volume should contain
the database files for only one database.

m Transaction logs or Exchange system files should not reside on the same
volume as the Exchange database file (. edb).

m (Exchange 2007) Restore all databases in a storage group at the same time.
Also restore the all the databases before the transaction logs are committed
and the databases are mounted. Transaction logs are committed at a storage
group level, rather than at a database level.
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About Exchange Instant Recovery with the Microsoft VSS Provider

A special requirement exists when you want to use Instant Recovery with the
Microsoft VSS Provider. Symantec recommends when you create a policy for an
Exchange 2010 standalone server that you include only the databases that are on
a common volume. For Exchange 2007, include only the storage groups whose
databases are on a common volume.

If an IR policy backs up databases on multiple volumes and you restore a subset
of those volumes, NetBackup deletes the other snapshots. Otherwise the backup
image contains an incomplete snapshot set. A rollback with the Microsoft VSS
Provider consumes the snapshot because it does not provide for re-snapping the
volume.

If you use Instant Recovery with the Microsoft VSS Provider and you select any
items that span multiple volumes, the following occurs:

m NetBackup creates a backup set with one snapshot for each volume.

m During restores, if any snapshots are rolled back, all of the snapshots in that
set are deleted. (With the SFW VSS provider or the hardware system provider,
the rolled back snapshots are re-snapped so that the snapshot set remains
complete.)

This situation is a limitation of the Microsoft VSS Provider. It typically occurs
when you do a roll-forward restore of a database and log folders that are on
separate volumes (Exchange 2010). Or when you do a roll-forward restore of
a storage group whose database and log folders are on separate volumes
(Exchange 2007). The database volume normally is rolled back but the log
volume is copied back. This action preserves the logs that were created since
the backup. NetBackup then deletes the log snapshot and removes the IR copy
of the backup image from the catalog. If a storage unit copy of the backup
exists, it remains.

Configuring an Exchange snapshot policy with Instant Recovery

This topic describes how to configure a snapshot policy with Instant Recovery.
This topic only covers what is necessary to configure Instant Recovery snapshot
backups of Exchange Server. Information on how to configure other policy
information is described in another topic. (This information includes other policy
attributes and how to create schedules, add clients, and add backup selections.)

If you have existing streaming backup policies and you upgraded to Exchange
2010, you must update your backup policies. Exchange 2010 backup policies
require that Perform snapshot backups is enabled. You may have to update the
backup selections list with the correct directives.

Optionally you can perform an off-host Instant Recovery backup.
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To configure a snapshot policy with Instant Recovery for Exchange Server

1 Create a new policy.
2 Click the Attributes tab.
3 Inthe Policy type drop-down list, click MS-Exchange-Server
4  Select the Policy storage.
See “Adding schedules for Exchange Instant Recovery” on page 105.
Click Perform snapshot backups.
Click Retain snapshots for Instant Recovery.
NetBackup retains the snapshot on disk, so that Instant Recovery can be
performed from the snapshot. A normal backup to storage is also performed
when the backup schedule specifies Snapshot and copy to storage unit.
See “Adding schedules for Exchange Instant Recovery” on page 105.
See “Schedules settings in Exchange Instant Recovery policies” on page 106.
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10

11

12

13

In the Snapshot Client group, click Options.

In the Snapshot Client Options dialog box, from the Snapshot method list
click VSS.

Adjust the configuration parameters.
See “Snapshot options for Exchange Server” on page 95.

Optional: If you selected that you want to divide backups into multiple jobs
and you selected Snapshot and copy to storage unit, click Allow multiple
data streams.

See “Performing Exchange backups with multiple data streams” on page 77.
(Optional) To perform off-host Instant Recovery backups do the following:
m Click Perform off-host backup.

m In the Machine box, type the name of the alternate client.

If you use the SFW VSS provider, review the additional installation
requirements and configuration that exist.

See “Requirements for Exchange off-host backups” on page 30.
Add other policy information as follows:

m Add clients to the policy.
See “Adding clients to a NetBackup for Exchange policy” on page 73.

m Add backup selections to the policy.
See “Notes and limitations for creating a backup selections list for
Exchange 2007 and earlier streaming database backups” on page 111.
See “Adding backup selections to an Exchange policy with Instant Recovery
” on page 108.

After you add all the clients, schedules, and backup selections you need, click
OK.

See “Policy recommendations for Exchange Instant Recovery” on page 100.

Adding schedules for Exchange Instant Recovery

Follow these instructions to configure schedules for an Instant Recovery policy.

To add schedules for Instant Recovery

1
2
3

In the Policy dialog box, click the Schedules tab.
Click New.

In the Schedules dialog box, create at least one Full type of schedule.
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4  From the Instant Recovery group, select one of the following options.

Snapshots and copy This option is required for the following:

snapshots to a storage unit m Differential backups

m Disaster recovery scenarios where both the primary
and the snapshot volume have been damaged

m Instant Recovery backups with Enable granular
recovery enabled

Snapshots only For fast, temporary backups.

5 Click OK.
6 To close the dialog box, click OK.
See “About configuring snapshot backups of Exchange Server” on page 87.

3

See “Configuring a snapshot policy with Instant Recovery for Exchange Server’
on page 92.

See “Configuring an Exchange snapshot policy with Instant Recovery” on page 103.

Schedules settings in Exchange Instant Recovery policies

Note the following settings in the Schedules tab when you add a schedule for a
policy with Instant Recovery.

Table 4-27 Settings for schedules in Instant Recovery policies
Setting Options Description
Type of Backup Full or user Snaps the volumes that contain the Exchange database, system, and log
files.
Differential or Snaps the volumes that contain the Exchange system and log files.
cumulative Differential backups require that the transaction logs are backed up to a
incremental storage unit and kept on the Instant Recovery snapshot volume. (Select

the Snapshots and copy snapshots to a storage unit option.)

This configuration is required because all of the differential backups after
the last full backup are required to fully restore a database. Since a
differential backup truncates the transaction logs, there is no way to
guarantee that all of the log files exist. Also, snapshot rotation might have
snapped back or deleted one or more snapshot images. They must be backed
up to a storage unit.
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Table 4-27

Settings for schedules in Instant Recovery policies (continued)

Setting

Options

Description

Instant Recovery

Snapshots and
copy snapshots to
a storage unit

Note: The Instant Recovery options are available if you select Retain
snapshots for Instant Recovery (on the Attributes tab of the policy).

NetBackup creates a disk snapshot and backs up the client’s data to the
storage unit that is specified for the policy. This option is required if you
want to perform Instant Recovery backups with Granular Recovery
Technology (GRT).

Transaction logs are deleted when the backup (full or differential) to the
storage unit has completed.

Snapshots only

The image is not backed up to tape or to other storage. NetBackup creates
a persistent snapshot only. Note that this persistent snapshot is not
considered a replacement for traditional backup.

Transaction logs are not deleted for this schedule option. To delete
transaction logs, you must perform a backup to a storage unit. Alternatively,
you can configure NetBackup to delete logs for any full Instant Recovery
backups that are snapshot only.

See “About truncating Exchange transaction logs with Instant Recovery
backups” on page 124.

Retention

One week - infinity

The retention level indicates the maximum time that the Instant Recovery
snapshot is retained. For full backups, select a retention level that ensures
a full backup is always available for restore. The snapshot can be deleted
before that time if the snapshot volume is required for another backup
attempt.

See “About Exchange Instant Recovery volume rotation” on page 107.

See “Snapshot options for Exchange Server” on page 95.

About Exchange Instant Recovery volume rotation

At the start of a backup, the Snapshot Client is queried to determine how many

Instant Recovery snapshots currently exist for each volume. This information is

required for the Exchange storage groups that are selected for backup. If the

number of snapshots is currently at the configured maximum level of snapshots,

a snapshot is resynched (or snapped backup or deleted). Then a snapshot is
available for the upcoming backup attempt.

The algorithm to determine which snapshot volume is resynched considers

whether the snapshot was taken as part of a full backup or an incremental backup.
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The algorithm tries to maintain as many full backups as possible, even if newer
incremental backups have to be resynched.

See “Snapshot options for Exchange Server” on page 95.
See “About consistency checks options for an Exchange 2010 backup” on page 126.

See “About snapshot backups with Exchange Server” on page 20.

Adding backup selections to an Exchange policy with Instant
Recovery

You can include each Exchange storage group in one backup policy. Or you can
choose to include a storage group in more than one policy. In the latter case,
ensure that enough snapshot volumes exist to satisfy the Maximum Snapshots
value for each policy that contains the storage group.

When you configure an Exchange snapshot backup policy, the only valid directives
are: Microsoft Exchange Database Availability Groups:\ Or Microsoft
Information Store:\ (a database or storage group can be appended) .

Note: To back up individual databases, you must select all the databases in the
storage group.

See “Policy recommendations for Exchange Instant Recovery” on page 100.
See “Configuration recommendations for the Exchange Server” on page 90.

See “About Exchange Instant Recovery methods” on page 21.

Configuring a streaming NetBackup for Exchange
policy (Exchange 2007 and earlier)

This topic describes how to cofigure a streaming backup policy for an Exchange
database.

To configure a streaming NetBackup for Exchange policy (Exchange 2007 and earlier)
1 Review the notes and limitations for this type of backup.

See “Notes and limitations for creating a backup selections list for Exchange
2007 and earlier streaming database backups” on page 111.

Log on to the master server as administrator (Windows) or root (UNIX).

Start the NetBackup Administration Console.
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If your site has more than one master server, choose the one on which you
want to add the policy.

(Windows) In the left pane, right-click Policies and choose New Policy.

(Java interface) In the left pane, click Policies. In the All Policies pane,
right-click the master server, and click New Policy.

In the Add a New Policy dialog box, in the Policy name box, type a unique
name for the new policy.

Click OK.

In the Add New Policy dialog box, in the Policy type list, select
MS-Exchange-Server.

The database agent policy type does not appear in the drop-down list unless
your master server has a license key for the database agent.
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10 (Optional) To enable restores of individual items from database backups, click
Enable granular recovery.

See “Configuring Exchange backups that use Granular Recovery Technology

(GRT)” on page 84.
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11 Complete the entries on the Attributes tab.
See “About policy attributes for NetBackup for Exchange” on page 69.
12 Add other policy information as follows:

m Add schedules.
See “Adding schedules to a NetBackup for Exchange policy” on page 70.

m Add clients.
See “Adding clients to a NetBackup for Exchange policy” on page 73.

m Add database objects to the backup selections list.
See “Adding backup selections to an Exchange policy” on page 74.
See “Notes and limitations for creating a backup selections list for
Exchange 2007 and earlier streaming database backups” on page 111.
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13 For any backups that use Granular Recovery Technology (GRT), configure
the list of Exchange hosts.

See “Configuring the hosts for backups that use Granular Recovery
Technology (GRT) in virtual environments ” on page 86.

14 When you have added all the schedules, clients, and backup selections you
need, click OK.

See “About configuring NetBackup for Exchange” on page 54.

Notes and limitations for creating a backup selections list for Exchange
2007 and earlier streaming database backups

Streaming backups include the Microsoft Information Store:\ directive.

Review the following information before you create a backup selections list for
the Exchange 2007 or earlier streaming database backups:

m NetBackup for Exchange does not support incremental backups of individual
databases within a storage group.

m When individual databases in a storage group are backed up, the transaction
logs for the entire storage group are also included in the backup.
Transaction logs are not truncated (deleted) until a full backup is run on every
database in the storage group. To ensure that transaction logs are truncated
(deleted) regularly, include all databases for a storage group in a full backup
policy. Or specify the storage group (not individual databases) in the backup
policy.

See “About configuring NetBackup for Exchange” on page 54.

Configuring a policy for backups of individual
Exchange mailboxes or public folders (Exchange 2007
and earlier)

A MAPImailbox or public folder policy includes individual mailbox or public folder
objects. This type of policy can only be configured for Exchange 2007 and earlier.
Before you configure NetBackup for Exchange policy for these objects, review the
configuration that is necessary for this type of backup.

See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.
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To configure a NetBackup for Exchange policy for MAPI mailbox or public folder

backups

1 Logon tothe master server as administrator.

2  Start the NetBackup Administration Console.

3 If your site has more than one master server, choose the one on which you
want to add the policy.
(Windows) In the left pane, right-click Policies and choose New Policy.
(Java interface) In the left pane, click Policies. In the All Policies pane,
right-click the master server, and click New Policy.

6 Inthe Add a New Policy dialog box, in the Policy name box, type a unique

name for the new policy.

Click OK.



Configuring NetBackup for Exchange | 113
Configuring a policy for backups of individual Exchange mailboxes or public folders (Exchange 2007 and earlier)

8 Inthe Add New Policy dialog box, in the Policy type list, select
MS-Exchange-Server.

The database agent policy type does not appear in the drop-down list unless
your master server has a license key for the database agent.
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Palicy storage: I Ary fwvailable j ™ Encryption
- Collect disaster recavery infamation for
Palicy volume paal MetBack -
I sdcue | I | Eare Metal Festore

™| Collest b image restore infarmation

[T Take checkpoints every: i) 3: minutes I | with move detestion
I~ Limit jobs per policy: 3: [~ aliow multiple: data strearns
o m [~ Disable client-side deduplication
[~ Enable granular recovery
Media Owner: Any & Keyword phrage: I
— Snapshat Client r Microzaft Exchange Attrbut
I™ | Perform block level incremental backups Exchiange 20710 DA or Exchange 2007 replication [LER ar CEH]
™ Perform shapshot backups Options... |
™| Ritain snapshats for Instant Fecovery Dbz backnp sous, I j
= Hyper server: I Freferned server list.. I [Exchange 2010 DAG anly]
I | Perform off-host backup
Use; I j
fdachine: I

oK I Cancel Help

9 Complete the entries on the Attributes tab.
See “About policy attributes for NetBackup for Exchange” on page 69.
10 Add other policy information as follows:
m Add schedules.
See “Adding schedules to a NetBackup for Exchange policy” on page 70.
m  Add clients.
See “Adding clients to a NetBackup for Exchange policy” on page 73.

m Add database objects to the backup selections list.
See “Adding backup selections to an Exchange policy” on page 74.
See “Notes and limitations when you create a backup selections list for
MAPI mailbox and public folder backups” on page 114.
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See “Policy recommendations for Exchange Server 2007 and earlier MAPI
backups” on page 67.

11 When you have added all the schedules, clients, and backup selections you
need, click OK.

Notes and limitations when you create a backup selections list for
MAPI mailbox and public folder backups

MAPI mailbox backups are performed with the Microsoft Exchange Mailboxes:\
directive. MAPI public folder backups are performed with the Microsoft Exchange
Public Folders:\ directive.

Review the following information before you create a backup selections list for
MAPI mailbox or public folder backups:

m To perform backups of mailboxes, additional steps are required beyond policy
configuration.
See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.

m When you use mailbox or public folder directives, only backups of mailboxes
or folders are allowed. You cannot specify the backup of an individual message
or individual public document.

m MAPI mailbox and public folder backups allow for mailbox or public folder
recovery, but are not adequate for disaster recovery. Exchange database
backups are required for disaster recovery.

m Theroot path of an Exchange Mailbox object (Microsoft Exchange Mailboxes:\)
is case sensitive.

See “About configuring NetBackup for Exchange” on page 54.

About Exchange client and server privileges for
granular operations, virtual environments, or off-host

backups

When you perform a backup, sometimes the source client is different than the
client that NetBackup uses for backup processing. These situations include the
following:

m When you use an Exchange granular proxy host
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You can specify the granular proxy host in the NetBackup Administration
Console or with the bp1ist command. Note that NetBackup uses the proxy
host when you duplicate a backup image.

See “Configuring the granular restore proxy host” on page 124.

m Off-host backups

m When you use a private network

m Backups of a clustered Exchange server

m Backups of an Exchange 2010 Database Availabililty Group

m When you select a destination client other than the source client to either
browse the backup image or when you perform a restore

If one of these situations applies to your NetBackup configuration, the following
requirements exist:

m The client(s) or the media server must have the same version of Windows as
the client from which the backup is made.

m For Windows 2008 and Windows 2008 R2, the client(s) must have Services for
Network File System enabled (under File Services). For Windows 2003 R2 SP2,
the client(s) must have NFS installed.

See “About installing and configuring Network File System (NFS) for Exchange
Server Granular Recovery” on page 33.

m The proxy server must also meet the following additional requirements:
m Has the same NetBackup version as the Exchange hosts

m Uses the same NetBackup master server

m The client(s) or the media server must have privileges to perform granular
operations.
See “Configuring Exchange client and server privileges for granular operations,
virtual environments, or off-host backups” on page 115.

Configuring Exchange client and server privileges for granular
operations, virtual environments, or off-host backups

This configuration is required if you want to browse backups or perform restores
and you have an environment where the source client is different than the client
that NetBackup uses for backup processing. More information is available on
when this configuration is necessary.

See “About Exchange client and server privileges for granular operations, virtual
environments, or off-host backups” on page 114.
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Alternatively, you can perform a server-directed restore. Further instructions are
available on how to allow redirected restores in the NetBackup Administrator's
Guide, Volume I.

To configure Exchange client and server privileges for granular operations, virtual
environments, or off-host backups

1

On the master server, create the altnames directory, as follows:

In a non-clustered environment, create the following directory:
install path\NetBackup\db\altnames

In a clustered environment, create the following directory:
shared drive install path\NetBackup\db\altnames

In the altnames directory, create a peername file.

peername refers to:

The granular proxy host name
See “Configuring the granular restore proxy host” on page 124.

The off-host client name
The private network host name

The node names in the cluster
Create a peernane file for each node in the cluster.

The physical Exchange servers in a DAG
For a 2010 DAG, create one file for each physical Exchange server in the
DAG.

The destination client name, if it is different than the source client

For example, consider that you have a source client named c1ienta and you
want to use a proxy host named ProxyClient. On the master server, you create
afile that is called proxyclient.

In the peername file, add the name of the source client.

The source client is the client that originally performed the backup. For
clustered clients, use the virtual Exchange name. For a backup within a private
network, use the private network host name. For a DAG, use the DAG name;
this name should be the client name in the policy.

For example, in the proxyclient, include the name clienta.
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Configuring exclude lists for Exchange clients

If you do not want to back up certain storage groups (Exchange 2003 or Exchange
2007) or databases (Exchange 2010), you can create an exclude list. When
NetBackup runs a NetBackup for Exchange backup policy, NetBackup ignores the
storage groups or databases that appear in the exclude list.

For more information about this topic, see the following:

See “About excluding Exchange items from backups” on page 80.

NetBackup excludes certain files and directories by default. These default
exclusions always appear in the administration console's exclude list. The default
exclusions are as follows:

C

C

C

c

:\Program Files\Veritas\NetBackup\bin\bprd.d\*.lock
:\Program Files\Veritas\NetBackup\bin\bpsched.d\*.lock
:\Program Files\Veritas\NetBackupDB\data\*

:\Program Files\Veritas\Volmgr\misc\*

The following figure shows an exclude list with two databases:
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Figure 4-1 An Exchange exclude list that specifies two databases
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Note: For DAG backups in clustered or replicated environments, select each node
and perform the configuration procedure on each node. You must configure the
same settings on each node. If you change the attributes for the virtual name of
the client, NetBackup updates only the active or current node.

The following procedure explains how to specify storage groups or databases in
an exclude list.

To configure an Exchange client exclude list

1 Open the NetBackup Administration Console or the Remote Administration
Console.

2 Inthe left pane, expand NetBackup Administration > Host Properties >
Clients.

In the right pane, select the Exchange client(s) that you want to configure.
Click Actions > Properties.

Expand Windows Client and click Exclude Lists.
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6 Click Add.
Specify objects to exclude in one of the following ways:

m InthePolicy field, select <<A11l Policies>>ortypethe name of a specific
policy.

m In the Schedules field, select <<a11 Schedules>> or type the name of a
specific schedule.

m Inthe Files/Directories field, type the name of a storage group or database
in the following format:

Microsoft Information Store:\name

For name, specify the name of a storage group or database, as follows:

m Toexclude a specific storage group from an Exchange 2003 or Exchange
2007 backup, type the name of a specific storage group. Do not type
the name of a database in this field because for log truncation purposes,
Exchange requires that snapshot (VSS) backups contain the entire
storage group.

m To exclude a specific database from an Exchange 2010 backup, type
the name of a database to be excluded, even for DAG backups.
When specifying object to exclude, do not specify any wildcard characters.

The following notes apply only to Exchange 2010 DAG backups:

m Ifyouselectall policies,duringtheinitial discovery phase of abackup,
NetBackup detects the excluded database and excludes the database.

m If you specifiy a policy in the Policy field, during the initial discovery
phase of abackup, NetBackup does not detect the databases in the exclude
list. However, the snapshot phase of a backup detects the databases to be
excluded and excludes the databases. If there is only one database in the
snapshot phase, NetBackup generates a status 69 error (invalid file list
specification), and the entire backup finishes with an error. However,
NetBackup retains the images from all of the other Exchange servers.

8 (Conditional) Repeat step 3 through step 7 for the other nodes in the
environment.

Perform this step if the NetBackup environment is clustered or replicated.

If you specify the name of the virtual client, only the active or current node
is updated. For the changes to be effective throughout the cluster, repeat the
configuration steps on each node.

See “Using wildcards in an Exchange backup selections list” on page 78.

See “About configuring NetBackup for Exchange” on page 54.
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Configuring host properties for Exchange clients

In the Exchange client host properties you configure settings for the Exchange

clients you selected.

To configure Exchange client host properties

1

6

7

Open the NetBackup Administration Console or the Remote Administration

Console.

In the left pane, expand NetBackup Management > Host Properties > Clients.

In the right pane, select the Exchange client(s) you want to configure.

Note: For clustered or replicated environments, select each node. You must
configure the same settings on each node. If you change the attributes for
the virtual name of the client, only the active or current node is updated.

Click Actions > Properties.

Expand Windows Client and click Exchange.

Client Properties: tvtag
& Properties Exchange Defaults

-8 Universal Settings
-5 Servers Exchange Snapshot Client options

g. Client Name Snapshot verification 1/0 throttle (number of I/Os before pausing): I 1] _|:;l

é Encryption
& Backup option for log files during full backups:

Port Ranges

Back up only uncommitted log files (not recommended for replication
Timeouts

environments)

Firewall .
.4 Logging & Back up all log files (induding committed log files)

(Y Access Control

.80 Metwork Settings  Exchange granular restore proxy host:
EIE', Windows Client I |
g, Client Setting: )

. ﬂ‘é’ Exclude Lists  Mailbox for message level backup and restore:

T MNetwork

-# Lotushates | = Enable single instance backup for message attachments
:

53 SharePoint ™ Truncate Exchange log files after successful Instant Recovery backup
% Active Directo —Exchange 2010 options

Enterprise Val I Perform consistency check before backup with Microsoft Volume Shadow
E Login Banner Corn: Copy Service (VS5)

¥ Continue with backup if consistency check fails

< I |

oK I Cancel Apply Help

Enable the options you want.
See “Exchange properties” on page 121.

Click OK.
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The Exchange properties apply to the currently selected Windows clients. For

clustered or replicated environments, configure the same settings for all nodes.

If you change the attributes for the virtual server name, only the active node is

updated.

Snapshot verification
I/0 throttle

Backup option for log
files during full
backups

Truncate log after
successful Instant
Recovery backup

For snapshot backups, specify the number of I/Os to process for
each 1-second pause. This option applies to Exchange 2003 SP2
and to Exchange 2007 if the Exchange Management Console is
not installed on the alternate client.

See “About configuring a pause in consistency checks for
Exchange 2007 and earlier” on page 122.

Choose which logs to include with snapshot backups:

m Back up only uncommitted log files
Select this option to back up only the log files that are
uncommitted. This option is not recommended for Exchange
2010 DAG or Exchange 2007 CCR environments.

m Back up all log files (including committed log files)

See “About backing up all or only uncommitted Exchange
transaction log files with snapshot backups” on page 123.

Note: In NetBackup 7.0, the default option is now Back up all
log files (including committed log files). If you previously
changed this setting for a client, your selection remains the same.
For new installations of NetBackup, the default is Backup alllog
files (including committed log files). For upgrade installations
where you did not change this setting for a client, the default is
changed to Back up all log files (including committed log files)

Enable this option to delete transaction logs after a successful
Instant Recovery backup. By default, transaction logs are not
deleted for a full Instant Recovery backup that is snapshot only.

See “About truncating Exchange transaction logs with Instant
Recovery backups” on page 124.
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Exchange granular You can specify a different Windows system to act as a proxy for

restore proxy host the source client. Use a proxy if you do not want to affect the
source client or if it is not available. This situation applies when
you duplicate a GRT-enabled backup image from a disk storage
unit to a tape storage unit or when you use the bp1i st command.

See “Configuring the granular restore proxy host” on page 124.

See “About Exchange client and server privileges for granular
operations, virtual environments, or off-host backups”
on page 114.

Mailbox for message  Asof NetBackup 7.0, this setting no longer needs to be configured.
level backup and
restore

Enable single instance Enable this option to back up the data that is stored on a Single
backup for message Instance Store (SIS) volume. This feature only applies to Exchange
attachments Server 2007 and earlier versions.

See “About configuring Exchange Single Instance Store backups
(Exchange 2007 and earlier) ” on page 125.

Perform consistency  Disable this option if you do not want to perform a consistency
check beforebackup  check during an Exchange 2010 DAG backup. If you check
with Microsoft Volume Continue with backup if consistency check fails, NetBackup
Shadow Copy Service continues to perform the backup even if the consistency check
(VSS) fails.

See “About consistency checks options for an Exchange 2010
backup” on page 126.

About configuring a pause in consistency checks for Exchange 2007
and earlier

Note: This option is only applicable to Exchange 2003 SP2 or later and for Exchange
2007 if the Exchange Management Console is not installed on the alternate client.

The value is used during snapshot validation by the Exchange command ESEUTIL
/pxxx where xxx is the value of Snapshot verification I/O throttle. ESEUTIL
defines the /p setting as a forced 1-second pause after every xxx I/Os to limit the
I/O rate during database verification. See the Microsoft Exchange documentation
regarding the EseuT11, command for details.

For more information on how to configure client settings in the host properties,
see the following topic:
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See “Configuring host properties for Exchange clients” on page 120.

About backing up all or only uncommitted Exchange transaction log
files with snapshot backups
The Back up option for log files during full backups determines how many log

files are backed up during a full or user-directed snapshot backup. You can adjust
this setting in the host properties for the Exchange client.

Note: In NetBackup 7.0, the default option is now Back up all log files (including
committed log files). If you previously changed this setting for a client, your
selection remains the same. For new installations of NetBackup, the default is
changed to Back up all log files (including committed log files). For upgrade
installations where you did not change this setting for a client, the default is
changed to Back up all log files (including committed log files)

If you select Back up only uncommitted log files NetBackup only backs up and
catalogs the transaction log files that were not committed to the Exchange database
at the time that the snapshot was taken. Exchange requires these uncommitted
log files during the recovery of the Exchange database to make the database
consistent. If Back up all log files (including committed log files) is selected, all
of the log files that exist on the snapshot volume are backed up and cataloged.

Back up only uncommitted log files is not recommended for replicated
environments. See the following TechNote:

http://entsupport.symantec.com/docs/336948

When you back up only the uncommitted log files, the advantage is that less space
is needed on the storage unit for the transaction logs. When you back up all of
the log files, the advantage is that a consecutive set of log files is maintained. A
previous full backup can use these log files for rolling forward. These options do
not affect the ability to recover the current full or user-directed type backup.
These options do affect the ability to roll forward from a previous full or
user-directed type backup.

For example, consider if a full backup is performed, followed by two differential
backups, followed by another full backup. If Back up all log files is specified, all
of the log files exist in backup images. The first full backup, the log files from the
two differential backups, and the log files from the second full backup can be
restored. The existence of all the log files allows for a roll-forward recovery. If
you select Back up only uncommitted log files, a gap exists in the sequence of
transaction logs that are in the backup images. From the full backup, you can
restore only as far as the time that is covered in the two differential backups.
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For more information on how to configure the client host properties, see the
following topic:

See “Configuring host properties for Exchange clients” on page 120.

About truncating Exchange transaction logs with Instant Recovery

backups

By default, Exchange transaction logs are not truncated for a full Instant Recovery
backup that does not back up to a storage unit. To truncate logs enable Truncate
log after successful Instant Recovery backup in the Exchange properties for the
client. Consider carefully before you select this option. Ensure that you have an
independent method to retain your snapshots for disaster recovery. Alternatively,
you can perform a full Instant Recovery backup to a storage unit.

See “Truncating Exchange transaction logs by performing a backup to a storage
unit” on page 124.

For more information on how to configure the client host properties, see the
following topic:

See “Configuring host properties for Exchange clients” on page 120.

Truncating Exchange transaction logs by performing a backup
to a storage unit

To truncate Exchange transaction logs by performing a backup to a storage unit
1 Create a new backup policy.
2 Create a full or a differential schedule type.

3 Inthe attributes for the schedule, select Snapshots and copy snapshots toa
storage unit.

4  Select a storage unit for the policy.
Perform a snapshot backup with this policy.

Configuring the granular restore proxy host

When you browse for or restore individual items using Granular Recovery
Technology (GRT), NetBackup uses the destination client to stage a virtual copy
of the database that you want to restore. However, NetBackup uses the source
client of the backup to stage the database in the following situations: when you
duplicate a GRT-enabled backup image or when you use the bplist command.
Alternatively, you can specify a different Windows system to act as a proxy for
the client. Use a proxy if you do not want to affect the source client or if the source
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client is not available. To specify a proxy, configure the Exchange granular proxy
host in the Exchange properties for the client.

When you use the bplist command and the bpduplicate command, you can
override the Exchange granular proxy host setting with the -granular proxy
option. More information is available on how to specify the granular host with
these commands.

See “About using the command line to browse or restore granular backup images”
on page 185.

NetBackup determines the granular restore proxy host in the following order:

m The host that is specified with the -granular proxy option on the command
line

m The granular restore proxy host that you specify in the host properties for the
source client

m The source client

More information is available about how to configure the client host properties
and about the requirements for the granular proxy server.

See “Configuring host properties for Exchange clients” on page 120.

See “About Exchange client and server privileges for granular operations, virtual
environments, or off-host backups” on page 114.

About configuring Exchange Single Instance Store backups (Exchange
2007 and earlier)

Exchange Server 2007 and earlier uses the Single Instance Store (SIS) to maintain
single-instance storage of mail messages. This capability in Exchange Server
allows the database to keep one copy of a message sent to multiple users on the
same server.

Toback up the data that is stored on an SIS volume, select Enable single instance
backup for message attachments. Enable this option in the Exchange properties
for the NetBackup client where Exchange Server is installed.

See “Configuring host properties for Exchange clients” on page 120.
Note the following:

m This feature is only available for MAPI mailbox backups, not for snapshot
backups or any backups that use Granular Recovery Technology (GRT).

m Only attachments larger than 100 KB are backed up as SIS objects. Attachments
smaller than 100 KB are backed up with each individual message.
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See “About configuring NetBackup for Exchange” on page 54.

About consistency checks options for an Exchange 2010 backup

By default, NetBackup is configured to run a consistency check on Exchange 2010
backups. The consistency check that runs on the snapshot determines if possible
data corruption exists. For standalone servers, you must perform a consistency
check. Consistency checks are optional for an Exchange 2010 Database Availability
Group (DAG). You can configure this option in the host properties for the Exchange
client.

If Perform consistency check before backup with Microsoft Volume Shadow
Copy Service (VSS) is selected, NetBackup backs up Exchange objects as follows:

m Ifyoudonot select Continue with backupif consistency checkfails, a database
backup fails if it contains database files or transaction log files that are corrupt.
All other non-corrupt databases that you selected are backed up.

m When you select Continue with backup if consistency check fails, then all
Exchange data is backed up regardless if corrupt files are detected.

For more information on how to configure client settings in the host properties,
see the following topic:

See “Configuring host properties for Exchange clients” on page 120.

See “About snapshot backups with Exchange Server” on page 20.

Testing configuration settings for NetBackup for

Exchange

After you configure the master server for NetBackup for Exchange, test the
configuration settings. Perform a manual backup (or backups) with the automatic
backup schedules you created. A description of status codes and other
troubleshooting information is available.

See the NetBackup Status Codes Reference Guide.
See the NetBackup Troubleshooting Guide.

Note: A manual back creates a real backup. Exchange logs are truncated, if
appropriate.
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To test the configuration settings

1 Log onto the master server as administrator (Windows) or root (UNIX).
Start the NetBackup Administration Console.

In the left pane, click Policies.

Click the policy you want to test.

g A W N

Select Actions > Manual Backup.

The Schedules pane contains the name of an automatic schedule (or schedules)
configured for the policy that you want to test. The Clients pane contains the
name of the client(s) listed in the policy that you want to test.

Follow the directions in the Manual Backup dialog box.

To check the status of the backup, click Activity Monitor in the NetBackup
Administration Console.

For more information, see the Troubleshooting chapter.
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Performing backups and
restores of Exchange
Server, mailboxes, and
public folders

This chapter includes the following topics:

About backing up Exchange Server data

About restoring Exchange database data

About restoring individual mailbox and public folder items
About restoring Backup Exec Exchange images with NetBackup

About selecting a source client for an Exchange Server backup or a restore
operation

Notes and limitations when you select a source client for an Exchange Server
backup or restore operation

About selecting a destination client for an Exchange Server restore operation

Notes and limitations when you select a destination client for an Exchange
Server restore operation



130 ‘

Performing backups and restores of Exchange Server, mailboxes, and public folders
About backing up Exchange Server data

About backing up Exchange Server data

With NetBackup for Exchange you can perform snapshot and streaming database
backups. You can also perform MAPI backups of individual mailboxes and public

folders.
Table 5-1 Snapshot and streaming backups available for Exchange Server
Backup type Exchange 2010 | Exchange 2007 |Procedure
and earlier
Snapshot X See “Performing user-directed snapshot backups of
Exchange Server” on page 131.
Streaming X See “Performing user-directed streaming backups of
Exchange Server (Exchange 2007 and earlier)”
on page 133.
Individual X See “Performing user-directed MAPI backups of
mailboxes and individual mailboxes and public folders (Exchange 2007
public folders and earlier)” on page 135.
(MAPI)

Options for Exchange backups

Table 5-2 Backup options

Option Description

NetBackup server To change the NetBackup server that you want to perform the
backup operation, select another server from the drop-down list.

Items marked to be Contains a list of objects to be backed up.

backed up

Keyword phrase to Specifies a keyword phrase, up to 128 characters in length, that

associate with the NetBackup associates with the image created by this backup

backup or archive operation. You then can restore the image by specifying the

keyword phrase in the Search Backups dialog box.

All printable characters are permitted including space (“ ”) and

“n

period (“.”). The default keyword phrase is the null (empty) string

Start Backup

Initiates the backup operation.
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Performing user-directed snapshot backups of Exchange Server

To perform a user-directed snapshot backup, a policy must exist on the server
that is configured for snapshot backups. This policy must also have a User
schedule. Exchange 2010 users can back up a DAG, the Information Store, or a
database. Exchange 2007 and earlier users can back up the Information Store or
a storage group. Transaction logs are also backed up. However, transaction logs
are not truncated for user-directed backups.

Note: For Exchange 2003 pre-SP1, a user-directed backup also truncates the
transaction logs.

When Enable granular recovery is enabled in the backup policy, you can later
restore individual mailbox and public folder items from the backup.

To perform a user-directed snapshot backup of Exchange Server objects
1 Mount any databases that you want to back up.
2 Open the Backup, Archive, and Restore interface.

For a Database Availability Group (DAG), you must initiate the user backup
operation from the node where the DAG virtual name is active (online).

Click Actions > Specify Policy and Schedule.

4  Inthe BackupPolicy and Schedule box, type the name of the Snapshot Client
policy.

Click File > Select Files and Folders to Back Up.
Select File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

m The server you want to perform the backup.

m If you are in a cluster environment, specify the name of the virtual
Exchange Server or the DAG virtual name.
See “About selecting a source client for an Exchange Server backup or a
restore operation” on page 187.

8 Inthe All Folders pane, select the objects you want to back up.
See Table 5-3 on page 133.
Note the following:

m For an Exchange 2010 Database Availability Group (DAG), you cannot
select a specific server in the Backup, Archive, and Restore interface from
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which to perform the backup. If you want to use a specific server, specify
it in the Preferred server list.

See “Backup source for an Exchange 2010 DAG backup or an Exchange
2007 replication backup ” on page 96.

All databases in the DAG, regardless of what server they reside on, are
displayed.

m For Exchange 2007 or earlier backups of individual storage group
databases, you must select all the databases in the storage group. If you
do not select all the databases, the backup job fails.

The following figure shows a backup of an Exchange 2010 DAG.

All Folders Contents of 'Microsoft Exchange Database Availability Groups:\dagraw 1.ex639.ad
=-0] 2 dagraw1 Name | Time Backed Up | a...[ s.] Time Mc
= [E] Microsoft Exchange Database Availab [ Database [1] 12/9/2000 3:00:50PM d— 0 12/9/2C

El D@ dagraw 1.ex639.ad [ Just_database 12/9/2009 3:00:59PM d— 0 12/3/20

1 ERW e Jicrosoft Information Store [ Mailbox Datebase 1312624491 12/5/2009 3:00:55PM d— 0 12/9/2C
Dﬁjj Mailbox Database 1610318760 12/9/2009 3:00:37PM d— 0 12/9/2C

Dﬁjj Mailbox Database 1897167405 12/9/2009 3:00:36 PM d— 0 12/9/2C

4 | I N | i

The following figure shows a backup of an Exchange 2010 standalone server.

All Folders Contents of Microsoft Information Store
;I Name | A | S‘l Time Modified |
[ Mailbox Database 1791621673 d— 0 12/10/2009 8:27:49 AM
[ Noras-5_MB1 d— 0 12/10/2009 8:27:49 AM
J [ Noras-5_MB2 d— 0 12/10/2009 8:27:49 AM
=

The following figure shows a backup of an Exchange 2007 storage group.

All Folders Contents of Microsoft Information Store:\Second Storage Group
[=E D@ Microsoft Information Store d [ame | ,ql s,l Time Modified |
[ First Storage Group Dl @562 061 — O 2/17/2000 10:06:43 AM

UM [i1Eo=cond Storage Group @ scz 0Bz - 0 2/17/2009 10:06:43 AM

Dla# Storage Group 10a (CHERY) D@56z 083 — 0 2/17/2009 10:06:43 AM

O Third

Dg Microsoft Exchange Mailboxes

-7 1454 Microsoft Exchange Public Folders LI

9 C(Click Actions > Backup.
10 In the Backup Files dialog box, click Start Backup.
11 To view the progress of the backup, click Yes.

If you do not want to view the progress of the backup, click No.
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Table 5-3 Selecting Exchange database objects for user-directed backups
Exchange version Node Objects to back up
Exchange 2010 DAG Microsoft Exchange Database Availability Groups | DAG
All databases in the DAG
Exchange 2010 Microsoft Information Store Microsoft Information Store

standalone server

All databases

Exchange 2007 and
2003

Microsoft Information Store

Microsoft Information Store
Storage groups

All databases

See “About Exchange Instant Recovery methods” on page 21.

See “Configuring an Exchange snapshot policy with Instant Recovery” on page 103.

See “Configuration recommendations for the Exchange Server” on page 90.

Performing user-directed streaming backups of Exchange Server
(Exchange 2007 and earlier)

To perform a user-directed backup, the backup policy must have a User schedule.
Users can back up the Information Store, storage groups, and individual databases.

When Enable granular recovery is enabled in the backup policy, you can later
restore individual mailbox items from the backup.

To perform a user-directed backup

Log onto the server as Administrator.
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following information:

Ensure all databases that you want to back up are mounted and online.
Open the Backup, Archive, and Restore interface.

Click File > Select Files and Folders to Back Up.

Select File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, provide the

m The server you want to perform the backup.

m If you are in a cluster environment, specify the name of the virtual
Exchange Server or the DAG virtual name.
See “About selecting a source client for an Exchange Server backup or a

restore operation” on page 187.
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7 Inthe All Folders pane, click the objects you want to back up, as follows:

m Storage groups. Expand the Microsoft Information Store node and select
the storage group to back up.

m Individual databases. To back up an individual database within a specific
storage group, expand the Microsoft Information Store. Then expand the
storage group and select the database to back up.

All Folders Contents of Microsoft Information Store:lSecond Storage Group
= @ Microsaft Infarmation Stare ;I Mame | Al S.| Time Modified |
O irst Stoage GWP O @56z 061 - 0 2/17/2009 10:06:43 &M
(M[ET8 ~=cond Storage Group O @56z 0Bz - 0 2f17/2009 10:06:43 &M
D)@ Storage Group 103 (CHEX) D) G)S62.0B3 — 0 2/17/2009 10:06:43 AM
O Third
B[] 5 Micrasoft Exchange Maibaxes
-1 153 Micrasoft Exchange Public Folders LI
. .
Click Actions > Backup.

9 Select the backup options you want.
See “Options for Exchange backups” on page 130.
10 Click Start Backup.
11 To view the progress of the backup, click Yes.
See “About backing up Exchange Server data” on page 130.

See “Performing user-directed full streaming backups (Exchange 2007 and earlier)”
on page 134.

See “Configuring a policy for backups of individual Exchange mailboxes or public
folders (Exchange 2007 and earlier)” on page 111.

See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007
and earlier)” on page 108.

See “About restoring streaming backups of Exchange Server (Exchange 2007 and
earlier)” on page 162.

Performing user-directed full streaming backups (Exchange 2007 and

earlier)

In NetBackup, a user-directed backup of Exchange acts as a copy backup. Copy
backups are the same as full backups, except copy backups do not truncate the
Exchange log files. You can change the behavior of a user backup so that it
normally acts as a full backup instead of a copy backup. As with regular full
backups, the logs are truncated.
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Note: This configuration is only available for streaming backups.

To perform a user-directed copy backup
1 Logonto the server as Administrator.

2 From the Backup, Archive, and Restore interface, perform a user-directed
streaming backup.

See “Performing user-directed streaming backups of Exchange Server
(Exchange 2007 and earlier)” on page 133.

To configure user-directed backups to act as full backups
1 On the Exchange client, open Regedit.
2 Open the following key:

HKEY LOCAL MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Agents\Exchange

Create a new DWORD value named Convert_USER_to_FULL.
Right-click on the new value and click Modify.

In the Value data box, type 1.

Click OK.

N o0 o0 ~W

Repeat these steps for any other Exchange clients.

See “Configuring a policy for backups of individual Exchange mailboxes or public
folders (Exchange 2007 and earlier)” on page 111.

See “Notes and limitations for creating a backup selections list for Exchange 2007
and earlier streaming database backups” on page 111.

See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007
and earlier)” on page 108.

See “Performing user-directed streaming backups of Exchange Server (Exchange
2007 and earlier)” on page 133.

See “About restoring streaming backups of Exchange Server (Exchange 2007 and
earlier)” on page 162.

See “About backing up Exchange Server data” on page 130.

Performing user-directed MAPI backups of individual mailboxes and
public folders (Exchange 2007 and earlier)

Before you perform backups of individual Exchange mailboxes or public folders,
special configuration is required.
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See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.

Note: The user account you use to log on must have the same Exchange privileges
as the NetBackup Client service account.

To back up individual mailboxes, mailbox folders, or public folders, the backup
policy must include the Microsoft Exchange Mailboxes:\ Or the Microsoft
Exchange Public Folders:\directive. These directives are only available for
Exchange 2007 and earlier.

Alternatively, you can perform a user-directed backup from a database backup
policy that has Enable granular recovery enabled. You cannot back up individual
mailboxes, mailbox folders, or public folders with a database backup policy.
However, you can restore these items from the database backup.

See “Performing user-directed streaming backups of Exchange Server (Exchange
2007 and earlier)” on page 133.

See “Performing user-directed snapshot backups of Exchange Server” on page 131.
To perform a user-directed MAPI backup of individual mailboxes and public folders
1 Logonto the server as Administrator.

Open the Backup, Archive, and Restore interface on the Exchange Server.
Click File > Select Files and Folders to Back Up.

Select File > Specify NetBackup Machines and Policy Type.
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In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

m The server you want to perform the backup.

m If you are in a cluster environment, specify the name of the virtual
Exchange Server or the DAG virtual name.
See “About selecting a source client for an Exchange Server backup or a
restore operation” on page 187.
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6 Inthe All Folders pane, expand the node that contains the objects you want

to back up and select those objects.

See Table 5-4 on page 137.
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All Folders Contents of Microsoft Information Store:{First Storage Group

EDQ Microsoft Exchange Mailboxes ;I Tame | nI S.| Timne Modified |

- -0 abraham Lincoln [abe] [ 3 Malbos Store -0 2/17/2008 10:06:37 AM
E-[]5E Comman Yiews

[ & Public Folder Store - 0 2{17/2009 10:06:37 AM
-[]% Deferred Action
-] Finder
-4 Schedule
-4 Shortcuts
=[5 Top of Information Store
E-[] 55 Views
D@ Drwight: D, Eisenhower [ike]
=] Dg Microsaoft Exchange Public Folders
[J¢E Folder-a
I8 Internet Mewsgroups

Click Actions > Backup.
8 Select the backup options you want.
See “Options for Exchange backups” on page 130.
9 Click Start Backup.
10 To view the progress of the backup, click Yes.
If you do not want to view the progress of the backup, click No.

Table 5-4 Selecting individual Exchange mailboxes and public folders for

user-directed backups

Node Select

Microsoft Exchange Mailboxes Mailbox(es)

Mailbox folder(s)

Microsoft Exchange Public Folders Public folder(s)

See “About restoring streaming backups of Exchange Server (Exchange 2007 and
earlier)” on page 162.

See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007
and earlier)” on page 108.

About restoring Exchange database data

Review the following information before you perform restores of Exchange Server:
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m Restore all databases in a storage group at the same time and before the
transaction logs are committed and the databases are mounted.

m When an administrator restores individual databases or transaction logs, the
administrator should have a thorough working knowledge of Exchange Server
databases, transaction logs, and utilities. If the correct files are not restored,
the database(s) may fail to mount.

m Do not restore Microsoft Exchange Mailboxes:\ Or Microsoft Exchange
Public Folders:\ objects and Microsoft Information Store:\ objects at
the same time. Do not restore mailbox or public folder items from a
GRT-enabled backup and a streaming backup at the same time. You must
dismount databases before you restore them. But because they are dismounted,
the attempt to restore mailbox objects fails. Or the restore of the Exchange
mailbox items can finish before the restore of the Exchange databases starts.
In this case the restore of the Exchange databases overwrites the restored
mailbox objects.

m To restore full and incremental backups, you can restore all the backups in a
single operation. Or you can restore the full backups and incremental backups
individually. If you restore all the backups in a single operation, NetBackup
performs a commit after the last incremental is restored. If you restore the
backups individually, select the following options when you restore the last
incremental backup set: Commit after last backup set is restored and Mount
database after restore.

m (Exchange 2007 and earlier streaming restores) Make sure the temporary
location for log files is empty before you start a restore job. If a restore job
fails, check the temporary location (including subdirectories) to make sure log
files from a previous restore job are deleted.

NetBackup copies logs to the Exchange working directory. It creates a
subdirectory for each storage group being restored. After the database is
restored, Exchange applies the log files from the temporary location to the
database, and then it applies the current log files. After the recovery is
complete, Exchange deletes the log files from the temporary location (including
any subdirectories).

m A restore of Exchange Server files always overwrites existing files. (For
example, if Pub.edb already exists on the target machine, it is replaced with
the copy from the backup.)

m Review the information for existing transaction logs.
See “About existing transaction logs” on page 139.

See “Restoring storage groups or storage group databases from a streaming
backup” on page 164.
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See “About restoring streaming backups of Exchange Server (Exchange 2007 and
earlier)” on page 162.

See “About restoring individual mailbox and public folder items” on page 170.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

About existing transaction logs

Depending upon the data recovery scenario you have, you must take existing
transaction logs into consideration.

For example, do one of the following tasks:

m Roll-forward recovery (or replay all log files)
After you restore the files and the service starts up, Exchange commits the
transactions in the logs you restored. If contiguous logs exist on the server
beyond the log with the highest number you restored, those transactions also
are committed. If there is any gap in the numeric sequence of log names, no
further transactions are committed beyond the gap.
This scenario is useful when the transaction logs are intact but you require
the database to be restored. When you keep existing transaction logs, Exchange
Server can recover to the point of the failure. Otherwise, you must recover to
the time of the last full backup or the last incremental backup.

m Point-in-time recovery (or replay only restored log files)
Use this option if you only want to restore up to the point of the last backup.
Any transaction logs that are created after the last backup are not involved in
the recovery of the database(s). For snapshot restores, NetBackup renames
current log files to .delete.

See “About Exchange backups and transaction logs” on page 82.

See “About truncating Exchange transaction logs with Instant Recovery backups”
on page 124.

See “Truncating Exchange transaction logs by performing a backup to a storage
unit” on page 124.

See “About Exchange backup operations” on page 18.

See “About Exchange Instant Recovery methods” on page 21.

About restoring snapshot backups

From a snapshot backup you can restore the Microsoft Information Store, Exchange
2010 databases, and Exchange 2007 and earlier storage groups and storage group
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databases. If you enabled Granular Recovery Technology (GRT) for the backup,
you can also restore mailbox and public folder items from the backup.

See “About restoring individual mailbox and public folder items” on page 170.
Note the following when you restore snapshot backups:

m (Exchange 2007 and earlier) All databases in a storage group must be
dismounted before you begin a restore operation. You can instruct NetBackup
to dismount the databases before the restore begins.

See “Snapshot restore options” on page 140.

m All of the images you select for the restore must be from snapshot backups.

m Only Exchange 2007 allows snapshot restores to the Recovery Storage Group
(RSG).

m Exchange 2010 allows restores to the Recovery Database (RDB).
See “Redirecting an Exchange 2010 Database Availability Group (DAG) snapshot
backup to another database or to the recovery database (RDB)” on page 149.
See “Redirecting an Exchange 2010 standalone server snapshot backup to
another database or to the recovery database (RDB)” on page 153.

m (Exchange 2007 and later) For Instant Recovery restores:
Select Normal Backup even if you want to perform volume rollback. NetBackup
automatically rolls back volumes whenever it is appropriate

One of the following occurs:

m NetBackup snaps back (resyncs) the selected database volumes from the
snapshot to the original volume.

m NetBackup copies back the files of the selected databases from the snapped
volume to the original volume

See “About snapshot backups with Exchange Server” on page 20.
See “Limitations of Exchange snapshot operations” on page 89.

See “Configuration requirements for snapshot backups of Exchange Server”
on page 90.

Snapshot restore options

The following restore options are available when you perform snapshot restores.
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Table 5-5 Snapshot restore options
Option Description
Roll-Forward Retains the existing transaction logs. Exchange replays transaction logs that are part of
Recovery (Replay all | the restore operation, followed by any transaction logs that currently exist.
log files)

See “About existing transaction logs” on page 139.

Point-in-Time
Recovery (Replay only
restored log files)

Restores the database(s) or storage group(s) and replaces only the transaction logs that
existed at the time of backup.

A restore may require a full backup and one or more incremental backups. You can select
all of the images and perform the restore in one job. Or you can restore each backup image
separately. In the latter case, only enable Point-in-Time Recovery for the first job.
Otherwise, each point-in-time recovery deletes the transaction logs from the preceding
restore jobs.

NetBackup renames all transaction log files that exist at the start of the recovery operation
tOEXXYYYYYYYY.log.delete Oor EOyXXXxX.log.delete. Current transaction logs are
only renamed for the Exchange database or storage group that is restored. Then NetBackup
copies logs from the backup image. You can manually delete any logs named E* .
log.delete when the restore or recovery is successful. Otherwise, NetBackup deletes
them on the next point-in-time recovery.

Temporary location
for log files

Not applicable for snapshot restores.

Dismount database
prior to restore

Dismounts the database(s) before the restore begins. For Exchange 2007 and earlier, this
option dismounts all of the databases in the storage that you want to restore, even if a
database is not selected for restore. By default this option is not selected.

This option also sets the Database can be overwritten by a restore flag in Exchange 2007
and later.

Note: Use this option with caution. Ensure that you selected the correct database to restore
before you choose to dismount it with this option.

Commit after last
backup setisrestored

This option should only be set on the last job of a multi-job restore. This option enables the
restore operation to play through log files and roll back any uncompleted transactions. If
this option is not selected, the database needs to be mounted manually after the restore.

If Commit after last backup set is restored is selected when an intermediate backup is
applied, you cannot restore further backups. You must restart the restore operation from
the beginning.

Mount database after
restore

Mount database after restore is automatically selected if Commit after last backup set is
restored is selected. Otherwise, this option is disabled.

141



142 | Performing backups and restores of Exchange Server, mailboxes, and public folders
About restoring Exchange database data

Table 5-5 Snapshot restore options (continued)
Option Description
Redirect to Recovery | Check this option to restore to the recovery storage group (RSG, only applies to Exchange
Storage Group (RSG) | 2007 restores). You cannot restore Exchange 2003 VSS backups to the recovery storage
(Only for Exchange group.
2007) See “Redirecting an Exchange 2007 snapshot backup to a storage group or the recovery
storage group” on page 157.
See “Redirecting an Exchange 2010 Database Availability Group (DAG) snapshot backup
to another database or to the recovery database (RDB)” on page 149.
Start Restore Initiates the restore operation.

See “Redirecting an Exchange 2007 or Exchange 2003 streaming backup to a
recovery storage group” on page 166.

Performing a snapshot restore of a Database Availability Group
(DAG)

Before you perform a snapshot restore
To perform a snapshot restore of a Database Availability Group (DAG)

1 Manually suspend replication. This step applies for any snapshot provider
you use.

http://technet.microsoft.com/en-us/library/dd298159.aspx
2 Dismount all Exchange databases that you want to restore.

Or, when you perform the restore, click the Dismount database prior to
restore option.

Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.

Select File > Specify NetBackup Machines and Policy Type.
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In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

m The server that performed the restore.

m For the source client, select the DAG virtual name.
See “About selecting a source client for an Exchange Server backup or a
restore operation” on page 187.

m For the policy type, select MS-Exchange-Server.


http://technet.microsoft.com/en-us/library/dd298159.aspx
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From the NetBackup History pane, click the backup image that contains the
objects you want to restore as follows:

m The last full backup or user-directed backup

m The last full backup and all subsequent differential backups

m The last full backup and the last cumulative backup

In the All Folders pane, select the objects you want to restore, as follows:

m The Database Availability Group.
Selecting this object restores all the databases.

m Databases.
Expand the DAG. Then select the database(s) and log files you want to
restore.

All Folders Contents of 'Microsoft Exchange Database Availability Groups:\dagrawl.e:
E|D dagrawl Name | Time Backed Up | hl Size I Time
&=+ [E2] Micrasoft Exchange Database Availzb | ) Database 12/9/2009 3:00:59PM  — 67179262 12t
= 1 dagrawt ex639.20 O @ous 12/3/2009 3:00:59PM  —— 5053362 13t
’ £ (1 Miorosoft Information Store |7 (5 oge 1260390381 12/9/2008 300:59PM  — 5258048 120
[ fiitkoatabase (1]
il Just_database
[l Mailbox Database 131262
[l Mailbox Database 161031
-]l Mailbox Database 189716
1 | A KN | |

Click Actions > Restore.
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10 Click the Microsoft Exchange tab.

See “Snapshot restore options” on page 140.

Restore Marked Files [ x|

General  Miciosoft Exchange |

Replay log file option:

* Fol-Forward Recovery (Replay all log files

= Point-in-Time Recoveny [Feplay only restored log files)

Temporary location for log fles:

[~ Dismount database prior to restore

[V Commit after last backup set iz restored
¥ Mourt database after restore

[~ Redirect to Recovery Storage Group [RSG] [Only for Exchange 2007)

Start Restore I Cancel Help |

11 Click Start Restore.

The restore is directed to the active Exchange database, regardless of which
database was backed up. NetBackup automatically detects the Exchange
server that currently contains the active Exchange database.

12 When the restore completes, resume replication.
13 If necessary, update the mailbox database copy.

http://technet.microsoft.com/en-us/library/dd351100.aspx


http://technet.microsoft.com/en-us/library/dd351100.aspx
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Performing a snapshot restore of an Exchange 2010 standalone
server or an Exchange 2007 or earlier server

To perform a snapshot restore of an Exchange 2010 standalone server or an
Exchange 2007 or earlier server

1 Dismount all Exchange databases that you want to restore.

Or, when you perform the restore, click the Dismount database prior to
restore option.

Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.

Select File > Specify NetBackup Machines and Policy Type.
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In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

m The server that performed the restore.

m If you have an Exchange 2007 cluster environment, select the virtual
Exchange server name.
See “About selecting a source client for an Exchange Server backup or a
restore operation” on page 187.

m For the policy type, select MS-Exchange-Server.

6 From the NetBackup History pane, click the backup image that contains the
objects you want to restore as follows:

m The last full backup or user-directed backup
m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup

7 Inthe All Folders pane, select the objects you want to restore, as follows:

m The Microsoft Information Store.
Click the checkbox next to the computer name or the Microsoft
Information Store.

m (Exchange 2007 and earlier) storage groups.
Expand the Microsoft Information Store node and select the storage
group to restore.

m Exchange 2010 databases.
Expand the Microsoft Information Store node. Then select the database(s)
and log files you want to restore.

m Exchange 2007 and earlier databases.
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Expand the Microsoft Information Store node and the storage group.
Then select the database(s) and log files you want to restore.

The following figure shows a restore of Exchange 2010.

All Folders Contents of Microsoft Information Store
E||:| grawl Name | Time Backed Up | Al Size I Time
=[] Microsoft Information Store [ @ Database 12/9/2009 3:00:59PM  — 67179262 12t
e [ [ @oLLs 12/9/2009 3:00:59PM  — 5053362 12/

Eg ::'?‘tb—dat;b;f i [ 3 Logs_1260392381 12/5/2009 3:00:59PM  —— 5258948 12t
allbox Da’ 3se

&[] Maibox Database 161031
&[] Maibox Database 189716

Kl | i | KN | i

The following figure shows a restore of an Exchange 2007 storage group.

All Folders Contents of 'Microsoft Information Store:|\Second Storage Group'

=[] 2 dragonstrike Name | Time Backed Up [a.] Size I Til
& Microsaft Information Store [ & Log files_1233649726  2/5/2009 10:02:06 M —— 7751658 2/

Dl First storage Group [ @l Lag files_1233050122  2/5/2009 100842 AW - 7751650 2/

[ B Log files_1233864516  2/5/2009 2:08:36 PM - 12994598 2{

Eﬁﬁ ?;D';ge Group 103 (CHEXY4) [ @ se2_oE1 2/5/2008 2:08:36 PM - 5263562 2)
IF

[ @ s6z_pb2 2/5/2008 Z:08:36 PM - 5263562 2)

[ @ s62_DE3 2/5/2008 2:08:36 PM - 5263562 2

<

8 Click Actions > Restore.
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9 Click the Microsoft Exchange tab.

See “Snapshot restore options” on page 140.

Restore Marked Files [ x|

General  Miciosoft Exchange |

Replay log file option:

* Fol-Forward Recovery (Replay all log files

= Point-in-Time Recoveny [Feplay only restored log files)

Temporary location for log fles:

[~ Dismount database prior to restore

[V Commit after last backup set iz restored
¥ Mourt database after restore

[~ Redirect to Recovery Storage Group [RSG] [Only for Exchange 2007)

Start Restore I Cancel Help |

10 Click Start Restore.

Recovering an Exchange 2007 Local Continuous Replication
(LCR) environment

This topic describes how to recover a storage group with LCR enabled. Most of
the following PowerShell commands are now available in the Exchange
Management Console with Exchange 2007 SP1. You must manually suspend
replication in a LCR environment. This applies to VSS and non VSS.

Refer to Managing Local Continuous Replication for more information:
http://technet.microsoft.com/en-us/library/aa998823.aspx
Follow these steps:

m Issue the PowerShell command Suspend-StorageGroupCopy for a storage
group before you restore that storage group.


http://technet.microsoft.com/en-us/library/aa998823.aspx
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m Perform a database restore.
See “Performing a snapshot restore of an Exchange 2010 standalone server
or an Exchange 2007 or earlier server” on page 145.

® You may need to re-seed the copy before you resume the copy.
Do the following:

m Remove the database files, all log files, and all checkpoint files from the
copy location. (If you use it, the Exchange Management Console prompts
you to perform this step.)

m Issue the PowerShell command Update-StorageGroupCopy.
See How to Seed a Local Continuous Replication Copy for more information:
http://technet.microsoft.com/en-us/library/aa995973.aspx

m Issuethe PowerShell command Resume-StorageGroupCopy to properly resume
the copy.

See “Recovering an Exchange 2007 Clustered Continuous Replication (CCR)
environment” on page 148.

See “Policy recommendations for Exchange Server 2007 and earlier database
backups” on page 66.

See “Configuring the NetBackup service account (Exchange 2007)” on page 59.

See “Notes and limitations for creating a backup selections list for Exchange 2007
and earlier streaming database backups” on page 111.

Recovering an Exchange 2007 Clustered Continuous Replication
(CCR) environment

This topic describes how to recover a storage group with CCR enabled. Most of
the following PowerShell commands are now available in the Exchange
Management Console with Exchange 2007 SP1. You must manually suspend
replication in a LCR environment. This applies to VSS and non VSS.

Note: A restore can only be directed to the active node.

See Managing Cluster Continuous Replication for more information:
http://technet.microsoft.com/en-us/library/aa997676.aspx
Follow these steps:

m For Exchange 2007 pre-SP1, The NetBackup Client Service must be run as a
privileged domain account on each node. Otherwise, NetBackup is not properly
authorized to perform dismounts or restores.


http://technet.microsoft.com/en-us/library/aa995973.aspx
http://technet.microsoft.com/en-us/library/aa997676.aspx
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Issue the PowerShell command Suspend-StorageGroupCopy for a storage
group before you restore that storage group.

Perform a database restore.
See “Performing a snapshot restore of an Exchange 2010 standalone server
or an Exchange 2007 or earlier server” on page 145.

You may need to re-seed the cluster copy before you resume the copy.

Do the following:

Remove the database files, all log files, and all checkpoint files from the
passive node. (If you use it, the Exchange Management Console, prompts
you to perform this step.)

From the passive node, issue the PowerShell command
Update-StorageGroupCopy.

See Howto Seed a Cluster Continuous Replication Copy for more information:
http://technet.microsoft.com/en-us/library/bb124706.aspx

Issue the PowerShell command Resume-StorageGroupCopy to properly resume
the cluster copy.

See “Recovering an Exchange 2007 Local Continuous Replication (LCR)
environment” on page 147.

See “Redirecting an Exchange 2007 snapshot backup to a storage group or the
recovery storage group” on page 157.

See “Configuring the NetBackup service account (Exchange 2007)” on page 59.

See “Policy recommendations for Exchange Server 2007 and earlier database
backups” on page 66.

Redirecting an Exchange 2010 Database Availability Group
(DAG) snapshot backup to another database or to the recovery
database (RDB)

To redirect an Exchange 2010 snapshot backup to another database or to the
recovery database

1

Manually suspend replication. This step applies for any snapshot provider
you use.

http://technet.microsoft.com/en-us/library/dd298159.aspx

The database or the recovery database must already exist.

To restore to the RDB, create the RDB on an Exchange server, if necessary.
Leave the RDB dismounted.
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Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.
Click File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

Server to use for backups  Select the server that performed the restore.
and restores

Source client for restores Select the virtual DAG name.

Destination clients for Torestore to another database in the same DAG, leave

restores the destination client the same as the source client.
NetBackup detects the active server to which to redirect
the restore.

Toredirect the restore to a different DAG, indicate the
DAG name where that database exists. NetBackup
automatically detects the CAS server that is assigned
to the database. To restore to the RDB, indicate the
DAG name. If the RDB exists on a standalone server,
indicate that server name as the destination client.

If applicable, review the notes and limitations for
redirecting to a different client.

See “Notes and limitations when you select a
destination client for an Exchange Server restore
operation” on page 188.

Policy type for restores Select MS-Exchange-Server.

From the NetBackup History pane, select one of the following:

m The last full backup, or

m The last full backup and all subsequent differential backups, or
m The last full backup and the last cumulative backup

In the All Folders pane, expand Microsoft Exchange Database Availability
Groups > Forest or domain name.

Select the database you want to restore.

Click Actions > Restore.

Change the destination path to another database or to the RDB:
m Click the General tab.
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m Select Restore everything to a different location.

m In the Destination box, provide the name of the alternate database you
want to restore to. Or provide the name of the RDB you previously created.
Exchange 2010 does not automatically redirect a database to its RDB, if

it exists.

Restore Marked Files | x|

General | Microsoft Exchange |
— Restore Destination Choices

" Restore evenything to its original location

* Restore evenything to a diferent location (maintaining existing structure)
Destination:

bs\dagraw 1 .ex639.ad \Microsoft I ion Store\AnotherD); } Erawsze..

™ Restore individual folders and files to different locations (double-click to modify)

base Availabilty Groups:dagraw 1.ex633.ad"Microsoft Information Store*Database [1]\

K I i

© Dreate and restore to a nev vitusl hard disk file

Destination far wirtual hard disk file:

I EBroperties

— Festore [Dption:

™| Riestore without access control attibutes [Windows clients oy
! Oyenwite existing files
. Restore the file uging a temporany filename

Do not restore the file

[~ Owvemide default job priorty
Jiob pricrity 50000 =
[Higher number is greater, priority]

Start Restore I Cancel Help

151



152 | Performing backups and restores of Exchange Server, mailboxes, and public folders
About restoring Exchange database data

12 Click the Microsoft Exchange tab.

See “Snapshot restore options” on page 140.

Restore Marked Files [ x|

General  Miciosoft Exchange |

Replay log file option:

* Fol-Forward Recovery (Replay all log files

= Point-in-Time Recoveny [Feplay only restored log files)

Temporary location for log fles:

[~ Dismount database prior to restore

[V Commit after last backup set iz restored
¥ Mourt database after restore

[~ Redirect to Recovery Storage Group [RSG] [Only for Exchange 2007)

Start Restore I Cancel | Help |

13 Check Commit after last backup set is restored.

If you choose to restore backup images separately, you must check Commit
after last backup set is restored only when you restore the last incremental
backup set.

If you do not select Commit after last backup setis restored, manually mount
the database after the restore is complete.

See “Manually mounting an Exchange database after a restore” on page 161.
14 Click Start Restore.

The restore is directed to the active Exchange database, regardless of which
database was backed up. NetBackup automatically detects the Exchange
server that currently contains the active Exchange database.
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15 When the restore completes, resume replication.
16 If necessary, update the mailbox database copy.
http://technet.microsoft.com/en-us/library/dd351100.aspx

See “Redirecting an Exchange 2010 standalone server snapshot backup to another
database or to the recovery database (RDB)” on page 153.

See “Redirecting an Exchange 2007 snapshot backup to a storage group or the
recovery storage group” on page 157.

See “About redirecting restores of Exchange 2003 snapshot backup images”
on page 161.

Redirecting an Exchange 2010 standalone server snapshot
backup to another database or to the recovery database (RDB)

This topic describes how to redirect a snapshot backup of an Exchange 2010
standalone server to another database or the recovery database (RDB).

To redirect an Exchange 2010 standalone server snapshot backup to the recovery
database

1 The database or the recovery database must already exist.

To restore to the RDB, create the RDB on an Exchange server, if necessary.
Leave the RDB dismounted.

Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.

Click File > Specify NetBackup Machines and Policy Type.


http://technet.microsoft.com/en-us/library/dd351100.aspx

154

Performing backups and restores of Exchange Server, mailboxes, and public folders
About restoring Exchange database data

10
11

In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

Server to use for backups Select the server that performed the restore.
and restores

Destination clients for Torestore to the RDB on a different server, change the

restores destination client to the Exchange server that hosts
the RDB. This client must be the Exchange server that
hosts the database to which you want to redirect the
restore. Also review the notes and limitations for
redirecting to a different client.

See “Notes and limitations when you select a
destination client for an Exchange Server restore
operation” on page 188.

To restore to the RDB or to a database on the local
server, leave the destination client the same as the
source client.

Policy type for restores Select MS-Exchange-Server.

From the NetBackup History pane, select one of the following:

m The last full backup, or

m The last full backup and all subsequent differential backups, or
m The last full backup and the last cumulative backup

In the All Folders pane, expand Microsoft Information Store.
Select the database you want to restore.

Click Actions > Restore.

In the Restore Marked Files dialog box, click the General tab.
Change the destination path to another database or to the RDB:

m Select Restore everything to a different location.

m In the Destination box, provide the name of the alternate database you
want to restore to. Or provide the name of the RDB you previously created.
Exchange 2010 does not automatically redirect a database to its RDB, if
it exists.
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Restore Marked Files

General | Microsoft Exchange |
— Restore Destination Choices

" Restore evenything to its original location

& Restore evenything to a diferent location (maintaining existing structure)
Destination:

= Restore individual folders and files to different locations (double-click to modify)

IMlcmsoﬂ Information Store:\DatabaseEh Browse

Source Destination | Time Backed L
Microsoft Information Store:\Datab

4 |

 Dreate andrestare to a nev vitusl hard disk file

Destination far wirtual hard disk file:

12/7/2009 12:52:33 PM - 12/7/200¢

i

I EBroperties

— Bestore [Dption:
™| Restore without access-contral attributes [Windows clients orly]
 Myemyite existing files
 Restore the file using a lemporar filename

7 Dokot restare the file

[~ Ovemide default job priority
Job pricrity S0000 =
[Higher number is areater priority]

Start Restore I Cancel
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12 Click the Microsoft Exchange tab.

See “Snapshot restore options” on page 140.

Restore Marked Files [ x|

General  Miciosoft Exchange |

Replay log file option:

* Fol-Forward Recovery (Replay all log files

= Point-in-Time Recoveny [Feplay only restored log files)

Temporary location for log fles:

[~ Dismount database prior to restore

[V Commit after last backup set iz restored
¥ Mourt database after restore

[~ Redirect to Recovery Storage Group [RSG] [Only for Exchange 2007)

Start Restore I Cancel | Help |

13 Check Commit after last backup set is restored.

If you choose to restore backup images separately, you must check Commit
after last backup set is restored only when you restore the last incremental
backup set.

If you do not select Commit after last backup setis restored, manually mount
the database after the restore is complete.

See “Manually mounting an Exchange database after a restore” on page 161.
14 Click Start Restore.

See “Redirecting an Exchange 2010 Database Availability Group (DAG) snapshot
backup to another database or to the recovery database (RDB)” on page 149.

See “Redirecting an Exchange 2007 snapshot backup to a storage group or the
recovery storage group” on page 157.
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See “About redirecting restores of Exchange 2003 snapshot backup images”
on page 161.

Redirecting an Exchange 2007 snapshot backup to a storage
group or the recovery storage group

This topic describes how to redirect an Exchange 2007 snapshot backup. You can
redirect the restore to another storage group or to the recovery storage group
(RSG).

For further instructions, refer to the following information on recovery storage
groups on Microsoft’s Technet site:

http://technet.microsoft.com/en-us/library/aa997260.aspx

To redirect an Exchange 2007 snapshot backup to a storage group or the recovery
storage group

1 The RSG or storage group must already exist. Do the following:

m To restore to the RSG, create the RSG and the databases you want to
recover on an Exchange server, if necessary. Leave the RSG dismounted.

m To restore to another storage group, create a storage group that has
databases. Those databases must have the same names as those in the
original storage group.

Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.

Click File > Specify NetBackup Machines and Policy Type.


http://technet.microsoft.com/en-us/library/aa997260.aspx
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In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

Server touse for  Select the server that performed the restore.

backups and

restores

Destination If you want to restore to a different server, change the destination
clients for client to the Exchange server that hosts the RSG or the storage
restores group. Also review the notes and limitations for redirecting to a

different client.

See “Notes and limitations when you select a destination client
for an Exchange Server restore operation” on page 188.

If you want to restore the RSG or a storage group to the local
server, leave the destination client the same as the source client.

Policy type for Select MS-Exchange-Server.
restores

From the NetBackup History pane, select one of the following:

m The last full backup, or

m The last full backup and all subsequent differential backups, or
m The last full backup and the last cumulative backup

In the All Folders pane, expand the Microsoft Information Store.
Select the storage group you want to restore.

Click Actions > Restore.

In the Restore Marked Files dialog box, click the General tab.

To redirect the storage group, do the following:

m Select Restore everything to a different location.

m Change the destination path.
When you redirect a snapshot restore to the RSG, the ESE engine does
not automatically redirect the storage group restore to its RSG, if it exists.
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Restore Marked Files

General | Micrasoft Ekchangal

— Restore Destination Choice:
' Restore everything ta its original location
* Restore everything to a different lncation [maintaining existing structure]

D estination:

Microzolt Information Store \anotherStoreGoupt Eravise..

= Bestore individual folders and files to different locations (double-click to rmodify):

Source | Destinationl Time Backed Up | T

Microsoft Infarmation Store:\StoreGraupEFY 12/3/20091:23:43PM 12

4| |

" Create and restore to a new vitual hard disk file

Destination far wirtual hard disk file:

I EBroperties

— Festore Dption:
I” | Restore without access-contral atiributes [wWindows clients orly]
€ Myenyite existing fles

€ Restore the file using a temporan filename

' Do ot restore the file

[~ Owveride default job pricrity

Job pricrity IBDUDD 3:

[Higher number is areater priority]

Start Festare I Cancel | Help |
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12 Click the Microsoft Exchange tab.

See “Snapshot restore options” on page 140.

Restore Marked Files [ x|

General  Miciosoft Exchange |

Replay log file option:

* Fol-Forward Recovery (Replay all log files

= Point-in-Time Recoveny [Feplay only restored log files)

Temporary location for log fles:

[~ Dismount database prior to restore

[V Commit after last backup set iz restored
¥ Mourt database after restore

[~ Redirect to Recovery Storage Group [RSG] [Only for Exchange 2007)

Start Restore I Cancel | Help |

13 Check Commit after last backup set is restored.

If you choose to restore backup images separately, you must check Commit
after last backup set is restored only when you restore the last incremental
backup set.

If you do not select Commit after last backup setis restored, manually mount
the database after the restore is complete.

See “Manually mounting an Exchange database after a restore” on page 161.

14 If youwant to restore to an RSG, check Redirect to Recovery Storage Group
(RSG) (Only for Exchange 2007).

15 Click Start Restore.

See “Recovering an Exchange 2007 Local Continuous Replication (LCR)
environment” on page 147.
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See “About redirecting restores of Exchange 2003 snapshot backup images”
on page 161.

About redirecting restores of Exchange 2003 snapshot backup
images

The following limitations and requirements exist to redirect restores of Exchange
2003 snapshot backups:

m You cannot restore an Exchange 2003 snapshot backup to an RSG.

m  With this Exchange version, you cannot redirect to a different storage group
on the local server.

m If youwant to redirect to a storage group on another server the storage group
and the database must be identical. The path(s) of the storage group also must
be identical to the original storage group.

See “Redirecting an Exchange 2007 or Exchange 2003 streaming backup to a
recovery storage group” on page 166.

See “Configuring the NetBackup service account (Exchange 2003)” on page 60.

Manually mounting an Exchange database after a restore

If you did not click Commit after last backup set is restored, you need to mount
the database manually after the restore is completed.

To mount a database manually after a restore
1 Mount all of the databases that were restored in the storage group.

2 If the mount fails, try a soft recovery (ignore mismatched database
attachments) of the Exchange databases to bring the databases to a consistent
state.

eseutil /r EOn /i

3 Mount the databases again.
See “Recovering an Exchange database” on page 192.

See “Restoring storage groups or storage group databases from a streaming
backup” on page 164.

See “About backing up Exchange Server data” on page 130.
See “About restoring Exchange database data” on page 137.
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About restoring streaming backups of Exchange Server (Exchange
2007 and earlier)

Streaming backups can only be performed with Exchange 2007 or earlier.
NetBackup uses snapshot technology for all Exchange 2010 backups.

NetBackup can restore the following Exchange Server objects from streaming
backups:

m Microsoft Information Store

m Storage groups

m Storage group databases

You can also redirect a restore to the recovery storage group (RSG).

See “Redirecting an Exchange 2010 Database Availability Group (DAG) snapshot
backup to another database or to the recovery database (RDB)” on page 149.

See “Redirecting an Exchange 2007 snapshot backup to a storage group or the
recovery storage group” on page 157.

See “Redirecting an Exchange 2007 or Exchange 2003 streaming backup to a
recovery storage group” on page 166.

Restore options for streaming restores of Exchange databases

The Roll-Forward Recovery and Point-in-Time Recovery options correspond to
the Delete existing transaction logs prior torestore option in NetBackup 6.5 and
earlier. However, the default option has changed. In those previous releases,
Delete existing transaction logs prior to restore was enabled by default, which
corresponds to Point-in-Time Recovery. The new default option is Roll-Forward
Recovery.

Different options are available when you perform a MAPI mailbox restore or a
snapshot restore.

See “Restore options for restores of Exchange Server mailbox objects or public
folder objects” on page 171.

See “Snapshot restore options” on page 140.

Table 5-6 Restore options for streaming restores of Exchange databases
Option Description
Roll-Forward Recovery Retains the existing transaction logs. Exchange replays the transaction logs that are
(Replay all log files) part of the restore, followed by any transaction logs that currently exist.
See “About existing transaction logs” on page 139.
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Restore options for streaming restores of Exchange databases
(continued)

Option

Description

Point-in-Time Recovery
(Replay only restored log
files)

Restores the database and replaces only the transaction logs that existed at the time
of backup.

Temporary location for log
files

Enter a location where the associated log files are kept until the database is restored.
The default location is c : \ temp. If you choose to restore storage groups, NetBackup
creates a subdirectory in c: \ temp for each storage group. It keeps log files for each
storage group in the corresponding subdirectory.

If Commit after last backup set is restored is selected during the restore, Exchange
applies to the database. Then it applies the current log files. After the restore is
complete, Exchange deletes the log files from the temporary location (including any
subdirectories).

Note: Make sure the temporary location for log files is empty before you start a
restore job. If a restore job fails, check the temporary location (including
subdirectories) to make sure any previous log files from a previous restore job were
deleted.

Dismount database prior to
restore

Dismounts the database(s) before the restore begins. This option dismounts all of the
databases in the storage groups that you want to restore, even if a database is not
selected for restore. By default this option is not selected.

This option also sets the Database can be overwritten by a restore flag in Exchange
2007.

Note: Use this option with caution. Ensure that you selected the correct database to
restore before you choose to dismount it with this option.

Commitafter last backup set
isrestored

This option should only be set on the last job of a multi-job restore. This option enables
the restore operation to play through log files and roll back any uncompleted
transactions. If this option is not selected, the database needs to be mounted manually
after the restore.

If Commit after last backup setis restored is selected when an intermediate backup
is applied, you cannot restore further backups. You must restart the restore operation
from the beginning.

Mount database after Mounts the database so that it is available to users.
restore

Redirect to Recovery This option is not applicable for streaming restores.
Storage Group (RSG) (Only

for Exchange 2007)

Start Restore Initiates the restore operation.
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Restoring storage groups or storage group databases from a
streaming backup

This topic describes how to restore storage groups or databases.

Note: A restore of Exchange Server files always overwrites any existing files. For
example, if pub . edb already exists on the target computer, it is replaced with the
copy from the backup.

To restore storage groups or storage group databases from a streaming backup

1
2

(o) B © 1 B ~ W ¥§ )

Log onto the server as Administrator.
Dismount all Exchange databases that need to be restored.

Or, when you perform the restore, click the Dismount database prior to
restore option.

Open the Backup, Archive, and Restore interface.
Click File > Select Files and Folders to Restore > from Normal Backup.
Click File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

m The server that performed the restore.

m For the policy type, select MS-Exchange-Server.

From the NetBackup History pane, select one of the following:
m The last full backup

m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup

In the All Folders pane, select the objects you want to restore:

m Storage groups.
Expand Microsoft Information Store and click the storage group to
restore.

m Individual databases.
To restore an individual database within a specific storage group, expand
Microsoft Information Store, then the storage group, and click the
database.
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A full backup of an Exchange database includes the database transaction log
files. When you restore a database, you must also restore the transaction log

files.

All Falders

Contents of 'Micrasoft Infarmation Store:|Second Storage Group'

Click Actions > Restore.

Restore Marked Files | x|

General  Microsoft Exchange |

=0 & dragonstrke Marrie: | Time Backed Up [a..] Size | Tl
=01 Microsoft Information Store [ (3 Lag files_1233840726  2/5(2009 100206 AM  — 7751658 2/
Dl First storage Group [ G Log files_1233050122  2/5/2009 10:05:42 &M —— 7751658 2/

M [E7:8 occond Storage Group O @Logfiles_1233864516  2/5/2009 2:09:36 PM - 12994598 2/

s+ LIl storage Group 103 (CHEWYA) [ @ se2_oE1 2/5/2008 2:08:36 PM - 5263562 2)
-0l Thid [ @ s6z_pb2 2/5/2008 Z:08:36 PM - 5263562 2)

[ @ s62_DE3 2/5/2008 2:08:36 PM - 5263562 2

<

Replay log file option:

= Roll-Forward Recover [Replay all log filesk

= Point-in-Time Fecovery [Replay only restored log files]

Temporary location for log files:

[~ Dismount database prior to restore
IV Commit after last backup et is restored

v Mount database after restare

I™ Bedrect to Recavery Storage Group [R5 E] (@l for Exchange 2007]

Start Restare I Cancel |

Help |

10 Select the restore options you want.

11

See “Restore options for streaming restores of Exchange databases”

on page 162.

To restore the backups individually, click Commit after last backup set is

restored and Mount database after restore when you restore the last

incremental backup set.
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12 Click Start Restore.

13 Ifyourestored storage groups and did not click Mount database after restore
(after the restore), be sure to mount the storage group databases that were
restored.

See “About restoring streaming backups of Exchange Server (Exchange 2007 and
earlier)” on page 162.

See “Recovering an Exchange database” on page 192.

See “About configuring the NetBackup Client Service for backups and restores
that use Granular Restore Technology (GRT) or MAPI” on page 56.

See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007
and earlier)” on page 108.

See “Policy recommendations for Exchange Server 2010” on page 63.

See “Policy recommendations for Exchange Server 2007 and earlier database
backups” on page 66.

Redirecting an Exchange 2007 or Exchange 2003 streaming
backup to a recovery storage group

NetBackup supports restores to the recovery storage group. With streaming
backups, you do not need to redirect the restore as long as the RSG already exists
and is added for the selected storage group and database(s). The restore
automatically is restored to the recovery storage group.

For further instructions, refer to the following information on recovery storage
groups on Microsoft’s Technet site:

Exchange 2007 http://technet.microsoft.com/en-us/library/aa997260.aspx

Exchange 2003 http://technet.microsoft.com/en-us/library/aa998782.aspx

To redirect an Exchange 2007 or Exchange 2003 streaming backup to a recovery
storage group

1 Logonto the server as Administrator.
2 Create the RSG on the target Exchange Server, if necessary.
3 (Exchange 2007) Dismount all Exchange databases you want to restore.

Or, when you perform the restore, click the Dismount database prior to
restore option.

4  Confirm that the RSG databases are not mounted.

Open the Backup, Archive, and Restore interface.


http://technet.microsoft.com/en-us/library/aa997260.aspx
http://technet.microsoft.com/en-us/library/aa998782.aspx
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Click File > Select Files and Folders to Restore > from Normal Backup.
Click File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, provide the
following information:

Destination If you want to restore to a different server, change the destination
clients for client to the Exchange server that holds the RSG. Also review
restores the notes and limitations for redirecting to a different client.

See “Notes and limitations when you select a destination client
for an Exchange Server restore operation” on page 188.

If you want to restore to the local server, leave the destination
client the same as the source client.

Policy type for Select MS-Exchange-Server.
restores

From the NetBackup History pane, select one of the following:
m The last full backup

m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup

In the All Folders pane, click the objects you want to restore:

m A storage group
Expand the Microsoft Information Store node and click the storage group
to restore.

m Individual databases
To restore an individual database within a specific storage group, expand
the Microsoft Information Store, then the storage group, and click the
database.

A full backup of an Exchange database includes the database transaction log
files. When you restore a database, you must also restore the transaction log
files.
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11 Click Actions > Restore.

Restore Marked Files | x|

General  Microsoft Exchange |

Replay log file option:

* Ball-Forward Recoven (Replay all log filesk

= Paint-in-Time Recovery [Feplay only restored log files)

Temporary location for log files:

[~ Dismount database pricr to restore

IV Commit after last backup set is rastored
¥ Mount databass after restore

I™ | Bedrect to Recovery Storage Group [R5 E] (@l for Exchange 2007]

Start Restare I Cancel | Help |

12 To restore the backups individually, click Commit after last backup set is
restored and Mount database after restore when you restore the last
incremental backup set.

13 Select the other restore options you want.

See “Restore options for streaming restores of Exchange databases”
on page 162.



14 (Optional) If wanted, click the General tab and change the destination path
to the RSG name.

15
16

See
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The destination path does not need to be changed even though the RSG is a
different name than the original storage group. The ESE engine automatically
redirects the restore to the proper location.

Restore Marked Files [ ]

General | Microsoft Ekchangal

r— Restare Destination Choic
" Restore evervthing ta its original location

* Restore everpthing to a different location [maintaining existing structure]:
Destinatior:

Microsolt [nformation Store: \AnatherS toreGroupY Erowse..

" Bestore individual folders and files to different locations [double-click to madify):

SoLrce | [estination I Time Backed Up | T
Microsoft Infarmation Store:\StoreGraupEFY 12/3/2009 1:29:43PM 11
4 |

" Create and restore to a new vittual hard disk file

[Destination forvirtual bard disk file:

I Fraperties

— Restore Option:

™| Restore without access-contal atiibutes [wWindows clients orly)
€ Myenyite existing fles
€ Restore the filz using a temporan filename

€ Do ot restore the file

[~ Owemide default job pricrity

Job pricrity IBDUDD 3:

[Higher number is areater priority]

Start Restare I Cancel | Help |

Click Start Restore.

If you chose to restore storage groups and you did not click Mount database
afterrestore (after the restore), mount the storage group databases that were
restored.

“Policy recommendations for Exchange Server 2007 and earlier database

backups” on page 66.

See “Configuring a streaming NetBackup for Exchange policy (Exchange 2007

and earlier)” on page 108.

See “About restoring streaming backups of Exchange Server (Exchange 2007 and

earlier)” on page 162.
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About restoring individual mailbox and public folder
items

You can restore individual mailbox or public folder items (folders, messages, and
documents) from the following types of backups:

m  MAPI mailbox backups. This backup type applies to Exchange 2007 and earlier.

m  MAPI public folder backups. This backup type applies to Exchange 2007 and
earlier.

m Streaming or snapshot backups with Granular Recovery Technology (GRT)
enabled.

About special characters in mailbox folders and message subjects

NetBackup uses escape sequences for slashes and backslashes in mailbox folder
names and message subjects because the objects are handled using file path syntax.
The tilde (~) character is the escape character, so it also has to be escaped.

When you browse for items to restore, you see the escaped character sequences.
Use Table 5-7 to convert the translated characters back to the characters that
appear in the restored items.

Table 5-7 Translation of special characters in mailbox folders and message
subjects

Character Translation

~ -0

/ ~1

\ ~2

See “About restoring individual mailbox and public folder items” on page 170.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

See “About restoring individual mailbox and public folder items” on page 170.

Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages

Review the following prerequisites before you restore individual mailboxes,
mailbox folders, public folders, or messages:
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m The destination mailbox must exist to successfully restore a mailbox.

Review the following information before you restore individual mailboxes, mailbox
folders, public folders, or messages:

m When you restore mailbox messages or public folder documents, the option
Overwrite existing message(s) overwrites the contents and properties of the
original objects. Messages are overwritten regardless of their location. (For
example, if the messages were moved to the “Deleted Items” folder.) If the
original message no longer exists, a new message is generated with the same
contents and properties. A new message is also generated if a new destination
location is entered.

If the option Do not restore the message(s) is selected, NetBackup skips the
restore of any message that still exists, regardless of the current location.
Note that if the original message(s) no longer exists, a restore of the message(s)
generates a new copy every time it is restored. A restored copy of the message
does not count as the original message in the existence check.

m When a mailbox is restored, all folders and messages that are contained in the
mailbox are restored. You can choose to restore specific folders or messages
or both from the mailbox backup image.

m When a folder is restored, all subfolders and messages that are contained in
the folder are restored. You also can choose to restore specific subfolders or
specific messages or both from the folder backup image.

m NetBackup can back up the online archive mailbox for users. However, a restore
from a backup using Granular Recovery Technology (GRT) by default restores
the items to the user’s mailbox and not the archive mailbox. Items are restored
starting at the root of the mailbox hierarchy. Alternatively, you may want to
redirect the restore to the path Top of Information Store\Inbox\Archives\.

See “About special characters in mailbox folders and message subjects” on page 170.
See “About restoring individual mailbox and public folder items” on page 170.

See “Restoring mailbox or public folder objects” on page 172.

Restore options for restores of Exchange Server mailbox objects or
public folder objects

When you restore mailbox or public folder objects, NetBackup may encounter
messages that already exist in the database. Select one of the options from
Table 5-8 to indicate whether NetBackup should pass over or replace the
pre-existing object.
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Note: These options are ignored for a redirected restore.

Table 5-8 Restore options for restores of Exchange Server mailbox objects of
public folder objects

Option Description

Donotrestore the | Does not restore mailbox messages if they already exist.
message(s)

Overwrite the Replaces the existing message with the one from the backup.
message

Restoring mailbox or public folder objects

Torestore a mailbox object to a different location, you follow a different procedure.

See “About redirecting a restore of mailbox or public folder objects to a different
path” on page 176.

Note: Browse time for a backup that uses Granular Recovery Technology may take
longer than for a non-granular backup image. The media server gathers granular
information at this time and wait times may vary. Depending on the load on the
media server, you may need to increase the Client read timeout value. This option
is located in the Client host properties in the Timeouts tab.

Note: Do not restore mailbox or public folder backups and database backups in
the same restore job. If the database restore starts first, NetBackup dismounts
the database during the restore. Or it requires that the database be dismounted
before the restore. Then the database being dismounted causes the mailbox or
public folder object restore to fail. Or, the restore of the Exchange mailbox or
public folder items finishes before the restore of the Exchange databases starts.
Then the restore of the Exchange databases deletes the restored mailbox or public
folder objects.

Note: Do not restore any backups that use Granular Recovery Technology with
any backups that do not in the same restore job.

To restore mailbox or public folder objects
1 Logonto the server as Administrator.

2 Open the Backup, Archive, and Restore interface.
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Click File > Select Files and Folders to Restore > from Normal Backup.
Click File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, select the
server and the policy type.

From the NetBackup History pane, click the image(s) that contain the objects
you want to restore.

Symantec recommends that you select one backup image set at a time for
individual item restore. While this recommendation is not a restriction, you
may at times restore more copies of messages than you intend.

You cannot restore individual items from a snapshot incremental backup
that uses Granular Recovery Technology (GRT).

Select one of the following:

m The last full backup

m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup
Expand one of the following:

m Microsoft Exchange Database Availability Groups > Forest or Domain
> Microsoft Information Store > Mailbox Database

m  Microsoft Exchange Database Availability Groups > Forest or Domain
> Microsoft Information Store > Public Store

m Microsoft Information Store > Mailbox Database

m Microsoft Information Store > Public Store

m Microsoft Information Store > Storage Group > Mailbox Database
m Microsoft Information Store > Storage Group > Public Store

m Microsoft Exchange Mailboxes

m Microsoft Exchange Public Folders

In the All Folders pane, select objects you want to restore from the following:
m Mailboxes

m Mailbox folders

m  Mailbox objects

m Public folders

m Documents in a public folder
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You can ignore the pris folder.

The following figure shows a restore of a DAG using Granular Recovery

Technology (GRT).

All Folders Contents of 'Microsoft Exchange Database Availability Groups:\dagrawl.e:
ED@ dagraw 1 | | Name | Time Backed Up | Ao | B | -
=01 [&] Microsoft Exchange Database Ava | ]2 Comman Views 12/9/2009 3:00:59PM d— 0

E"“D@ dagfa_"\'l-e"ﬁg-ad ) [CJ%&Deferred Action 12/9/2009 3:00:50PM d— 0
1 =[] Microsoft Information Stor D% Finder 12/9/2009 3:00:59PM d— 0
<& Freebusy Data 12/9/2009 3:00:59PM d— O
150 Maibox Database 131 % Recoverable Items 12/9/2009 3:00:59PM d— 0
5[ Database [CJ4E1Reminders 12/3/2009 3:00:59PM d— 0
By O<Eascheduls 12/3/2009 3:00:59PM d— 0
<Easharing 12/9/2009 3:00:59PM d— 0 _ |
O dagrawi 4 ar | shortauts 12/9/2009 3:00:59PM d— 0
) dagraw & [d: [J%&Top of Information Store  12/9/2009 3:00:59PM  d— 0
) dagrawt 7 [de % Transport Queue 12{5/2009 3:00:59PM d— 0

12/9/2009 3:00:59PM  d-—

O NORABLSVTILI Osiaviens
=i — -
»

..:
-
I_I;

4 |

7 Al - B -
The following figure shows an Exchange 2007 restore using Granular Recovery
Technology.
All Folders Contents of Microsoft Information Store:\First Storage Grou
-7 B dragonstrike | | name | Tite Backed Up [a.]s]
& Mitm_Sth Information Store OB calendar 2)9(2009 9:38:42 AM  d--—- 0
=@ First storage Groun C4&contacts 2i9(2000 938z 6M d— O
Dgg DlLs D5f0eleted Ttems  2/3(2009 9:36:42 &M d— O
:;S::‘El:nf:msm 4B Drafts 2{9/2009 9:38:42 &AM d— 0O
1 (%) Abraham Lnceln [25e] [l5Embox 2/9/2009 9:38:42 AWM d-—- 0
D142 Common Views 5 3ournal 2/9/2009 9:38:42 AW d-- 0
1421 Deferred Action O<Emotes 2/9/2009 9:38:42 aM d-— 0
O<E0outbos: 2/9/2009 9:38:42 aM d-— 0
[<gh Fresbusy Data [JiErSent tems 2/9(2009 9:35:42 AM d— 0
D14 Reminders Os@Tasks 2j9/2009 913842 AM d— 0

E Schedule
<& Shorteuts
<& Spocler Queue

15 Calendar

K]

[=-[#]%E Top of Infarmation Store

The following figure shows a MAPI mailbox restore.

-] Tickle Me, Too [tickle] -
— = S
I;IJ

All Folders Contents of 'Micrasoft Exchange Mailboxes:Shel Silverstein [shel]'
=+ 5B Microsoft Exchange Maiboxes | | Mame | Time Backed Up [a..]s]
- Ickle Me [ickle] O s8comman Yiews 11/5/2009 2:40:36 PM. d— 0
E -1 Picke Me [pickle] BDeferred Action 11/5(2009 2:40:36 PM d—- 0
Os&EFinder 11/5{2009 2:40:36 FM d-— 0
Os&schedule 11)5{2009 2:40:36FM d— 0
CJsEashortouts 11/5{2009 2:40:36PM  d-— O
[ <ETop of Information Skore 11/5(2009 2:40:36 PM d-— 0
Osiaviews 11/5/2009 2:40:36 PM d— 0
E4 Top of Information Store
i views
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All objects appear as folders and messages. You can identify some
non-message objects by the subject line. For example, if you create a Calendar
event named Appointment1, that name appears in the subject line for that
object.

However, some objects such as Forms and Views do not have a subject line
(even though they can be named). They may not be so easily identified.

Click Actions > Restore.

On the Microsoft Exchange tab, choose whether or not to restore existing
mailbox messages.

See “Restore options for restores of Exchange Server mailbox objects or public
folder objects” on page 171.

General  Microsoft Exchange |

Exchange Mailbo:
If the destination mailbox meszage(z) aready exists:

" Dvenite existing message(s]
& I

Start Restore I Cancel Help |
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11 You can restore individual mailbox items to alternate mailboxes or mailbox
folders.

See “About redirecting a restore of mailbox or public folder objects to a
different path” on page 176.

12 Click Start Restore.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

About redirecting a restore of mailbox or public folder objects to a

different path

NetBackup can restore Exchange mailbox or public folder objects to different
locations.

Refer to the following topics for more information and instructions:

m See “About requirements for redirecting the restore of an Exchange mailbox
object to a different path” on page 176.

m See “Redirecting the restore of a mailbox, mailbox folder, or public folder”
on page 179.

m See “Redirecting a restore of a mailbox or a public folder object to a different
path” on page 181.

About requirements for redirecting the restore of an Exchange
mailbox object to a different path
Review the following requirements for redirecting the restore of an Exchange
mailbox or public folder to a different path:
m Inthe destination path, the following segment of the path cannot be changed:
Microsoft Exchange Database Availability Groups:\
Microsoft Information Store:\
Microsoft Exchange Mailboxes:\
Microsoft Exchange Public Folders:\
If you change this part of the path, NetBackup attempts to restore the objects
as normal (non-Exchange) files.

m The destination mailbox or destination folder must have an associated user
account.

m When you redirect a restore of public folders, the folder that is indicated in
the destination path does not have to exist.
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m When you redirect mailbox backups, if you modify the name of the Exchange
folders, NetBackup restores the selected object to that specified folder name.
These Exchange folders include “Top of Information Store,” “Views,” “Finder”,
etc. You can see the new folder when you browse for backups and it is backed
up on subsequent backups of that mailbox. However, you cannot use Outlook
to view the folder and any subfolders and messages in that folder.

m (Exchange 2010) If you want to redirect the restore of a mailbox from a
Database Availability Group (DAG) to a standalone Exchange server, you must
include Microsoft Exchange Database Availability Groups:\andllot
Microsoft Information Store\: in the destination path.

Correct

Microsoft Exchange Database Availability Groups:\Database Name\John Q. Employee [johng]\

Top of Information Store\Calendar\
Incorrect

Microsoft Information Store:\Database Name\John Q. Employee [johng]\

Top of Information Store\Calendar\

m Additional requirements exist when you restore mailboxes from a granular
backup. Assume that the source path is one of the following:

Microsoft Information Store:\My-Store-Group\My-database\John Q. Employee\
Top of Information Store\Inbox\Nancy’s birthday

Microsoft Information Store:\My-database\John Q. Employee\Top of Information Store\
Inbox\Nancy’s birthday

Note the following:

m  “My-Store-Group” must be a valid storage group on the destination
Exchange server. However, the target mailbox does not have to exist in the
specified storage group.

m “My-database” must exist but is not used at restore time. The mailbox for
John Q. Employee is located on the destination Exchange Server but it is
independent of the database specification.

m Before you attempt the restore, the mailbox for “John Q. Employee” must
exist on the destination server.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

See “About redirecting a restore of mailbox or public folder objects to a different
path” on page 176.
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See “Examples of redirecting an Exchange mailbox restore” on page 178.

See “Redirecting the restore of a mailbox, mailbox folder, or public folder”
on page 179.

Examples of redirecting an Exchange mailbox restore

Mailbox 1 consists of Top of Information Store, Inbox, and Folders 1 and 2, each
containing some mail messages. Assume that you back up Mailbox 1. If you restore
Mailbox 1 to the existing Mailbox 2, all of the Mailbox 1 contents are restored to
Mailbox 2. Note that Mailbox 1 itself is not created under Mailbox 2.

See Figure 5-1.

Figure 5-1 Redirecting the restore of mailbox 1 to mailbox 2
=-[#] B snowbush =] &) snowbush
= 9 Microsoft Exchange Mailboxes EDS Microsoft Exchange Maiboxes
@ Mailbioz 1 ED@ Mailbioy: 2
[=I-[v] 21 Top of Information Store =-[]%E Top of Information Store
=[5 Inbox =% Inbox

=[5 Folder 1 -4 Falder 1

V] £ Message 1 [ &A Message 1

[ &A Message 2

EDQ@ Folder 2
B Message 3

[W] B3 Message 4 “[]EA Message 4

Assume that you redirect the restore of Mailbox 1\Top of Information
Store\Folder 2toMailbox 2.Thecontentsof Mailbox 1\Top of Information

Store\Folder 2,Message 3,andMessage 4,are placedinMailbox 2 inthe same
folder as they were in Mailbox 1.

See Figure 5-2.

Figure 5-2 Redirecting the restore of folder 2 to mailbox 2
=-[#] B snowbush =-] B snowbush
9 Microsoft Exchange Mailbaxes EDS Microsoft Exchange Maiboxes
E-[Z1G2 Mailbox 1 -] Maibox 2
E-[#] 5 Top of Information Store =-[]%E Top of Information Store
- [£5E Inbox =% Inbox
E-[#4E Folder 1 B[4 Folder 2

£ Message 1 [ EA Message 3
EA Message 2 [ Message 4
=[] 4 Folder 2

v] £ Message 3

=] Message 4

See “Redirecting the restore of a mailbox, mailbox folder, or public folder”
on page 179.

See “About requirements for redirecting the restore of an Exchange mailbox object
to a different path” on page 176.
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See “About redirecting a restore of mailbox or public folder objects to a different
path” on page 176.

Redirecting the restore of a mailbox, mailbox folder, or public
folder

This topic describes how to redirect the restore of a mailbox, mailbox folder, or
public folder to a different mailbox or public folder.

To redirect the restore of a mailbox, mailbox folder, or public folder

1 Logonto the server as Administrator.

Open the Backup, Archive, and Restore interface.

Click File > Select Files and Folders to Restore > from Normal Backup.

Click File > Specify NetBackup Machines and Policy Type.

o b~ W N

In the Specify NetBackup Machines and Policy Type dialog box, select the
server and the policy type.

6 From the NetBackup History pane, click the image(s) that contain the objects
you want to restore. Select one of the following:

m The last full backup
m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup

You cannot restore individual items from an incremental backup that uses
Granular Recovery Technology (GRT).

In the All folders or right pane, click the mailbox or public to restore.

8 Click Actions > Restore.
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9 On the Microsoft Exchange tab, select the restore options you want.
See “Restore options for restores of Exchange Server mailbox objects or public

folder objects” on page 171.

Restore Marked Files [ ]

General Microsoft Exchange |

Exchange Mailbo:
1f the destination mailbox message(s) already exists:

= Ovenwite existing message(s)

Start Restare I Cancel | Help |

10 On the General tab, click Restore everything to a different location.

11 Inthe Destination box, indicate where you want to restore the object. You
must indicate an explicit path (or full path).

m Change the mailbox name to another existing mailbox. For example, if
you want to restore the contents of Mailbox 1toMailbox 2\Folder,
specify one of the following in the Destination box:

Microsoft Exchange Database Availability Groups:\Forest or Domain\
Microsoft Information Store\Mailbox Database [Mailbox]\Mailbox 2\

Microsoft Information Store:\Mailbox Database\Mailbox 2\
Microsoft Information Store:\Storage Group\Mailbox Database\Mailbox 2\

Microsoft Information Store:\Storage Group\Mailbox Database\Mailbox 2\
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Microsoft Exchange Mailboxes:\Mailbox 2\

m When you restore public folders, change the public folder name to the
folder to which you want to restore. This folder does not have to exist.

Restore Marked Files B

General | Microsoft Exchangal

r— Restare Destination Choice:

" Restore everything to its original location

& Restore everpthing to a different location [maintaining existing structure]:

Destination:
soft Exchange Mailboxes: \udy Blume [blume]\nboshShels Folded Browse |

" Restore individual folders and files to different locations [double-click to modify):

Source | Deslinal\unl Time Backed Ly
Microzoft Exchange Maiboxes:\Shel Silverstein [shel]\ 11/5/2009 2:40:
4| | i

" Create and restore to a new vitual hard disk file

Destination far wirtual hard disk file:

I EBroperties

— Festore Dption:

I | Riestore without access-control attitutes [Windows clisnts arly)
' Oyenite existing fles
' Festore the file using a temporary filename

€ o ot restore the file

[~ Ovemide default job priority

Job pricrity ISUDDD 33

[Higher number is areater, priority]

Start Restore I Cancel | Help |

12 Click Start Restore.

Redirecting a restore of a mailbox or a public folder object to
a different path

This topic describes how to restore a mailbox or a public folder object to a different
path.

To restore a mailbox or a public folder object to a different path
1 Logonto the server as Administrator.
2 Click File > Select Files and Folders to Restore > from Normal Backup.

3 Click File > Specify NetBackup Machines and Policy Type.
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4  In the Specify NetBackup Machines and Policy Type dialog box, select the
server and the policy type.

5 From the NetBackup History pane, click the image(s) that contain the folder
you want to restore.

Select one of the following:

m The last full backup

m The last full backup and all subsequent differential backups
m The last full backup and the last cumulative backup

You cannot restore individual items from an incremental backup that uses
Granular Recovery Technology (GRT).

6 In the Contents of or right pane, click the folders, messages, or documents
to restore.

If you select items in the All Folders pane, you cannot redirect individual
objects.

7 Click Actions > Restore.
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8 On the Microsoft Exchange tab, select the restore options you want.

See “Restore options for restores of Exchange Server mailbox objects or public
folder objects” on page 171.

Restore Marked Files [ ]

General Microsoft Exchange |

Exchange Mailbo:
1f the destination mailbox message(s) already exists:

= Ovenwite existing message(s)

9 3]

Start Restare I Cancel | Help |

9 On the General tab, click Restore individual folders and files to different
locations option.

Each row under Restore individual folders and files to different locations
is associated with an individual folder, message, or document.

10 Double-click a row to modify the restore destination.
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11 Inthe New Destination box, indicate the mailbox or folder where you want
to restore the object(s).

To redirect a mailbox folder or message, the destination can be any existing
mailbox or mailbox folder. To redirect a public folder or document, the
destination can be a new or existing public folder. You must indicate an
explicit path (or full path).

For example, consider that you want to restore the contents of Inbox in
Mailbox 1 tothe folder other in the same mailbox. Specify one of the
following in the Destination box:

Microsoft Exchange Database Availability Groups:\Forest or Domain\

Microsoft Information Store\Mailbox Database [Mailbox]\Mailbox 1\Other
Microsoft Information Store:\Mailbox Database\Mailbox 1\Other

Microsoft Information Store:\Storage Group\Mailbox Database\Mailbox 1\
Top of Information Store\Other

Microsoft Exchange Mailboxes:\Mailbox 1\Top of Information Store\Other
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Restore Marked Files

General | Microsoft Exchange |

About restoring individual mailbox and public folder items

— Restore Destination Choice:

[Destination;

' Restore everything ta its original location

= Restore everpthing to a different location [maintaining existing structure]:

ticrosoft Exchange Mailbozes:\Shel Silverstein [shell\Top of Infomat Browse

= Restore individual folders and files to different locations [double-click to modify):

-

Iew Destination:

change Mailbozes:\Shel Silverstein [shel\Top of Information Storetlnboxt) osé Muri
change Mailbowes:\Shel Sikverstein [shell\Top of Information Storehlnbow'Multistrean |
change Mailbores:\Shel Silverstein [zhel]\Tap of Infarmation Staretnbox\RE: Jozé

Il Enter New Destination [ %]

Source: Microsoft Exchange Mailboxes:\Shel Silverstein [shellsTop of Information
Storehnboxshultistream granular backup

I\Jud_l,l Blume [blume]sTop of Information StorebShels MessageshMultistream EBrowse |

oK I Cancel |
4

 Myemyite existing files

7 Dokot restare the file

™| Restore without access-contral atributes [Windows clients orly]

 Restore the file using a lemporar filename

[~ Ovenride default pricrity
Jab priarity

0000 B

[higher number, s greater priarty]

Start Festare | Cancel | Help |

12 Click OK.
13 Click Start Restore.

See “About using the command line to browse or restore granular backup images”

on page 185.

Note the following information when you use the command line to browse or

restore granular backup images:

When you perform a snapshot restore of mailboxes or mailbox folders, specify
the file names as relative to the Microsoft Information Store or DAG and to
the storage group or database.
Correct:

\Microsoft Database Availability Groups\My-database\John Q. Employee\

Top of Information Store\Inbox\Nancy’s birthday

185
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\Microsoft Information Store\My-database\John Q. Employee\Top of Information Store\
Inbox\Nancy’s birthday

\Microsoft Information Store\My-Store-Group\My-database\John Q. Employee\
Top of Information Store\Inbox\Nancy’s birthday

Incorrect:

\Microsoft Exchange Mailboxes\John Q. Employee\Top of Information Store\Inbox\
Nancy’s birthday

m The “-granular_proxy” option is included with the bpdup1icate command and
the bplist command. Use the “-granular_proxy” option to specify a proxy
host if one of the following situations apply:

® You do not want to affect the source client
m The source client is not available

m You want to use a different proxy host than the one specified in the host
properties for the source client

The following example shows how you can specify a proxy host with the bp1ist
command:

bplist -t 16 -k exchgranpolicy -R -s 06/09/2008 16:00:00
-granular proxy ProxyServerA "\Microsoft Information Store\StorageGroupl\
DeptA\EmployeeA\Top of Information Store\Inbox\*"

More information is available on how to configure the proxy server in the
client host properties.

See “Configuring the granular restore proxy host” on page 124.

m If you specify a proxy host, it must have the same version of Windows as the
client from which the backup is made. The proxy host also must have privileges
to perform granular operations.

See “About Exchange client and server privileges for granular operations,
virtual environments, or off-host backups” on page 114.

About restoring Backup Exec Exchange images with
NetBackup

To restore Backup Exec backup images, follow the instructions for restoring a
NetBackup for Exchange image, except select File > Select Files and Folders to
Restore > from Backup Exec Backup.



Performing backups and restores of Exchange Server, mailboxes, and public folders | 187
About selecting a source client for an Exchange Server backup or a restore operation

Verify that NetBackup supports the restore type of you want to perform. See the
following Technote:

http://entsupport.symantec.com/docs/295433

See “About restoring Exchange database data” on page 137.
See “About configuring NetBackup for Exchange” on page 54.
See “NetBackup for Exchange backup types” on page 71.

About selecting a source client for an Exchange Server
backup or a restore operation

To perform an Exchange backup or restore in a cluster or DAG environment, you
select the virtual client name as the source client. Some limitations exist when
you select a source client for a backup operation:

See “Notes and limitations when you select a source client for an Exchange Server
backup or restore operation” on page 187.

To provide the name of the virtual client, select File > Specify NetBackup
Machines and Policy Type. Select the source client as described in Table 5-9

Table 5-9 Source client for an Exchange Server backup or restore operation

To perform a backup for For Source client for restores (or virtual
client for backups), select

An Exchange DAG the DAG name

An Exchange cluster the virtual Exchange Server name or virtual
DAG name. If necessary, add the virtual
name to the list and then select it.

Notes and limitations when you select a source client
for an Exchange Server backup or restore operation

Note the following when you select a source client for a backup operation:

® Youcannot use the Java client interface to select a virtual client or virtual DAG
name for a backup operation. Instead, log on with the virtual client name or
virtual DAG name.


http://seer.entsupport.symantec.com/docs/295433.htm
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m To perform a backup of a client in an Exchange cluster or DAG, must provide
the virtual name of the Exchange Server or the virtual DAG name. NetBackup
requires this configuration for backups of clusters to be successful.

About selecting a destination client for an Exchange
Server restore operation

When you perform a restore of an Exchange backup, you can choose the destination
client to which you want to restore a backup. (This type of operation is called
redirecting a restore to a different client.) Most of the Exchange objects that are
backed up can be redirected to a different client. The Microsoft Exchange
Information Store databases can be restored to a different Exchange server.

Some limitations exist for this type of redirected restore. Also follow the
instructions for the specific type of restore or redirected restore you want to
perform.

See “Notes and limitations when you select a destination client for an Exchange
Server restore operation” on page 188.

See “Notes and limitations when you select a destination client for an Exchange
Server restore operation” on page 188.

See “Redirecting an Exchange 2010 Database Availability Group (DAG) snapshot
backup to another database or to the recovery database (RDB)” on page 149.

See “Redirecting an Exchange 2010 standalone server snapshot backup to another
database or to the recovery database (RDB)” on page 153.

See “Redirecting an Exchange 2007 snapshot backup to a storage group or the
recovery storage group” on page 157.

Notes and limitations when you select a destination
client for an Exchange Server restore operation

Note the following when you select a destination client for a restore operation:

m To redirect a restore to a different client, you must have NetBackup server
privileges or be logged into a server with the NetBackup Administration Console
or the NetBackup Remote Administration Console.

m It may not be possible to restore an Exchange database from a NetBackup
client-only installation on a cluster. You may not be able to change the
destination client value to match the virtual server name. In that case, use the
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Backup, Archive, and Restore interface on a NetBackup server. From the server
you can change the destination client value to the virtual server name.

The following requirements must be met before you redirect the restore of
databases, storage groups, or storage group databases:

m The databases or the storage groups must exist on the target server.

m (Exchange 2007 and earlier) The storage group databases must have the same
names as those in the original storage group.

m (Exchange 2007 and earlier streaming backups) The target server must have
the same Organization and Administrative Group name as the source server.

The following additional limitations apply for Exchange 2003 when you redirect
a snapshot restore to a different client:

m The storage group log prefix on the target server must be the same as the
prefix of the original storage group. (For example, E00.log.) You may need to
create temporary storage groups so that the target storage group has the same
log prefix as the original.

m Thetarget storage group and databases must have the same path as the original
storage group and databases for the following: Exchange database, transaction
logs, and system files.
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Recovering an Exchange
database to a repaired or
an alternate Exchange

server

This chapter includes the following topics:

m About recovery of Exchange databases

m Recovering an Exchange database

About recovery of Exchange databases

Table 6-1 Recovering Exchange databases
Step Action Description
Step 1 Repair the Exchange server or create | If you need to recover an Exchange database, you can

an alternate Exchange server

restore it to a repaired Exchange server or to an
alternate Exchange server. For instructions on
performing a diaster recovery of an Exchange server,
see Table 6-2.

Step 2 Recover the Exchange database.

See “Recovering an Exchange database” on page 192.
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Recovering an Exchange database

Table 6-1 Recovering Exchange databases (continued)
Step Action Description
Step 3 Extract mailbox or public folder data | After you restore to an alternate server, you then can

to the server.

extract mailbox or public folder data to that server.
Technote 264924 explains how to configure an
alternate server for restore operations:

http://entsupport.symantec.com/docs/264924

Table 6-2 Instructions for performing a diaster recovery of an Exchange server

Exchange 2010 http://technet.microsoft.com/en-us/library/dd876880(EXCHG.140).aspx

Exchange 2007 http://technet.microsoft.com/en-us/library/aa998848.aspx

Exchange 2003 Exchange 2003 Disaster Recovery Operations Guide

http://technet.microsoft.com/en-us/library/bb125070.aspx

All versions of www.microsoft.com/exchange

Exchange

See “Recovering an Exchange database” on page 192.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

See “About restoring Exchange database data” on page 137.

Recovering an Exchange database

To recover an Exchange database

1 Onan alternate or a repaired Exchange server, create databases (Exchange
2010) or storage groups (Exchange 2007 and earlier) that match the original
databases or storage groups.

You can use the Backup, Archive, and Restore interface on the master to view
the correct logical names of the databases or storage groups you want to

recover.

2 Mount and dismount each database store you want to restore.

This action creates the data files NetBackup requires for restore.

3 Right-click the database store and click Properties.


http://entsupport.symantec.com/docs/264924
http://technet.microsoft.com/en-us/library/dd876880(EXCHG.140).aspx
http://technet.microsoft.com/en-us/library/aa998848.aspx
http://technet.microsoft.com/en-us/library/bb125070.aspx
www.microsoft.com/exchange
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On the Database tab, click This database can be overwritten by a restore.

Install the NetBackup client software on the alternate or the repaired
Exchange server.

On the master server, open the Backup, Archive, and Restore interface.
Click File > Specify NetBackup Machines and Policy Type.

In the Specify NetBackup Machines and Policy Type dialog box, specify the
following:

Server to use for backups and restores  Select the NetBackup server that
performed the backup.

Source client for restores Select the client from which the backup
was performed. For a clustered or DAG
environment, this client is the virtual DAG
name or the virtual cluster name.

Policy type for restores Select MS-Exchange-Server.

Destination clients for restores Select the client where you want to direct
the restore. This client is either the
alternate or the repaired Exchange server.

Click OK.
Restore the databases and transaction logs.

See “Restoring storage groups or storage group databases from a streaming
backup” on page 164.

Reconnect the mailboxes you recovered to their Active Directory user
accounts.

If you recovered to an alternate Exchange server, Symantec Corporation
recommends you restore mailbox data from a backup that used Granular
Recovery Technology (GRT).

You can also use a third party tool such as EXMerge to move individual items
from an alternate database or an RDB or RSG.

See the Microsoft Web site for more information about EXMerge.

See “About recovery of Exchange databases” on page 191.

See “Prerequisites and operational notes for restoring Exchange individual
mailboxes, mailbox folders, public folders, or messages” on page 170.

See “About restoring Exchange database data” on page 137.
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Troubleshooting NetBackup
for Exchange

This chapter includes the following topics:

About debug logging

Viewing Event Viewer logs on an off-host Exchange server

About NetBackup status reports

Exchange Server transaction log truncation errors

Troubleshooting LCR, CCR, and Database Availability Group (DAG) recovery

Troubleshooting an Exchange mailbox operation with a status 5 error with
bprestore

Dynamic enforcement of path length limit for Exchange backups and restores
Troubleshooting Exchange snapshot operations

Troubleshooting jobs that use Granular Recovery Technology (GRT)

About concurrent restore of multiple storage groups

Increased memory usage with Exchange 2010

Finding the virtual Database Availability Group (DAG) node

Displaying and resetting the Backup Status for a Database Availability Group
(DAG)
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About debug logging

About debug logging

The NetBackup master server and client software offers a comprehensive set of
debug logs for troubleshooting problems that can occur during NetBackup
operations. Debug logging is also available for Exchange Server backup and restore
operations.

See the following topics for information on how to create the logs and how to
control the amount of information written to the logs.

See “Enabling the debug logs for a NetBackup for Exchange client automatically”
on page 196.

See “Debug logs for NetBackup for Exchange backup operations” on page 196.
See “Debug logs for NetBackup for Exchange restore operations” on page 197.
See “Setting the debug level on a NetBackup for Exchange client” on page 198.

After you determine the cause of the problem, disable debug logging by removing
the previously created debug logging directories. Details are available on the
contents of these debug logs.

See the NetBackup Troubleshooting Guide.

Additional information about NetBackup client logs and NetBackup master server
logs is available.

See the online help for the Backup, Archive, and Restore interface.

See the NetBackup Administrator’s Guide, Volume I.

Note: When debug logging is enabled, the files can become large. The same files
are used by normal file backups.

Enabling the debug logs for a NetBackup for Exchange client
automatically

You can enable debug logging by running a batch file that creates each log
directory. To create all log file directories automatically, run the following:

install path\NetBackup\logs\mklogdir.bat

Debug logs for NetBackup for Exchange backup operations

After you perform a backup, debug logging information is placed in a subdirectory
that has the name of the process directory. The file is named mmddyy.1og.

For details on logging, see the NetBackup Troubleshooting Guide.



All backups

Snapshot backups

Backups that use GRT

Exchange 2010 backups and
restores
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Refer to the following logs:
B install path\NetBackup\logs\beds
This log is used only for mailbox and public folder backups using MAPI or EWS.
B install path\NetBackup\logs\bpbkar
Refer to the following logs:
B install path\NetBackup\logs\bpbkar
For off-host backups, the bpbkar log exists on the alternate client.
B install path\Netbackup\logs\bpfis
For off-host backups, the bpfis log exists on the alternate client and the primary
client
Refer to the following logs:
B install path\Netbackup\logs\nbfsd
This log appears on the client and the media server.
install path\NetBackup\logs\bpresolver
This log is written to the active node. To determine the active node, see the following:

See “Finding the virtual Database Availability Group (DAG) node” on page 204.

See “About installing the Exchange System Management Tools on the remote
server” on page 200.

See “Exchange Server transaction log truncation errors” on page 201.

Debug logs for NetBackup for Exchange restore operations

After you perform a restore, debug logging information is placed in a subdirectory
that has the name of the process directory. For legacy logging, the file is named

mmddyy . 1og. For unified logging, the log file is in a format that is standardized
across Symantec products.

For details on both unified and legacy logging, see the NetBackup Troubleshooting

Guide.

All restore operations

Refer to the following logs:

B install path\NetBackup\logs\beds
This log applies to mailbox and public folder restores with MAPI or EWS.

B install path\Netbackup\logs\tar
This log is not used for restores that use Granular Recovery Technology (GRT).
For off-host Instant Recovery, this log appears on the primary client.
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Restores with GRT

Refer to the following logs:

install path\NetBackup\logs\beds

install path\NetBackup\logs\nbfsd

This log appears on the client and the media server.

install path\Netbackup\logs\ncf

ncf uses unified logging. This log appears on the destination client or proxy client.
install path\Netbackup\logs\ncflbc

This log is for nb1lbc.exe. It appears on the destination client or proxy client.
install path\Netbackup\logs\ncfgre

This log is for nbgre . exe. It appears on the destination client or proxy client.

Instant Recovery and Instant Refer to the following logs:

Recovery off-host

install path\NetBackup\logs\bpbkar

For off-host Instant Recovery restores, bpbkar logs on the alternate client.
install path\Netbackup\logs\bpfis

This log applies to Instant Recovery rollback restores. For off-host Instant Recovery
backups, bpfis logs exist on both the primary and the alternate clients.
install path\Netbackup\logs\bppfi

For off-host Instant Recovery restores, bppfi logs on both the primary and the
alternate clients.

See “Exchange Server transaction log truncation errors” on page 201.

Setting the debug level on a NetBackup for Exchange client

To control the amount of information that is written to the debug logs, change
the General, Verbose, and Database debug levels on the client(s). Typically, the
default value of 0 is sufficient. However, technical support may ask you to set the
value higher to analyze a problem.

The debug logs are located in install path\NetBackup\logs.

To set the debug level on a NetBackup for Exchange client

1

From the Windows Start menu, choose Programs > Symantec NetBackup >
Backup, Archive, and Restore.

Select File > NetBackup Client Properties.

Click the Troubleshooting tab.

Set the General debug level.

Set this level as high as 2.
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5 Set the Verbose debug level.
Set this level as high as 5.
6 Click OK to save your changes.

Viewing Event Viewer logs on an off-host Exchange

server

During the verification of an off-host backup, Exchange Server logs messages on
the off-host server. These logs are helpful if you need to troubleshoot the
verification stage of the backup. The application event logs are used for Exchange
snapshot backup and restores and for consistency checks. If Exchange Server is
not installed on the remote server, you cannot view the details of these logs.

You can view the logs on the remote server in one of the following ways:

m See “Connecting to the remote Exchange server from within Event Viewer”
on page 199.

m See “About installing the Exchange System Management Tools on the remote
server” on page 200.

See “Debug logs for NetBackup for Exchange backup operations” on page 196.

Connecting to the remote Exchange server from within Event Viewer

You can view the logs on the remote server by opening Event Viewer on a server
that has Exchange Server installed. Then connect to the remote computer (the
server that performed the off-host backup).

To connect to the remote server from within Event Viewer

Log in to a server that has Exchange Server installed.

Open the Event Viewer.

Click Actions > Connect to another computer.

In the Select Computer dialog box, click Another computer.

Type the name of the remote server or click Browse to select the server.

Click OK.

N o o WNBRP

In the left-hand pane, click Application to view the Exchange logs related to
the off-host backup.

See “Viewing Event Viewer logs on an off-host Exchange server” on page 199.

See “Debug logs for NetBackup for Exchange backup operations” on page 196.
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About installing the Exchange System Management Tools on the remote
server

To install the Exchange System Management Tools, refer to the following articles:

m On the Microsoft Support Web site, refer to article 834121:
http://support.microsoft.com

m On the Microsoft TechNet Web site, refer to the Administration Guide for
Exchange Server 2003:
http://technet.microsoft.com

See “Debug logs for NetBackup for Exchange backup operations” on page 196.

About NetBackup status reports

NetBackup provides many standard status reports to verify the completion of
backup and restore operations. In addition, users and the administrator can set
up additional reports if a site requires them.

The administrator has access to operational progress reports through the
NetBackup Administration Console. Reports can be generated for Status of
Backups, Client Backups, Problems, All Log Entries, Media Lists, Media Contents,
Images on Media, Media Logs, Media Summary, and Media Written. These reports
can be generated for a specific time frame, client, or master server.

See the NetBackup Administrator’s Guide, Volume I for details.

Progress reports on the client allow easy monitoring of user operations. When
reports are created by the NetBackup client for each user-directed backup or
restore operation, administrators can monitor these operations and detect any
problems that may occur.

See “Viewing the progress report of a NetBackup for Exchange operation”
on page 200.

Viewing the progress report of a NetBackup for Exchange operation

This topic describes how to view the progress report of a NetBackup for Exchange
backup or restore operation.


http://support.microsoft.com
http://technet.microsoft.com
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To view the progress report of a NetBackup for Exchange operation
1 Choose File > View Status.

2 Click the task for which you want to check the progress.

3 Click Refresh.

More information is available on progress reports and the meaning of the
messages.

See the NetBackup Backup, Archive, and Restore Getting Started Guide.
See “About NetBackup status reports” on page 200.

Exchange Server transaction log truncation errors

The Exchange server deletes transaction logs after a successful backup (for full
and differential backup types). If the Exchange server encounters any errors
during the deletion process, it logs this information in the application event log.
Since the actual backup was successful, NetBackup exits with a status 0 (successful
backup). Refer to the Microsoft Exchange Server documentation for information
on any errors that are encountered with the transaction logs.

Troubleshooting LCR, CCR, and Database Availability
Group (DAG) recovery

If you restore a backup which included only uncommitted logs, Exchange may
report an error similar to the following:

Event Type: Error

Event Source: MSExchangeRepl
Event Category: Service

Event ID: 2059

Refer to the following Technote for information on how to resolve this issue:

http://entsupport.symantec.com/docs/336948

Troubleshooting an Exchange mailbox operation with
a status 5 error with bprestore

If you start an Exchange mailbox restore operation with the bprestore command
and encounter a status 5 error, check that the path is correct. The bp1ist command
does not properly escape the “[” and “]” characters.
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For example, bp1ist returns the following path for a mailbox:
/Microsoft Information Store/SGl/Mailboxl/backrestl100 [backrestl100]/
Instead, edit the path so it appears as follows:

/Microsoft Information Store/SGl/Mailboxl/backrestl100 \[backrestl100\]/

Dynamic enforcement of path length limit for
Exchange backups and restores

The NetBackup Administrator’s Guide for Windows, Volume I details that files
and directories with path lengths greater than 1023 are automatically excluded
from backups. For Exchange MAPI mailbox backups and for GRT-enabled backups,
the path length limit applies to individual mailbox folders and messages. When
a legacy mailbox backup encounters an item that exceeds the limit, the backup
job reports a final status of 1. This status indicates that some items were not
backed up, and the job details tell you which items were skipped. For granular
backups NetBackup checks the pathname length limit and reports exceptions,
during browsing and restoring of the granular backup image. It logs the pathnames
that exceed the limit in the unified logging ncf1bc or ncfgre logs. Then it reports
the items that were skipped during restore to the View Status window.

Troubleshooting Exchange snapshot operations

Note the following when you perform Exchange snapshot backup or restore
operations:

m If you want to restore a snapshot backup from a multiplexed tape, restore the
entire storage group. If you attempt to restore a single database from a storage
group that contains multiple databases, the restore may fail. This issue will
be fixed in a future release.

m If you want to restore from a snapshot image, the restore fails if an
Exxrestore.env file exists in the transaction log folder for the database or
the storage group. This temporary Exchange file can be left from a previously
failed restore. A Windows application event log entry from Exchange tells you
that this file is the problem. Remove this file manually before you attempt
another restore.

m When you launch an Exchange off-host backup from the Backup, Archive, and
Restore interface or from a node in a DAG, the progress log window does not
display the usual progress messages as when a scheduled backup is executed.
This lack of progress logging does not affect the backup operation. If you want
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detailed progress, use the NetBackup Administration Console to launch a
manual backup operation of the Exchange policy.
See “Testing configuration settings for NetBackup for Exchange” on page 126.

Troubleshooting jobs that use Granular Recovery
Technology (GRT)

Note the following when you use NetBackup to perform backup or restore
operations using Granular Recovery Technology:

m Disable or uninstall Qlogic San Surfer software. It may conflict with the port
mapper for Client for NFS.

m Before you install NFS on the media server or client(s), look for the ONC
Portmapper service. If it exists, stop it and disable it. Otherwise, the installation
of NFS Services for Windows fails.

m Astatus 1 error may occur for a GRT-enabled backup if the granular processing
operations failed to complete successfully. The job details under the Activity
Monitor or error log should indicate if this failure is what caused the status 1.
Do the following:

m Look at the bpbkar debug log for more information.

m A streaming backup still truncates transaction logs if the job ended with a
status 1 because of a granular processing operation failure. In this situation,
the backup image is suitable for database recovery.

m NetBackup must be able to contact the proxy client or destination client.
If NetBackup cannot contact this client, then errors appear in the “Problems”
or “All Log Entries” reports. The following error messages appear in the
NetBackup error logs:

The granular proxy <clientname> for client <clientname> could not be
contacted. Unexpected results may have occurred. See bprd debug log for more
details.

Could not connect to <clientname> for virtual browse operation, errno=#,
bpcd status=#

See “About Exchange client and server privileges for granular operations,
virtual environments, or off-host backups” on page 114.

m Technical Support may want nbfsd logs from the media server. Use the Verbose
setting carefully as the nbfsd log can grow very large.
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About concurrent restore of multiple storage groups

When you use multiple backup streams, for example, one stream for each storage
group, only the last storage group restored from the last restore job is properly
mounted. Recovery of the remaining storage groups is not complete.

Take one of these corrective actions:

m If you want to restore from a snapshot backup, simply mount the unmounted
storage groups.

m If you want to restore from a legacy (non-snapshot) backup, restore the logs
from the last backup set for each storage group individually.

To avoid these steps, you can also restore the storage groups individually in
separate restore operations.

Increased memory usage with Exchange 2010

As you increase the number of mailbox users with Exchange 2010, MONAD . EXE
uses more memory during backup operations. Symantec is working with Microsoft
to fix this problem.

Finding the virtual Database Availability Group (DAG)
node

Finding the virtual Database Availability Group (DAG) node

1 Start Programs > Administrative Tools > Failover Cluster Management on
one of the Exchange DAG servers.

In the left pane, select the DAG.
In the right pane, under Summary of Cluster, locate Current Host Server.

This server is where the virtual DAG resides

Displaying and resetting the Backup Status for a
Database Availability Group (DAG)

Use the following commands to display and reset the Backup Status for a DAG.
More information is available about how the Backup Status is used to choose the
node from which to perform the backup.
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See “Backup status for Exchange Database Availability Groups (DAGs) and the
preferred server list” on page 99.

Note: -EXDB is case sensitive

To display the Backup Status database, enter one of the following commands from
the NetBackup master server:

bpclient -client <DAG Name> -EXDB
bpclient -All -EXDB

where DAG_Name is the name of the DAG. The output from this command is as
follows:

EX DB: DAG DB3 EX SRVR: EXSRV3 EX TIME: 1259516017 EX COUNT: 1 EX STATUS: 156
EX DB: DAG MBOX7 EX SRVR: EXSRV3 EX TIME: 1259516040 EX COUNT: 2 EX STATUS: O
EX DB: EXCHDB0O1l EX SRVR: EXSRV2 EX TIME: 1259516018 EX COUNT: 1 EX STATUS: O

Note: -exdb is case sensitive

To reset the Backup Status database for a particular Exchange database, enter
the following command:

bpclient -client <host name> -update -exdb <db name:server name[:timestamp:count:status]>
For example:

bpclient -client DAG Name -update -exdb DAG DB3:EXSRV1:0:0:0
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